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Bill Gates’s dream of “a computer on every desktop” is becoming more and more of 
a reality—many people today work (and play) on computers both in the office and at 
home. For people who spend much of the day at a computer and are dependent on 
electronic messages as a means of communicating with colleagues, clients, friends, and 
family members, Microsoft Office Outlook 2007 offers an ideal solution. Outlook 2007 
integrates e-mail, address books, calendars, task lists, note pads, and more into one 
place, and more importantly, makes this information immediately available to you when 
you need it. From one window, you can work with e-mail messages, find contact infor-
mation, view upcoming appointments, and track tasks. From one place, you can quickly 
search your messages (and message attachments) and organize your work more easily 
and in a more intuitive way. You can use Outlook to:

	 l	 Send, receive, organize, and archive e-mail messages.

	 l	 Send documents, spreadsheets, graphics, and other files as message attachments, 
and preview attachments you receive from other people.

	 l	 Schedule events, appointments, and meetings, invite attendees, and reserve  
conference rooms, projectors, and other managed resources.

	 l	 View upcoming appointments and tasks, and receive reminders for them.

	 l	 Store contact information in a transferable format that easily interacts with your 
e-mail system.

	 l	 Track tasks for yourself or for someone else, and schedule time to complete  
your tasks.

	 l	 Store random bits of information as notes.

	 l	 Share schedule information with other people, inside and outside your 
organization.

	 l	 Track the interactions you have with other people.

	 l	 Organize and easily locate information in messages, attachments, calendars,  
contacts, and tasks.
    xi

	 l	 Filter out unwanted and annoying junk messages.

	 l	 Have information from favorite Web sites delivered directly to you.
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at’s New in Outlook 2007
The basic concepts of Outlook remain the same in the 2007 release as in earlier versions, 
with a few additions. The biggest improvement in this version is the way that the various 
functions and tools have been linked and organized, making it much easier to use all the 
tools from one place. The biggest change in this version is in the way tools and commands 
are available in the Outlook item windows. Instead of the traditional menus and toolbars 
which are still present in the program window), commands in the message, contact,  
appointment, and other item windows are organized in groups by function. The groups 
are organized on tabs by process, and all the tabs are organized on the “Ribbon” that is 
part of the Microsoft Office Fluent user interface available in several programs in the 2007 
Microsoft Office system.

The new command structure might take some getting used to, but if you use other 
Office programs, you’ll find that you can come up to speed pretty quickly.

If you’re upgrading to Outlook 2007 from a previous version, you’re probably more 
interested in the differences between the old and new versions and how they will affect 
you than you are in the basic functionality of Outlook. We don’t identify new features 
with a special margin icon (as we did in previous versions of this book). We do, however, 
list them here. The following sections list new features introduced in Outlook 2007 and 
Outlook 2003. Throughout this book, we include special discussions about features that 
are new in Outlook 2007, including the benefits of the feature, how to use it, and any 
potential problems you might encounter.

If You Are Upgrading from Outlook 2003
If you have been using Outlook 2003, you might not expect to see many improvements 
in Outlook 2007, but you will soon realize that this is not just an incremental upgrade to 
what seemed like a pretty comprehensive set of features and tools. Outlook 2007  
includes a long list of new and improved features, including the following:

	 l	 Redesigned user interface.  Compose, format, and act upon information in a more 
accessible, intuitive way.

	 l	 To-Do Bar.  View your appointments and tasks for the day.

	 l	 Instant Search.  Search for keywords, dates, or other criteria in your e-mail messages, 

calendar, contact records, or task list.

	 l	 Calendar functionalities.  Create and publish Internet calendars, and e-mail calendar 
snapshots.

	 l	 Share information in one interface.  Interact with Windows SharePoint Services 
to share and manage information.
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	 l	 Color Categories.  Easily personalize and add categories to e-mail, calendar items, 
contacts, or tasks.

	 l	 View your Really Simple Syndication (RSS) feeds.  Catch up on the latest news or 
blogs right from within Outlook.

	 l	 Attachment Preview.  Preview your attachments directly in the Reading Pane.

If You Are Upgrading from Outlook 2002
In addition to the features listed in the previous section, if you’re upgrading from 
Outlook 2002 (part of the Microsoft Office XP system), you’ll want to take note of the 
following new features that were introduced in Outlook 2003:

	 l	 Navigation Pane.  Quickly access your mail, calendar, contacts, tasks, and other 
Outlook items.

	 l	 Reading Pane.  Open attachments without opening the item.

	 l	 Desktop Alerts.  Read and respond to an e-mail message without closing other 
applications.

	 l	 Shared Attachments.  Post attachments for group input.

	 l	 Arrangements.  View your messages in any of 13 predefined views.

	 l	 Quick Flags.  Quickly mark messages for follow-up.

	 l	 Unique signature per account.  Assign a different signature to each Outlook 
account.

	 l	 Arrange by Conversation.  View your messages in a new way.

	 l	 Search Folders.  Collect and automatically update related information in virtual 
folders.

	 l	 Rules.  Create and organize rules in an easier way.

	 l	 Calendar View.  View your Calendar and the Date Navigator in a new, streamlined 
format.

	 l	 Side-by-side calendars.  View multiple calendars at the same time.

	 l	 Contact Picture.  Add a picture to an Address Book entry.

	 l	 View SharePoint Team Services contacts.  See a list of contacts with whom you 
can share information.
	 l	 RPC over HTTP.  Connect directly to your Microsoft Exchange Server from Outlook 
over the Internet.

	 l	 Cached Exchange Mode.  Store a local copy of your mailbox on your computer.
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	 l	 Go menu.  Quickly switch between panes in the Navigation Pane.

	 l	 New Data File Type (.pst).  Create a Personal Folders file.

	 l	 Expand Distribution Lists in an e-mail message.  Display the individual names of 
Distribution List members to edit the recipients of a message.

	 l	 Information Rights Management.  Create messages with restricted permission  
to prevent messages from being forwarded, printed, copied, or edited by un- 
authorized people.

	 l	 Enhanced privacy features.  Block or allow external Web content such as pictures 
or sounds to display in e-mail messages, and prevent Web beacons from validating 
your e-mail address to junk mail senders.

’s Get Started!
With this version, Outlook has truly come into its own as a full-fledged information 
management system, making it easier than ever to efficiently handle communications, 
schedules, and tasks all in one convenient location. We look forward to showing you 
around Outlook 2007 and sharing with you our enthusiasm for this truly useful product.
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The graphics and the operating system–related instructions in this book reflect the 
Windows Vista user interface. However, Windows Vista is not required; you can also use 
a computer running Windows XP.

Most of the differences you will encounter when working through the exercises in this 
book on a computer running Windows XP center around appearance rather than func-
tionality. For example, the Windows Vista Start button is round rather than rectangular 
and is not labeled with the word Start; window frames and window-management but-
tons look different; and if your system supports Windows Aero, the window frames 
might be transparent. 

In this section, we provide steps for navigating to or through menus and dialog boxes  
in Windows XP that differ from those provided in the exercises in this book. For the most 
part, these differences are small enough that you will have no difficulty in completing 
the exercises.

anaging the Practice Files
The instructions given in the “Using the Companion CD” section are specific to Windows 
Vista. The only differences when installing, using, uninstalling, and removing the practice 
files supplied on the companion CD are the default installation location and the uninstall 
process.

On a computer running Windows Vista, the default installation location of the practice 
files is Documents\Microsoft Press\Outlook2007SBS. On a computer running Windows 
XP, the default installation location is My Documents\Microsoft Press\Outlook2007SBS. 
If your computer is running Windows XP, whenever an exercise tells you to navigate to 
your Documents folder, you should instead go to your My Documents folder.
    xv

To uninstall the practice files from a computer running Windows XP:

1.	 On the Windows taskbar, click the Start button, and then click Control Panel.

2.	 In Control Panel, click (or in Classic view, double-click) Add or Remove Programs.
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3.	 In the Add or Remove Programs window, click Microsoft Office Outlook 2007 
Step by Step, and then click Remove.

4.	 In the Add or Remove Programs message box asking you to confirm the deletion, 
click Yes.

Important  If you need help installing or uninstalling the practice files, please see the 
“Getting Help” section later in this book. Microsoft Product Support Services does not  
provide support for this book or its companion CD.

ng the Start Menu
To start Outlook 2007 on a computer running Windows XP:

	 ➜	 Click the Start button, point to All Programs, click Microsoft Office, and then click 
Microsoft Office Outlook 2007.

Folders on the Windows Vista Start menu expand vertically. Folders on the Windows XP 
Start menu expand horizontally. You will notice this variation between the images shown 
in this book and your Start menu.
6 5/9/2008   3:24:37 PM
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vigating Dialog Boxes
On a computer running Windows XP, some of the dialog boxes you will work with in the 
exercises not only look different from the graphics shown in this book but also work dif-
ferently. These dialog boxes are primarily those that act as an interface between Outlook 
and the operating system, including any dialog box in which you navigate to a specific 
location. For example, here are the Insert File dialog boxes from Outlook 2007 running 
on Windows Vista and Windows XP and some examples of ways to navigate in them.

To navigate to the ManagingContacts folder in Windows XP:

	 ➜	 On the Places bar, click My Documents. Then in the folder content pane,  
double-click Microsoft Press, Outlook2007SBS, and then ManagingContacts.

To move back to the Outlook2007SBS folder in Windows XP:

	 ➜	 On the toolbar, click the Up One Level button.
ne Levelne Level
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Desktop computing proficiency is becoming increasingly important in today’s business 
world. As a result, when screening, hiring, and training employees, more employers 
are relying on the objectivity and consistency of technology certification to ensure the 
competence of their workforce. As an employee or job seeker, you can use technology 
certification to prove that you already have the skills you need to succeed, saving cur-
rent and future employers the trouble and expense of training you.

The Microsoft Business Certification program is designed to assist employees in validat-
ing their Windows Vista skills and 2007 Microsoft Office program skills. There are two 
paths to certification:

	 l	 A Microsoft Certified Application Specialist (MCAS) is an individual who has  
demonstrated worldwide skill standards for Windows Vista or the 2007 Office 
system through a certification exam in Windows Vista or in one or more of the 
2007 Office system programs, including Microsoft Office Word 2007, Microsoft 
Office Excel 2007, Microsoft Office PowerPoint 2007, Microsoft Office Outlook 
2007, and Microsoft Office Access 2007.

	 l	 A Microsoft Certified Application Professional (MCAP) is an individual who has 
taken his or her knowledge of the 2007 Microsoft Office suite and of Microsoft 
SharePoint Products and Technologies to the next level and has demonstrated 
through a certification exam that he or she can use the collaborative power of the 
Office suite to accomplish job functions such as Budget Analysis and Forecasting, 
or Content Management and Collaboration.

After attaining certification, you can include the MCAS or MCAP logo with the appro-
priate certification designator on your business cards and other personal promotional 
materials. This logo attests to the fact that you are proficient in the applications or 
cross-application skills necessary to achieve the certification.
    xix
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ting a Certification Path
When selecting the Microsoft Business Certification path that you would like to pursue, 
you should assess the following:

	 l	 The program and program version(s) with which you are familiar

	 l	 The length of time you have used the program

	 l	 Whether you have had formal or informal training in the use of that program

Candidates for MCAS-level certification are expected to successfully complete a wide 
range of standard business tasks, such as formatting a document or worksheet. Successful 
candidates generally have at least six months of experience with Windows Vista or the 
specific Office program, including either formal, instructor-led training or self-study using 
approved books, guides, or interactive computer-based materials.

Candidates for MCAP-level certification are expected to successfully complete more 
complex, business-oriented tasks utilizing advanced functionality with the 2007 Office 
system and SharePoint. Successful candidates generally have between six months and 
one or more years of experience with the programs, including formal, instructor-led 
training or self-study using approved study materials.

ming a Microsoft Certified Application 
ialist—Microsoft Office Outlook 2007

Every MCAS and MCAP certification exam is developed from a set of exam skill standards 
that are derived from studies of how Windows Vista and the 2007 Office programs are 
used in the workplace. Because these skill standards dictate the scope of each exam, they 
provide you with critical information on how to prepare for certification.

To become certified as a Microsoft Certified Application Specialist for Microsoft Office 
Outlook 2007, you must pass Exam 77-605, Using Microsoft Office Outlook 2007, by 
demonstrating proficiency in these five areas:

	 l	 Managing messaging.  You must demonstrate the ability to create, send, reply to, 
and forward e-mail messages; create automatic signatures and reply messages;  
attach files to messages; preview, save, and open attachments; set message sensitiv-

ity, importance, security, and delivery options; and view messages in different ways.

	 l	 Managing scheduling.  You must demonstrate the ability to create one-time and 
recurring appointments, meetings, and events, from scratch and from e-mail mes-
sages and tasks; schedule meetings and update, cancel, and respond to meeting 
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requests; customize your work week, time zones, and holidays; share and publish 
your calendar; and view other calendars.

	 l	 Managing tasks.  You must demonstrate the ability to create and modify one-time 
and recurring tasks from scratch and from messages; set the status, priority, and 
percent completion of a task and mark it as complete or private; and assign tasks 
to others and respond to tasks assigned by others.

	 l	 Managing contacts and personal contact information.  You must demonstrate 
the ability to create and modify contacts from scratch or from messages, electronic 
business cards, and contact records; create and send an electronic business card, 
and use it as a signature; create and modify distribution lists; and create or import 
a secondary address book.

	 l	 Organizing information.  You must demonstrate the ability to categorize and  
sort messages, appointments, meetings, contacts, and tasks by color; create and 
manage data files; create and populate mail folders; manage deleted, sent, and 
junk messages; locate specific messages, appointments, tasks, or contacts; create, 
modify, and remove rules to manage messages; customize the Outlook environ-
ment; and configure Outlook 2007 to be accessible over the Internet.

ing a Microsoft Business Certification Exam
The MCAS and MCAP certification exams for Windows Vista and the 2007 Office  
programs are performance-based and require you to complete business-related tasks 
using an interactive simulation (a digital model) of the Windows Vista operating  
system or one or more programs in the Office system.

Test-Taking Tips

	 l	 Follow all instructions provided in each question completely and accurately.

	 l	 Enter requested information as it appears in the instructions, but without dupli-
cating the formatting unless you are specifically instructed to do otherwise. For 
example, the text and values you are asked to enter might appear in the instruc-
tions in bold and underlined (text), but you should enter the information without 
applying these formats.

	 l	 Close all dialog boxes before proceeding to the next exam question unless you are 
specifically instructed otherwise.

	 l	 Don’t close task panes before proceeding to the next exam question unless you are 
specifically instructed to do otherwise.
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	 l	 If you are asked to print a document, worksheet, chart, report, or slide, perform the 
task, but be aware that nothing will actually be printed.

	 l	 Don’t worry about extra keystrokes or mouse clicks. Your work is scored based 
on its result, not on the method you use to achieve that result (unless a specific 
method is indicated in the instructions), and not on the time you take to complete 
the question.

	 l	 If your computer becomes unstable during the exam (for example, if the exam 
does not respond or the mouse no longer functions) or if a power outage occurs, 
contact a testing center administrator immediately. The administrator will restart 
the computer and return the exam to the point where the interruption occurred 
with your score intact.

Certification
At the conclusion of the exam, you will receive a score report, which you can print with 
the assistance of the testing center administrator. If your score meets or exceeds the 
passing standard (the minimum required score), you will be mailed a printed certificate 
within approximately 14 days.

More Information
To learn more about the Microsoft Business Certification exams and courseware, visit:

www.microsoft.com/learning/mcp/msbc/
5/13/2008   9:55:04 AM
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This book has been designed to lead you step by step through all the tasks you are most 
likely to want to perform in Microsoft Office Outlook 2007. If you start at the beginning 
and work your way through all the exercises, you will gain enough proficiency to be able to 
manage all types of information through Outlook. However, each topic is self contained. If 
you have worked with a previous version of Outlook, or if you completed all the exercises 
and later need help remembering how to perform a procedure, the following features of 
this book will help you locate specific information:

	 l	 Detailed table of contents.  A listing of the topics and sidebars within each 
chapter.

	 l	 Chapter thumb tabs.  Easily locate the beginning of the chapter you want.

	 l	 Topic-specific running heads.  Within a chapter, quickly locate the topic you 
want by looking at the running head of odd-numbered pages.

	 l	 Quick Reference.  General instructions for each procedure covered in specific  
detail elsewhere in the book. Refresh your memory about a task while working 
with your own documents.

	 l	 Detailed index.  Look up specific tasks and features and general concepts in the 
index, which has been carefully crafted with the reader in mind.

	 l	 Companion CD.  Contains the practice files needed for the step-by-step  
exercises, as well as a fully searchable electronic version of this book and  
other useful resources.

In addition, we provide a glossary of terms for those times when you need to look up 
the meaning of a word or the definition of a concept.

You can save time when you use this book by understanding how the Step by Step series 
shows special instructions, keys to press, buttons to click, and so on.
    xxiii
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Convention Meaning

This icon at the end of a chapter introduction indicates information 
about the practice files provided on the companion CD for use in  
the chapter.

USE This paragraph preceding a step-by-step exercise indicates the practice 
files that you will use when working through the exercise.

BE SURE TO This paragraph preceding or following an exercise indicates any require-
ments you should attend to before beginning the exercise or actions 
you should take to restore your system after completing the exercise.

OPEN This paragraph preceding a step-by-step exercise indicates files that 
you should open before beginning the exercise.

CLOSE This paragraph following a step-by-step exercise provides instructions 
for closing open files or programs before moving on to another topic.

1 
2

Blue numbered steps guide you through step-by-step exercises and 
Quick Reference versions of procedures.

1	
2

Black numbered steps guide you through procedures in sidebars and 
expository text.

➜ An arrow indicates a procedure that has only one step.

See Also These paragraphs direct you to more information about a given topic 
in this book or elsewhere.

Troubleshooting These paragraphs explain how to fix a common problem that might 
prevent you from continuing with an exercise.

Tip These paragraphs provide a helpful hint or shortcut that makes work-
ing through a task easier, or information about other available options.

Important These paragraphs point out information that you need to know to 
complete a procedure.

Save

The first time you are told to click a button in an exercise, a picture of 
the button appears in the left margin. If the name of the button does 
not appear on the button itself, the name appears under the picture.

F In step-by-step exercises, keys you must press appear as they would on 
a keyboard.

H+> A plus sign (+) between two key names means that you must hold 
down the first key while you press the second key. For example, “press 
H+>” means “hold down the H key while you press the > key.”
Program interface 
elements

In steps, the names of program elements, such as buttons, commands, 
and dialog boxes, are shown in black bold characters.

User input Anything you are supposed to type appears in blue bold characters.

Glossary terms Terms that are explained in the glossary at the end of the book are 
shown in blue italic characters.

4/2/2008   2:51:22 PM
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The companion CD included with this book contains the practice files you’ll use as you 
work through the book’s exercises, as well as other electronic resources that will help  
you learn how to use Microsoft Office Outlook 2007.

 Contents
The companion CD contains practice files necessary to complete the step-by-step  
exercises. In this book, you will create most of the practice files while working through 
the initial exercises. This ensures that the practice files work with your system—for  
example, that e-mail messages are sent between real e-mail accounts.

The following table lists the practice files supplied on the companion CD.

Chapter Folders\Files
Chapter 1: Getting Started with Outlook 2007 None
Chapter 2: Managing Contact Information ManagingContacts\FourthCoffee.png
Chapter 3: Sending E-Mail Messages SendingMessages\Attaching.docx

SendingMessages\Attaching.pptx
Chapter 4: Handling E-Mail Messages None
Chapter 5: Managing Your Inbox None
Chapter 6:  
Managing Appointments, Events, and Meetings

None

Chapter 7: Managing Your Calendar None
Chapter 8: Tracking Tasks None
    xxv

Chapter 9: Gathering Information None
Chapter 10: Collaborating with Other People None
Chapter 11: Working Away from Your Office None
Chapter 12: Customizing and Configuring Outlook None

6/25/12   3:34 PM
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In addition to the practice files, the CD contains the following resources in electronic 
format:

	 l	 Microsoft Office Outlook 2007 Step by Step

	 l	 Microsoft Computer Dictionary, Fifth Edition

	 l	 Sample chapter and poster from Look Both Ways: Help Protect Your Family on the 
Internet (Linda Criddle, 2007)

	 l	 Windows Vista product guide

Important  The companion CD for this book does not contain the Outlook 2007 software. 
You should purchase and install that program before using this book.

um System Requirements

2007 Microsoft Office System
The 2007 Microsoft Office system includes the following programs:

	 l	 Microsoft Office Access 2007

	 l	 Microsoft Office Communicator 2007

	 l	 Microsoft Office Excel 2007

	 l	 Microsoft Office Groove 2007

	 l	 Microsoft Office InfoPath 2007

	 l	 Microsoft Office OneNote 2007

	 l	 Microsoft Office Outlook 2007

	 l	 Microsoft Office Outlook 2007 with Business Contact Manager

	 l	 Microsoft Office PowerPoint 2007

	 l	 Microsoft Office Publisher 2007

	 l	 Microsoft Office Word 2007
No one edition of the 2007 Office system installs all of the above programs. Specialty 
programs available separately include Microsoft Office Project 2007, Microsoft Office 
SharePoint Designer 2007, and Microsoft Office Visio 2007.

5/9/2008   3:43:40 PM
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To install and run these programs, your computer needs to meet the following minimum 
requirements:

	 l	 500 megahertz (MHz) processor

	 l	 256 megabytes (MB) RAM

	 l	 CD or DVD drive

	 l	 2 gigabytes (GB) available hard disk space; a portion of this disk space will be freed 
if you select the option to delete the installation files

Tip  Hard disk requirements will vary depending on configuration; custom installation 
choices might require more or less hard disk space.

	 l	 Monitor with 800×600 screen resolution; 1024×768 or higher recommended

	 l	 Keyboard and mouse or compatible pointing device

	 l	 Internet connection, 128 kilobits per second (Kbps) or greater, for download and 
activation of products, accessing Microsoft Office Online and online Help topics, 
and any other Internet-dependent processes

	 l	 Windows Vista with Service Pack 1 (SP1), Windows XP with Service Pack 2 (SP2), or 
Windows Server 2003

	 l	 Windows Internet Explorer 7 or Microsoft Internet Explorer 6 with service packs

The 2007 Microsoft Office suites, including Office Basic 2007, Office Home & Student 
2007, Office Standard 2007, Office Small Business 2007, Office Professional 2007, Office 
Ultimate 2007, Office Professional Plus 2007, and Office Enterprise 2007, all have similar 
requirements.

Step-by-Step Exercises
In addition to the hardware, software, and connections required to run the 2007 
Microsoft Office system, you will need the following to successfully complete the  
exercises in this book:

	 l	 Outlook 2007, PowerPoint 2007, and Word 2007

	 l	 Access to a printer
	 l	 1 MB of available hard disk space for the practice files

5/9/2008   3:43:40 PM
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alling the Practice Files
You need to install the practice files in the correct location on your hard disk drive 
before you can use them in the exercises. Follow the steps below.

Tip  If for any reason you are unable to install the practice files from the CD, the files can 
also be downloaded from the web at

1.	 Remove the companion CD from the envelope at the back of the book, and insert 
it into the CD drive of your computer. If the AutoPlay window opens, click Run 
startcd.exe.

The Microsoft Software License Terms appear. To use the practice files, you must 
accept the terms of the license agreement.

2.	 Click I accept the agreement, and then click Next.

After you accept the license agreement, the CD interface appears.

Important  If the menu screen does not appear, click the Start button, and then click 
Computer. Display the Folders list in the Navigation Pane, click the icon for your CD 
drive, and then in the right pane, double-click the StartCD executable file.

3.	 Click Practice Files. If the File Download and/or Internet Explorer Security dialog 
boxes open, click Run.

4.	 On the Welcome page of the InstallShield Wizard, click Next. On the License 
Agreement page, click I accept the terms in the license agreement, and then 
click Next. Click Next on the first screen, and then click Next to accept the terms 
of the license agreement on the next screen.

5.	 If you want to install the practice files to a location other than the default folder 
(Documents\Microsoft Press\Outlook2007SBS), click the Change button, select the 
new drive and path, and then click OK.

Important  If you install the practice files to a location other than the default, you 
will need to substitute that path within the exercises.

http://www.microsoftpressstore.com/title/9780735623002. 
6.	 On the Custom Setup page, click Next, and then on the Ready to Install the 
Program screen, click Install.

7.	 After the practice files have been installed, click Finish.

6/25/12   3:38 PM
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8.	 Close the Step by Step Companion CD window.

9.	 Remove the companion CD from the CD drive, and return it to the envelope at the 
back of the book.

ing the Practice Files
When you install the practice files from the companion CD that accompanies this 
book, the files are stored on your hard disk in chapter-specific subfolders of your 
Documents\Microsoft Press\Outlook2007SBS folder. Each exercise is preceded by a 
paragraph that lists the files needed for that exercise and explains any preparations 
needed before you start working through the exercise. Here are examples:

USE  the Andrea Dunker and John Emory contact records you created earlier in this chapter.

BE SURE TO  display the Contacts module before beginning this exercise.

You can browse to the practice files in Windows Explorer by following these steps:

1.	 On the Windows taskbar, click the Start button, and then click Documents.

2.	 In your Documents folder, double-click Microsoft Press, double-click 
Outlook2007SBS, and then double-click a specific chapter folder.

You can browse to the practice files from an Outlook 2007 dialog box by following 
these steps:

1.	 On the Favorite Links pane in the dialog box, click Documents.

2.	 In your Documents folder, double-click Microsoft Press, double-click 
Outlook2007SBS, and then double-click the specified chapter folder.

Tip  You can also view the practice files by selecting Browse on the CD menu.
6/25/12   3:38 PM
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oving and Uninstalling the Practice Files
After you finish working through this book, delete the practice messages, appoint-
ments, contacts, and other Outlook items you created while working through the  
exercises, and then uninstall the practice files that were installed from the companion 
CD. Follow these steps:

1.	 On the Windows taskbar, click the Start button, and then click Control Panel.

2.	 In Control Panel, under Programs, click the Uninstall a program task.

3.	 In the Programs and Features window, click Microsoft Office Outlook 2007 	
Step by Step, and then on the toolbar at the top of the window, click the 
Uninstall button.

4.	 If the Programs and Features message box asking you to confirm the deletion  
appears, click Yes.

See Also  If you need additional help installing or uninstalling the practice files, see the 
“Getting Help” section later in this book.

Important  Microsoft Product Support Services does not provide support for this book or 
its companion CD.
5/9/2008   3:43:41 PM
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Every effort has been made to ensure the accuracy of this book and the contents of its 
companion CD. If you do run into problems, please contact the sources listed below for 
assistance.

ta & Book Support
We’ve made every effort to ensure the accuracy of this book and its companion con-
tent. Any errors that have been reported since this book was published are listed on our 
Microsoft Press site: 

If you find an error that is not already listed, you can report it to us through the same page.

If you need additional support, email Microsoft Press Book Support at mspinput@
microsoft.com.

Please note that product support for Microsoft software is not offered through the addresses 
above.

ting Help with Outlook 2007
If your question is about Microsoft Office Outlook 2007, and not about the content of 
this Microsoft Press book, your first recourse is the Outlook Help system. This system is 
a combination of tools and files stored on your computer when you installed Outlook 
and, if your computer is connected to the Internet, information available from Microsoft 
Office Online. You can find general or specific help information in several ways.

	 l	 To find out about an item on the screen, you can display a ScreenTip. For example, 
to display a ScreenTip for a button, point to the button without clicking it. The 
ScreenTip gives the button’s name, the associated keyboard shortcut if there is 
one, and in an item window featuring the Microsoft Office Fluent Ribbon, a de-
scription of what the button does when you click it.

http://www.microsoftpressstore.com/title/9780735623002. 
    xxxi

	 l	 In the Outlook program window, you can click the Help button (labeled with a 
question mark) at the right end of the Standard toolbar, or press the F1 key, to 
display the Outlook Help window.

6/25/12   3:30 PM
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	 l	 In a dialog box, you can click the Help button at the right end of the dialog box 
title bar to display the Help window with topics related to the functions of that 
dialog box already identifi ed.

	 l	 You can enter a search term or question in the Type A Question For Help box at 
the right end of the program window menu bar, and then press Enter to display the 
Outlook Help window with related topics identifi ed.

If you want to practice getting help, you can work through the following exercise, which 
demonstrates two ways of locating information.

BE SURE TO start Outlook before beginning this exercise.

1. At the right end of the menu bar, click the Type	a	question	for	help box.

2. Type How	do	I	get	help?, and then press the F key.

A list of topics that relate to your question appears in the Search Results task pane. 
If you have an active Internet connection, this list includes current content from 
Microsoft Offi ce Online, so your results might vary from those shown here.

BE SURE TO start Outlook before beginning this exercise.start Outlook before beginning this exercise.
You can click any of the listed topics to get more information or instructions.

5/1/2008   10:17:11 AM
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3.	 In the Search Results task pane, scroll the results list, and then click a topic that 
interests you.

The Outlook Help window opens, displaying information about that topic.

4.	 At the right end of the Outlook Help window’s title bar, click the Maximize button, 
and then in the topic pane, click Show All.

The topic content expands to provide in-depth information about getting help 
while you work.

ximizeximize
5.	 At the right end of the Outlook Help window’s title bar, click the Close button.

6.	 To access the Help system in a different way, on the Help menu, click Microsoft 
Office Outlook Help.

Outlook Help opens, displaying a basic topic list from which you can browse to 
information.

7.	 On the Outlook Help window’s toolbar, click the Table of Contents button.

CloseClose

 Table of 
ntents
 Table of 
ntents

3 5/1/2008   10:17:11 AM



xxxiv 	 G

 

 

a11g623002.indd   34
etting	Help

The Table Of Contents pane opens, displaying the same list in a tree structure that 
you can expand.

8. In the Table	of	Contents pane, click E-mail, click Creating	messages, and then click 
Save	a	message.

Outlook Help displays the Save A Message topic.

9. Experiment on your own with fi nding information in Outlook Help.

CLOSE the Outlook Help window when you fi nish.CLOSE the Outlook Help window when you fi nish.
5/1/2008   10:17:13 AM



	

More 

We W

Stay in

a11g623002.indd   35
Getting Help    xxxv

Information
If your question is about Outlook 2007 or another Microsoft software product and you 
cannot find the answer in the product’s Help system, please search the appropriate 
product solution center or the Microsoft Knowledge Base at:

support.microsoft.com

In the United States, Microsoft software product support issues not covered by the 
Microsoft Knowledge Base are addressed by Microsoft Product Support Services. 
Location-specific software support options are available from:

support.microsoft.com/gp/selfoverview/

ant to Hear from You
At Microsoft Press, your satisfaction is our top priority, and your feedback our most valu-
able asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in ad-
vance for your input!

 Touch
Let’s keep the conversation going! We’re on Twitter: http://twitter.com/MicrosoftPress
6/25/12   3:31 PM
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etting Started with Outlook 2007
o confi gure Outlook to connect to an e-mail account

1. On  the Start menu, point to All Programs, click Microsoft Offi ce, and then click 
Microsoft Offi ce Outlook 2007.

2. On the welcome page of the Outlook 2007 Startup wizard  , click Next.

3. On the E-mail Upgrade Options page, click Do not upgrade, and then click Next.

4. On the E-mail Accounts page, with the Yes option selected, click Next.

5. On the Auto Account Setup page, enter your name, e-mail address, and password 
in the corresponding text boxes, and then click Next.

o manually confi gure your Exchange Server account settings

1. On  the Start menu, point to All Programs, click Microsoft Offi ce, and then click 
Microsoft Offi ce Outlook 2007.

2. On the welcome page of the Outlook 2007 Startup wizard, click Next.

3. On the E-mail Upgrade Options page, click Do not upgrade, and then click Next.

4. On the E-mail Accounts page, with the Yes option selected, click Next.

5. On the Auto Account Setup page select the Manually confi gure server settings 
check box, and then click Next.

6. On the Choose E-mail Service page, click Microsoft Exchange Server, and then 
click Next.

7. On the Microsoft Exchange Settings page, enter the name or address of your 
Exchange Server and your user name, and then click the Check Name button. If the 
Connect to dialog box appears, enter your logon information, and then click OK.

8. After your name is underlined, click Next, and then on the fi nal page of the wizard, 
click Finish.

o connect to an additional e-mail account

1. On  the Tools menu, click Account Settings.

2. On the E-mail tab of the Account Settings dialog box, click the New button.
  xxxvii

3. On the Choose E-mail Service page of the Add New E-mail Account wizard , with 
the Microsoft Exchange Server, POP3, IMAP, or HTTP option selected, click Next.

5/15/2008   2:43:06 PM
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4. On the Auto Account Setup page, enter the account display name, the e-mail 
address, and the password of the account you want to add to your profi le. Then 
click Next.

5. Click Finish to complete the account setup.

To create an additional Outlook profi le

1. Exit  Outlook if it is running.

2. Display Control Panel in Classic View, and then double-click the Mail icon. In the 
User Account Control dialog box, if you’re logged on as an administrator, click 
Continue. Otherwise, enter an administrator password, and then click OK.

3. In the Mail Setup dialog box, click the Show Profi les button.

4. In the Mail dialog box, click the Add button.

5. In the Profi le Name box, type a name to identify the new profi le, and then click OK.

6. On the Choose E-mail Service page, with the Microsoft Exchange Server, POP3, 
or IMAP option selected, click Next.

7. On the Auto Account Setup page, enter the name, e-mail address, and password 
in the corresponding text boxes, and then click Next.

8. After Outlook connects to the e-mail account, click Finish.

To confi gure Outlook to prompt for a profi le when starting

1. Display  Control Panel in Classic View, and then double-click the Mail icon. In the 
User Account Control dialog box, if you’re logged on as an administrator, click 
Continue. Otherwise, enter an administrator password, and then click OK.

2. In the Mail Setup dialog box, click Show Profi les.

3. In the Mail dialog box, click Prompt for a profi le to be used, and then click OK.

2 Managing Contact Information
To import information from a SharePoint Contacts List to your Outlook contacts 
folder

1. Display   the SharePoint site in your Web browser, and then display the SharePoint 
Contacts List you want to import.

2. On the Actions menu, click Link to Outlook.

3. In the Microsoft Offi ce Outlook message box asking whether you want to connect 

the SharePoint Contacts List to Outlook, click Yes.

To create a contact record

1. With  the Contacts pane displayed, on the Standard toolbar, click the New Contact 
button.

5/15/2008   2:43:07 PM
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. Enter the new contact information, and then on the Contact tab, in the Actions 
group, click the Save & Close button.

edit a contact record

. In   the Contacts pane, double-click the contact record to open it, and then edit or 
add information to the record.

. On the Contact tab, in the Actions group, click the Save & Close button.

assign contact records to color categories

. In   the Contacts pane, double-click the contact record you want to assign to a 
category.

. On the Contact tab, in the Options group, click the Categorize button, and click a 
category. Then in the Actions group, click the Save & Close button.

Or

On the Options tab, click the Categorize button, and click All Categories to display 
the Color Categories dialog box. Then in the Name list, select any pertinent check 
boxes, and click OK.

create a distribution list

. In the New list, click Distribution List.

. In the Name box, type a name for your list, and then in the Members group, 
click the Select Members button.

. If the Select Members dialog box is displaying an address book other than 
your Contacts list, in the Address Book list, under Outlook Address Book, click 
Contacts.

. In the Name list, click the names of the people you want to include, click the 
Members button, and then click OK.

. On the Contact tab, in the Actions group, click the Save & Close button.

modify a business card

. In   the Contacts pane, double-click the contact record to open it.

. On the Contact tab, in the Options group, click the Business Card button.

. In the Card Design area of the Edit Business Card dialog box, click Background 
Color.

. In the Color dialog box, click a color you like, and then click OK.
. To add or change an image, in the Card Design area, to the right of Image, click 
Change. Then browse to the folder containing the image, click the image, and click OK.

. In the Image Area box, type or select the image area size.

. In the Image Align list, click a type of alignment, and then click OK.

5/15/2008   2:43:07 PM
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hare one or more address books with other people on your network

 In   the Contacts module Navigation Pane, under My Contacts, right-click the 
address book you want to share, and then click Share. Or if you want to share all 
your address books, in the Navigation Pane, click Share My Contacts folder.

 In the To box of the Sharing invitation message, enter the names of people or 
distribution lists on your network with whom you want to share the address book.

 If you are sharing your primary address book and want to request reciprocal 
permission, select the Request permission to view recipient’s Contacts folder 
check box. If you are sharing a secondary address book and want to give the 
recipient full access, select the Recipient can add, edit, and delete items in 
this contacts folder check box.

 Click Send.

reate a contacts folder

 Display  the Contacts module. Then in the New Contact list, click Folder.

 In the Name box of the Create New Folder dialog box, type a name by which you 
want to identify the folder.

 In the Folder contains list, click the type of folder you want to create.

 In the Select where to place the folder list, click a location for the folder, and then 
click OK.

xport an address book

 On   the File menu, click Import and Export.

 In the Choose an action to perform list, click Export to a fi le, and then click Next.

 In the Create a fi le of type list, click Personal Folder File (.pst), and then click Next.

 In the Select the folder to export from list, click the contacts folder you want to 
export, and then click Next.

 Click Browse to the right of the Save exported fi le as box. Then In the Open 
Personal Folders dialog box, select the location where you want to save the fi le.

 Type the fi le name, click OK, and then click Finish.

ort contact records

 Click   a column heading to sort the contact records in ascending order based on the 

column. Click the column heading again to reverse the sort.

hange how you view contact records

 Select  an option from the Current View list.

ocate a contact record by using Instant Search

 At    the top of the Contacts pane, click the Search box, and then type a search word.

5/15/2008   2:43:08 PM
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 ➜ To return to previous search results, at the right end of the Search box, click the 
Show Instant Search Pane Menu button, point to Recent Searches, and then 
select the search you want to use from the list.

To print a phone list

1. Display   the Contacts module in Phone List view.

2. On the Standard toolbar, click the Print button. Then in the Print range area of the 
Print dialog box, ensure that the All rows option is selected, and click OK.

To print an address card for a contact

1. Display   the Contacts module in Address Cards view.

2. In the Contacts pane, click the contact record for which you want to print a card.

3. On the Standard toolbar, click the Print button.

4. In the Print dialog box, scroll the Print style list and click Card Style.

5. Under Print range, click Only selected items, and then click OK.

To print address cards for multiple contacts

1. In   the Contacts pane, click a contact record to select it.

2, Hold down the H key, and then click other contact records to add them to the 
selection.

3. On the Standard toolbar, click the Print button.

4. In the Print style list, be sure that Card Style is selected. Then in the Print range 
area, click Only selected items, and click OK.

To link one or more contact records to Microsoft Offi ce OneNote

 ➜ In   the Contacts pane, select the contact record (or records) you want to link. 
Then on the Standard toolbar, click the Open or create linked contact notes in 
OneNote button.

Sending E-Mail Messages
To check addresses

 ➜ If   a message recipient’s address is in your address book, type the person’s name 
and either wait for Outlook to validate the name or press H+k to immediately 
validate it.
To have Outlook search additional address books

1. On   the Tools menu, click Address Book. Then in the Address Book window, on the 
Tools menu, click Options.

2. In the Addressing dialog box, click Add.

5/15/2008   2:43:09 PM
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n the Add Address List dialog box, click the address list you want to add, click 
dd, and then click Close.

n the Addressing dialog box, click OK, and then in the Address Book window, click 
he Close button.

nd a courtesy copy of a message

n  the message window, enter an e-mail address in the Cc or Bcc box.

play the Bcc fi eld in an outgoing message

n  the message window, on the Options tab, in the Fields group, click the Show 
cc button.

mpose and send a new e-mail message

n    the Standard toolbar, click the New Mail Message button.

n the To box of the message window, type an e-mail address.

n the Subject box, enter the main idea of your message.

n the message content area, type the body of the message.

hen you fi nish, click Send.

all a message

n   the Sent Items folder, open the message you want to recall.

n the Message tab, in the Actions group, click the Other Actions button, and 
hen click Recall This Message.

elect the option to delete unread copies of the message or to replace them with a 
ew message, and then click OK.

ach a fi le to an e-mail message

isplay  the message window.

n the Message tab, in the Include group, click the Attach File button (not the 
rrow under the button).

rowse to the fi le you want to attach, click it, and then click Insert.

nd a business card

isplay  the message window.

n the Message tab, in the Include group, click the Insert Business Card button, 
nd then in the list, click Other Business Cards.
n the Insert Business Card dialog box, select the card or cards you want to send, 
nd then click OK.

ate a SmartArt diagram within an e-mail message

lick   to place the insertion point in the message content area.
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2. On the Insert tab, in the Illustrations group, click the SmartArt button.

3. In the SmartArt gallery, click the diagram you want to create, and then click OK.

To format the text of an e-mail message

 �➜ In   the message content area, select the text you want to format. Then do one of 
the following:

❍ Click formatting buttons on the Mini toolbar.

❍ Click formatting buttons in the Basic Text group on the Message tab.

To apply a different theme to an outgoing e-mail message

1. In   the message window, on the Options tab, in the Themes group, click the 
Themes button.

2. In the Themes gallery, click the theme you want.

To create a signature and insert it in all the new messages

1. On    the Tools menu, click Options. On the Mail Format tab of the Options dialog 
box, click Signatures.

2. On the E-mail Signature tab of the Signatures and Stationery dialog box, click New.

3. In the New Signature dialog box, type a name for the signature, and then click OK.

4. In the signature content area, type a salutation, such as Regards, and a comma. 
Press the F key once or twice, and then type your name.

5. Add any other information you want to include, such as a telephone number, legal 
disclaimer, or link to your organization’s Web site, and format the text and para-
graphs the way you want them to appear in messages.

6. In the Choose default signature area of the Signatures and Stationery dialog box, in 
the New messages list, click the name you gave your signature. Then click OK twice.

 Handling E-Mail Messages
To mark messages as read after previewing them in the Reading Pane

1. On   the Tools menu, click Options. On the Other tab of the Options dialog box, in 
the Outlook Panes area, click Reading Pane.

2. In the Reading Pane dialog box, select the check box corresponding to the way 
you want Outlook to handle messages viewed in the Reading Pane, and then click 

OK twice.

To manually mark an e-mail message as read or unread

 ➜ Right-click   the message, and then click Mark As Read or Mark As Unread.
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review and open a message attachment

 In     the Reading Pane, point to the Message button below the message header, and 
then point to the attachment to preview its name, type, and size.

 Click the attachment, and then click the Preview fi le button.

 In the Reading Pane, double-click the attachment. If Outlook prompts you to 
confi rm that you want to open the fi le, click the Open button.

eply to or forward messages

 In   the message window, on the Message tab, in the Respond group, click the 
Reply, Reply to All, or Forward button.

nstruct Outlook to close original messages after you respond to them

 On    the Tools menu, click Options. On the Preferences tab, of the Options dialog 
box, click E-mail Options.

 In the E-mail Options dialog box, select the Close original message on reply or 
forward check box, and then click OK twice.

ustomize your desktop alert settings

 On  the Tools menu, click Options. On the Preferences tab of the Options dialog 
box, click E-mail Options.

 In the E-mail Options dialog box, click Advanced E-mail Options.

 In the Advanced E-mail Options dialog box, click Desktop Alert Settings.

 In the Desktop Alert Settings dialog box, set the duration and transparency as you 
want, previewing your changes as necessary. When you fi nish, click OK in each of 
the open dialog boxes.

ustomize where you want desktop alerts to appear

 On  the Tools menu, click Options. On the Preferences tab of the Options dialog 
box, click E-mail Options.

 In the E-mail Options dialog box, click Advanced E-mail Options.

 In the Advanced E-mail Options dialog box, click Desktop Alert Settings.

 Click Preview, drag the sample desktop alert to where you want it to appear on the 
screen, and then click OK.

urn off desktop alerts
 On   the Tools menu, click Options. On the Preferences tab of the Options dialog 
box, click E-mail Options.

 In the E-mail Options dialog box, click Advanced E-mail Options.

5/15/2008   2:43:10 PM



 

 

T

 

T

 

T

 

T

 

 
 

T

 

T

 

T

 

T

 
 
 

T

 

 

a12q623002.indd   45
Quick Reference  xlv

3. In the Advanced E-mail Options dialog box, clear the Display a New Mail Desktop 
Alert check box, and then click OK.

o quickly access the Desktop Alert Settings dialog box

➜ When   a desktop alert appears on your screen, click the Options button in the alert, 
and then click Desktop Alert Settings.

o mark a message as read through its desktop alert

➜ When    a desktop alert appears on your screen, point to it to keep it active, click its 
Options button, and then click Mark as Read.

o delete a message through its desktop alert

➜ When    the desktop alert appears on your screen, point to it, and then click its 
Delete Item button.

o specify a task due date other than the default when you fl ag a message

➜ In   the Inbox, right-click the fl ag in the message header, and then click the due date.

Or

1. Right-click the fl ag, and then click Set Quick Click.

2. In the Set Quick Click dialog box, click the due date you want, and then click OK.

o create a task from an e-mail message

➜ In the   Inbox, click the transparent fl ag at the right end of the message header.

o create an appointment based on a message

➜ Drag   the message from your Inbox, and drop it on the Calendar button at the 
bottom of the Navigation Pane.

o convert an appointment to an event

➜ Open the appointment, and then select the All day event check box.

o convert an appointment to a meeting

1. Open the appointment.

2. On the Appointment tab, in the Actions group, click Invite Attendees.

3. In the To box that appears, type the e-mail addresses of the people you want to 
invite. Then click Send.

o set up a message for printing
1. In   the message window, click the Microsoft Offi ce Button, point to the Print arrow, 
and then click Print Preview.

2. In the Print Preview window, click the Page Setup button.
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n the Page Setup: Memo Style dialog box, click the Paper tab to view and change 
he available options.

lick the Header/Footer tab, and then type the text you want to appear in the 
eader and footer of the message.

o print the message, click Print.

aging Your Inbox
 Instant Search to locate a specifi c message

n  the Search box at the top of the Inbox, type a word contained in the message.

o refi ne the search, click the Expand the Query Builder button to the right of the 
earch box, and supply additional information.

o expand the search to include all the folders in your mailbox, at the bottom of 
he Search Results pane, click Try searching again in All Mail Items.

o remove the search fi lter and view all messages, click the Clear Search button.

nge the display, arrangement, sort order, and grouping of messages

n  the View menu, point to Arrange By, and then click the command you want; or

lick the column heading on which you want to sort messages. Click it again to 
everse the order.

and or collapse groups

n    the View menu, point to Expand/Collapse Groups, and then click the collapse 
r expand view you want.

er the Inbox content

n   the View menu, point to Current View, and then click the view you want. Click 
essages on the Current View list to remove the fi lter.

 and remove fi elds

n  the View menu, point to Current View, and then click Customize Current View.

n the Customize View dialog box, click the Fields button.

o add fi elds, in the Available fi elds list of the Show Fields dialog box, click the 
 elds you want to add, and then click Add.

o remove fi elds in any list view, drag the column heading downward, and release 

he mouse button when a large black X appears over the heading.

nge the order of columns in any view

rag  the column headings to the locations you prefer.
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To restore the default Inbox settings

1. On   the View menu, point to Current View, and then click Defi ne Views.

2. In the Custom View Organizer dialog box, click Reset. In the Microsoft Offi ce 
Outlook message box asking whether you want to reset the current view to its 
original settings, click OK.

3. Reset any customized views you want by clicking the view name and then clicking 
Reset. When you fi nish, click the Messages view, and then click Apply View.

To create a custom Search Folder

1. In  the Navigation Pane, right-click the Search Folders folder, and then click New 
Search Folder.

2. In the New Search Folder dialog box, scroll the Select a Search Folder list to see 
the available options, click the option you want, and then click OK.

To make changes to the contents of an existing Search Folder

 ➜ Right-click   the folder, and then click Customize this Search Folder.

To display the default color categories

 ➜ In  the Inbox, click a message you want to categorize, and then on the Standard 
toolbar, click the Categorize button.

To rename categories

1. On   the Standard toolbar, click the Categorize button, and in the Category list, click 
All Categories.

2. In the Color Categories dialog box, click the category (not the check box), and 
then click Rename.

3. Type the name you want, and then press F.

To change the color associated with a category

1. On  the Standard toolbar, click the Categorize button, and in the Category list, click 
All Categories.

2. In the Color Categories dialog box, click the category you want.

3. In the Color palette, click the icon of the color you want.

To create categories

1. On  the Standard toolbar, click the Categorize button, and in the Category list, click 

All Categories.

2. In the Color Categories dialog box, click New.

3. In the Name box of the Add New Category dialog box, type the name you want to 
give the category. Then if you want, assign a color and a shortcut key.
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t the Inbox contents by category

t   the top of the Inbox, click the Arranged By bar, and then click Categories.

o the right of the Arranged By bar, click the command you want.

ate a folder

n  the Standard toolbar, in the New list, click Folder.

 the Name box of the Create New Folder dialog box, type the folder name, and 
en click OK.

ve messages to a folder

rag the message to the desired folder in the Navigation Pane.

r

ight-click the message, and then click Move to Folder.

 the Move Items dialog box, in the Move the selected items to the folder list, 
lick the folder where you want to move the message, and then click OK.

d the content of an e-mail message to OneNote

elect   the message, and then on the Standard toolbar, click the Send selected e-mail 
 OneNote button.

the default automatic archive options

n  the Tools menu, click Options. On the Other tab of the Options dialog box, 
lick AutoArchive.

ake the changes you want to your AutoArchive settings, then click OK in each of 
e open dialog boxes.

nually archive a folder

lick  the folder you want to archive. Then on the File menu, click Archive.

 the Archive dialog box, click Archive this folder and all subfolders, and then 
lick OK.

the archive options for an individual folder

ight-click  the folder in the Navigation Pane, and then click Properties.

n the AutoArchive tab of the Properties dialog box, set the archive options you 
ant, and then click OK.

aging Appointments, Events, and Meetings

edule an appointment

 the   Calendar, display the date on which you want to schedule an appointment.
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. Click the desired time slot, type information about the appointment, and then 
press F.

. To change the end time for the appointment, drag the bottom border of the time 
slot down to the bottom of the end time.

 reschedule an appointment

 Drag t he appointment to a different time slot on the calendar.

 make an appointment recurring

. Open the appointment. Then on the Appointment tab, in the Options group, click 
the Recurrence button.

. In the Recurrence pattern area of the Appointment Recurrence dialog box, click 
the option that corresponds to the desired recurrence, and then click OK.

. On the Recurring Appointment tab, in the Actions group, click the Save & Close 
button.

 schedule an event

. In  the Date Navigator, click the date on which you want to schedule an event, and 
then in the Calendar pane, click the blank space below the day header and above 
the time slots.

. Type the name of the event, and then press F.

 make an event recurring

. Double-click  the event, and then on the Event tab, in the Options group, click the 
Recurrence button.

. In the Recurrence pattern area of the Appointment Recurrence dialog box, click 
the option that corresponds to the recurrence you  want, and then click OK.

. On the Recurring Event tab, in the Actions group, click the Save & Close button.

 create and send a meeting request

. In  the Date Navigator, click the date on which you want the meeting to occur.

. On the Standard toolbar, in the New Appointment list, click Meeting Request.

. In the To box, type the e-mail addresses of the meeting attendees; in the Subject 
box, type the name of the meeting; and in the Location box, indicate where the 
meeting will take place.
. On the Meeting tab, in the Show group, click the Scheduling button. Then set the 
meeting time, and click Send.

 manually respond to a meeting request

. In  the Date Navigator, double-click the scheduled meeting.
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. In the meeting request window, in the Reading Pane, click Accept, Tentative, or 
Decline.

. Choose whether to send a standard response, a personalized response, or no 
response at all.

 propose a new time for a meeting

. In   the Reading Pane of the meeting request window, click Propose New Time.

. In the schedule area of the Propose New Time dialog box, set the proposed 
meeting start and end times, and then click Propose Time.

. In the meeting response window that opens, enter a message to the meeting 
organizer, and then click Send.

 instruct Outlook to automatically respond to meeting requests

. On  the Tools menu, click Options. On the Preferences tab of the Options dialog 
box, click Calendar Options.

. In the Calendar Options dialog box, click Resource Scheduling.

. In the Resource Scheduling dialog box, select the Automatically accept meeting 
requests and process cancellations check box.

. Select the Automatically decline confl icting meeting requests and/or the 
Automatically decline recurring meeting requests check boxes if you want 
Outlook to do this.

. Click OK in each of the open dialog boxes.

anaging Your Calendar
 add the holidays of other countries to your calendar

. On   the Tools menu, click Options. On the Preferences tab of the Options dialog 
box, click Calendar Options.

. In the Calendar Options dialog box, click Add Holidays.

. In the Add Holidays to Calendar dialog box, select the check boxes of the countries 
whose holidays you want to add, and then click OK in each open dialog box.

 remove holidays from your calendar

. In Calendar view, on   the View menu, point to Current View, and then click All 

Appointments.

. On the View menu, point to Current View, and click Customize Current View. 
Then in the Customize View dialog box, click Group By.

. In the Group By dialog box, clear the Automatically group according to arrange-
ment check box if it is selected. Then in the Group items by list, click Location.
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4. Ensure that all the Then by lists display (none), and then click OK in each of the 
open dialog boxes.

5. In the Calendar pane, collapse the displayed groups or scroll the pane until the 
Location group of the holidays you want to remove is visible. Then do one of 
the following:

❍ To remove a specifi c holiday, click it, and then press A.

❍ To remove all the holidays of the displayed country, click the Location group 
header, and then press D. If a Microsoft Offi ce Outlook message box warns 
you that this action will apply to all items in the selected group, click OK.

To change your work week

1. Display  your calendar in Week view, and at the top of the Calendar pane, click 
Show work week.

2. On the Tools menu, click Options. On the Preferences tab of the Options dialog 
box, click Calendar Options.

3. In the Calendar work week area of the Calendar Options dialog box, select or 
clear the check boxes of the days of the week.

4. Set the start and end times, and then click OK in the open dialog boxes.

To change the time zone

1. On  the Tools menu, click Options. On the Preferences tab of the Options dialog 
box, click Calendar Options.

2. In the Calendar Options dialog box, click Time Zone.

3. In the Time zone list, click the time zone you want. Then click OK in each of the 
open dialog boxes.

To simultaneously display two time zones in your Calendar

1. On  the Tools menu, click Options. On the Preferences tab of the Options dialog 
box, click Calendar Options.

2. In the Calendar Options dialog box, click Time Zone.

3. In the Time Zone dialog box, select the Show an additional time zone check box. 
Then in the second Time zone list, click the additional time zone you want to display.

4. Type a label for each time zone in its corresponding Label box, and then click OK in 
each of the open dialog boxes.

To preview and print your calendar
1. On   the View menu, click Day.

2. On the Standard toolbar, click the Print button. Then in the Print dialog box, click 
Preview.

3. On the Print Preview toolbar, click the Print button to redisplay the Print dialog box.
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 the Print style list, click the style of printing you want.

 the Print range area, set the fi rst and last dates you want to print, and then 
ick OK.

e calendar information as a Web page

isplay    your calendar, and then on the File menu, click Save as Web Page.

 the Save as Web Page dialog box, enter the start and end dates for which you 
ant to publish calendar information.

 the Options area, select whether to include appointment details or a background 
raphic.

 the Save as area, append a fi le name (the extension is unnecessary) at the end 
f the path shown in the File name box. If you want, change the title that will be 
isplayed on the Web page and the location where Outlook saves it.

ith the Open saved web page in browser check box selected, click Save.

ed information about your schedule in an e-mail message

isplay   your calendar, and then in the Navigation Pane, under Other Calendars, 
ick Send a Calendar via E-mail.

 the Send a Calendar via E-mail dialog box, in the Date Range list, click the 
mmand you want.

 the Detail list, click the option you want.

lick Advanced, set any options you want, and then click OK.

 one or more calendar entries to OneNote

lect the calendar item (or items) you want to link. Then on the Standard toolbar, 
ick the Open or create linked notes in OneNote button.

 to an Internet calendar

 the Calendar module Navigation Pane, scroll the All Calendar Items list to the 
ther Calendars section, and then click Search Calendars Online.

n the Internet Calendars page, scroll to the Subscribe to a Free Internet 
alendar section, and then click the Internet calendar you want.

 an Internet Explorer Security message box prompts you to allow Outlook to 
pen Web content, click the Allow button.

 the Microsoft Offi ce Outlook message box asking whether you want to add the 

lendar to Outlook and subscribe to updates, click Yes.

 multiple calendars side by side and as a composite

  either the My Calendars or Other Calendars list in the Navigation Pane, select 
e check box for at least one other calendar.
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2. On the title bar tab of a secondary calendar, click the View in Overlay Mode 
button.

3. Click either Calendar tab to display that calendar on top of the other calendar.

4. On either of the overlaid calendars, click the View in Side-By-Side Mode button to 
return to the standard display.

To delegate control of your calendar so that meeting requests can be created and 
responded to on your behalf

1. On   the Tools menu, click Options. On the Delegates tab of the Options dialog box, 
click Add.

2. In the Add Users dialog box, click the person you want to delegate control to, click 
Add, and then click OK.

3. In the Delegate Permissions dialog box, in the Calendar list, click the level of 
permission you want to delegate.

4. Select the Automatically send a message to delegate summarizing these 
permissions check box, and then click OK in each of the open dialog boxes.

Tracking Tasks
To create a folder that can contain tasks

1. On   the Standard toolbar, in the New list, click Folder.

2. In the Create New Folder dialog box, enter the name and select the location of the 
folder.

3. In the Folder contains list, click Task Items, and then click OK.

To create a task

 ➜ On  the To-Do Bar, click the Type a new task box, type a description of your task, 
and then press F.

To update a task

 ● To   assign a completion time, in the To-Do Bar Task List, right-click the fl ag following 
the task, and then click the timeframe you want.

 ● To assign the task to a category, right-click the Category bar following the task, 
and then click the category you want.

 ● To change the task text, double-click the task in the Tasks pane, and in the content 

pane, type the new text. Then save and close the task.

 ● To change the status, double-click the task in the Tasks pane, and in the Status list, 
click the option that applies to the task. Then in the % Complete box, change the 
completion percentage of the task, and save and close the task.
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 delegate a task to another Outlook user

. On   the To-Do Bar, double-click the task you want to delegate.

. In the task window, on the Task tab, in the Manage Task group, click the Assign 
Task button.

. In the To box that appears, type the e-mail address of the person you want to 
assign the task to.

. If you want Outlook to display a reminder for the task, in the Options group, click 
the Follow Up button.

. Click Send. If a message box appears to notify you that the task reminder has been 
turned off, click OK.

 update the status of tasks assigned to you by other people

● To   change the percentage of the project you estimate as complete, open the 
task, and then in the % Complete list, type or select (by clicking the arrows) the 
percentage.

● To manually change the task status, open the task, and then in the Status list, click 
the status you want.

 send a status report about a task

. In  the Tasks pane, double-click the task, and then on the Task tab, in the Manage 
Task group, click the Send Status Report button.

. Address the message to the people you want to send the report to, and click Send.

 mark a task as complete

 In   the Tasks pane, double-click the task, and then on the Task tab, in the Manage 
Task group, click the Mark Complete button.

 stop a reminder from appearing

. In   the To-Do Bar Task List, right-click the task, point to Follow Up, and then click 
Add Reminder.

. Clear the Reminder check box, and then click OK.

 delete a task

 In   the To-Do Bar Task list, click the task, and then press A.

thering Information

 subscribe to an RSS feed

. In   the Navigation Pane, under your primary mailbox, click the RSS Subscriptions 
folder.

. On the Outlook Syndicated Content (RSS) Directory page, click the feed you want 
to subscribe to.
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3. In the Microsoft Offi ce Outlook message box asking whether to add the RSS feed 
to Outlook, click Yes.

To remove an RSS feed

1. On  the Tools menu, click Account Settings.

2. In the Account Settings dialog box, click the RSS Feeds tab.

3. In the Feed Name list, click the name of the feed you want to remove.

4. Click Remove. Then in the Microsoft Offi ce Outlook message box asking whether 
to remove the RSS feed from Outlook, click Yes.

To change the default note color, size, or font

1. On   the Tools menu, click Options. On the Preferences tab of the Options dialog 
box, click Note Options.

2. Change the settings you want, and then click OK twice.

To create a note

1. In  the Notes pane, on the Standard toolbar, click the New Note button. 

2. Type the note title, press F, type the note text, and then click the Close button.

To link a note to a contact

1. Open   a note in the Notes pane, click the Note icon in its upper-left corner, and 
then click Contacts.

2. In the Contacts for Note dialog box, click Contacts.

3. In the Select Contacts dialog box, with Contacts selected in the Look in list, click 
the contact you want to link to in the Items list. Then click OK.

4. In the Contacts for Note dialog box, click Close. Then close the note.

To access a note from a contact record

1. In the Contacts pane, open the contact record. Then on the Contact tab, in the 
Show group, click the Activities button.

2. In the Show list, click Notes.

To display the Journal

 ➜ On  the Go menu, click Journal.

To add the Journal button to the Navigation Pane

1. In  the lower-right corner of the Navigation Pane, click the Confi gure buttons 

button.

2. Point to Add or Remove Buttons, and then click Journal.

5/15/2008   2:43:17 PM



lvi  Quick Referen

To re

 1. 

 2. 

 3. 

 4. 

To fo

 1. 
 2. 

To sa

 1. 
 2. 
 3. 
 4. 

To o

 1. 
 2. 

 10 Col
To al

 1. 

 2. 
 3. 

 4. 

 5. 

a12q623002.indd   56
ce

cord activities automatically

On  the Tools menu, click Options. On the Preferences tab of the Options dialog 
box, click Journal Options.

In the Journal Options dialog box, in the Automatically record these items box, 
select the check boxes for the activities you want to record.

In the For these contacts box, select the check boxes for the contacts whose items 
you want to record.

In the Also record fi les from box, select the check boxes for the programs whose 
fi les you want to record, and then click OK in the open dialog boxes.

rward a note

Right-click   a note in the Notes pane, and then click Forward.

In the To box, type the e-mail address of the person you want to send the note to, 
and then click Send.

ve a note as a fi le

Open   the note, click its Note icon, and then click Save As.

In the Save As dialog box, browse to the folder where you want to save the fi le.

In the Save as type list, click the fi le type you want to create.

In the File name box, change the fi le name if you want it to be something other 
than the current note title, and then click Save.

pen a received note

In   your Inbox, click the message with the note attached to it.

In the Reading Pane, right-click the attached note, and then click Open.

laborating with Other People
low another person on your Exchange Server network to access a folder

In   the Navigation Pane, right-click the folder, and then click Change Sharing 
Permissions.

On the Permissions tab of the Properties dialog box, click Add.

In the Add Users dialog box, double-click the name of the person with whom you 
want to share this folder, and then click OK.
With the person’s name selected on the Permissions tab, in the Permission Level 
list, click the level you want.

In the Properties dialog box, click Apply.

5/15/2008   2:43:18 PM



 

 

 

 

 

 

 
 

 

 
 

 

 

 11 

 
 

 

a12q623002.indd   57
Quick Reference  lvii

To create a document workspace from a message

1. In  a new message window, enter the addresses of the people you want to invite to 
the document workspace and a subject.

2. On the Message tab, in the Include group, click the Attach File button. Then in the 
Insert File dialog box, browse to and select the fi le(s) you want to share through a 
document library, and click Insert.

3. Click the Include dialog box launcher. Then under  Send attachments as in the 
Attachment Options task pane, click Shared attachments.

4. In  the Create Document Workspace at box, enter the address of your collaboration 
site, and then press the D key.

5. Send the message invitation that appears in the content area.

To create a group schedule

1. Display  your calendar, and then on the Actions menu, click View Group Schedules.

2. In the Group Schedules dialog box, click New. In the Create New Group Schedule 
dialog box, type a name for the schedule, and then click OK.

3. In the scheduling window, add members to the group by clicking in the Group 
Members list and then typing a name or an e-mail alias, or by clicking Add Others 
and then selecting group members from your address book.

To get a local copy of document library contents

1. On   your organization’s collaboration site, display the document library.

2. On the Actions menu, click Connect to Outlook. If an Internet Explorer Security 
alert appears, click Allow.

3. In  the Microsoft Offi ce Outlook message box asking you to confi rm that you 
want to connect the SharePoint document library to Outlook, click Yes. If a 
Connect dialog box appears, prompting you for your site credentials, enter your 
user name and password, and then click OK.

4. To preview downloaded items, click them; to open a read-only version of an item, 
double-click it.

Working Away from Your Offi ce
To confi gure Outlook to connect to an Exchange account by using the 
Outlook Anywhere feature
1. On  the Tools menu, click Account Settings.

2. On the E-mail tab of the Account Settings dialog box, in the Name list, click your 
Microsoft Exchange account, and then click Change.

3. In the Change E-mail Account dialog box, click More Settings.
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n the Microsoft Exchange dialog box, click the Connection tab.

n the Outlook Anywhere area, select the Connect to Microsoft Exchange using 
TTP check box.

lick the Exchange Proxy Settings button that becomes active.

n the Microsoft Exchange Proxy Settings dialog box, in the Connection settings 
rea, in the https:// box, type your organization’s Exchange proxy address.

lick OK in the Microsoft Exchange Proxy Settings dialog box and the Microsoft 
xchange dialog box. Then in the message box that appears, click OK to acknowl-
dge that the change will not take effect until you restart Outlook.

n the Change E-mail Account dialog box, click Next, and then click Finish.

lose the Account Settings dialog box, and then exit and restart Outlook.

n the Connect to dialog box, enter your user name and password, and click OK.

 up a VPN connection from a computer running Windows Vista

n  the right pane of the Start menu, click Connect To.

n the Connect to a Network dialog box, click Set up a connection or network.

croll the Choose a connection option list, click Connect to a workplace, and then 
lick Next.

nder Do you want to use a connection that you already have?, click No, create a 
ew connection, and then click Next.

nder How do you want to connect?, click Use my Internet connection (VPN).

nder Type the Internet address to connect to, type the Internet address you 
ant to connect to in the Internet address box. In the Destination name box, type a 
ame for the VPN connection, select any options that you want, and then click Next.

nder Type your user name and password, type your user name and password 
the domain name is optional), and then click Connect.

 up a VPN connection from a computer running Windows XP

n   the Start menu, if the Connect To menu appears on the right side, click 
onnect To, and then click Show all connections. Otherwise, open Control Panel 

n Classic view, and then click Network Connections.

n the Network Connections window, on the Network Tasks menu, click Create a 

ew connection.

n the fi rst page of the New Connection wizard, click Next.

n the Network Connection Type page, click Connect to the network at my 
orkplace, and then click Next.
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5. On the Network Connection page, click Virtual Private Network connection, and 
then click Next.

6. In the Company Name box, type a name by which you will identify the connection. 
Then click Next.

7. If the wizard displays the Public Network page, click Do not dial the initial con-
nection to indicate that you will always connect to the Internet before starting the 
VPN connection. Then click Next.

8. On the VPN Server Selection page, type the URL of your organization’s VPN server 
in the Host name box, and then click Next.

9. If your system includes a SmartCard reader, the wizard displays the Smart Cards 
page. If you don’t need to use your SmartCard to log in to this particular connec-
tion, click Do not use my smart card, and then click Next.

10. On the Connection Availability page, click My use only, and then click Next.

11. On the Completing page, click Finish.

12. In the User name box of the Connect dialog box, type your domain\username, and 
in the Password box, type your domain password.

13. Select the Save this user name check box and the Me only or Everyone option. 
Then click Connect.

To make the contents of a folder available for offl ine use

 ➜ In  the Navigation Pane, click the folder. On the Tools menu, point to Send/
Receive, point to Send/Receive Settings, and then click Make This Folder 
Available Offl ine.

To manually update your offl ine address book

1. On  the Tools menu, point to Send/Receive, and then click Download Address Book.

2. In the Offl ine Address Book dialog box, with the Download changes since last 
Send/Receive check box selected, click Full Details, and then click OK.

To confi gure Outlook to automatically reply to incoming messages

1. On the Tools menu, click Out of Offi ce Assistant.

2. In the Out Of Offi ce Assistant dialog box, click I am currently Out of the Offi ce.

3. In  the AutoReply only once to each sender with the following text box, type 
the text of the auto-reply message you want to send, click OK, and then click the 
notifi cation to close it.
To set up a rule to auto-forward messages to another e-mail address

1. On the status bar, click Out of Offi ce. Then on the Out of Offi ce menu, click Out of 
Offi ce Assistant.
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In the Out of Offi ce Assistant dialog box, click Add Rule. Then in the Edit Rule 
dialog box, click Advanced.

In   the Received area, specify the start date, end date, or any date range you want.

To set the importance of the message, select the Importance check box, click the 
option you want in the Importance list, and then click OK.

In the Edit Rule dialog box, under Perform these actions, select the Forward check 
box. Then in the To box, type the e-mail address to which you want to forward 
messages.

In the Method list, click the forwarding option you want. Then click OK.

rn off Out Of Offi ce auto-reply messages

Click the Out of Offi ce icon on the status bar, and then click Turn off Out of Offi ce 
auto-replies.

tomatically reply to messages during a future time period (applies only to 
ange Server 2007 accounts)

On the Tools menu, click   Out Of Offi ce Assistant.

In the Out of Offi ce Assistant dialog box, click Send Out of Offi ce auto-replies.

Select the Only send during this time range check box. Then set the Start time 
and End time settings as you want.

On the Inside My Organization tab, in the message box, type the text of the 
message you want to send, and then click OK.

nd a different auto-reply message to people outside your organization 
ies only to Exchange Server 2007 accounts)

Display the Out Of Offi ce Assistant dialog box, and click  the Outside My 
Organization tab.

Click Anyone outside my organization.

In the message box, type the text of the message you want to send to people 
outside your organization, and then click OK.

tomizing and Confi guring Outlook
d a button to the Quick Access Toolbar
At  the right end of the Quick Access Toolbar, click the Customize Quick Access 
Toolbar button, and then click More Commands.

In the Editor Options window, on the Customize page, in the Choose commands 
from list, click the tab from which you want to choose a command.
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3. In the tab’s command list, click a command you want to add to the toolbar, and 
then click Add.

4. Click the Move Up and Move Down buttons to position the command where you 
want on the toolbar, and then at the bottom of the Customize page, click OK.

o customize Outlook

1. Click   the Microsoft Offi ce Button, and then in the lower-right corner of the Offi ce 
menu, click Editor Options.

2. In the Editor Options window, in the page list in the left pane, click the page you 
want, make your changes, and then click OK to save your changes.

o add a button to a toolbar

1. Click  the Toolbar Options button at the right end of any toolbar, point to Add or 
Remove Buttons, and then click Customize.

2. In the Customize dialog box, click the Commands tab. In the Categories list, click 
the category containing the command you want to add.

3. In the Commands list, locate the command you want to add. Then drag the com-
mand from the list to the position where you want it to appear on the toolbar.

o rearrange the commands on a toolbar

1. Click  the Toolbar Options button, point to Add or Remove Buttons, and then click 
Customize.

2. In the Customize dialog box, on the Commands tab, click Rearrange Commands.

3. In the Rearrange Commands dialog box, under Choose a menu or toolbar to 
rearrange, click Toolbar. Then in the Toolbar list, select the toolbar or menu bar 
you want to rearrange.

4. In the Controls list, click the command you want to reposition, click Move Up or 
Move Down as many times as necessary to position the command where you want 
it, and then click Close.

o remove a custom button from a toolbar

1. Click  the Toolbar Options button, point to Add or Remove Buttons, and then click 
Customize.

2. In the Customize dialog box, on the Commands tab, click Rearrange Commands.

3. In the Rearrange Commands dialog box, under Choose a menu or toolbar to 
rearrange, click Toolbar, and then in the list, click the toolbar containing the 

button you want to remove.

4. In the Controls list, click the button you want to remove. Click Delete, and then 
click Close.
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eset a toolbar to its default state

Click  the Toolbar Options button, point to Add or Remove Buttons, and then click 
Customize. 

In the Customize dialog box, on the Toolbars tab, click the toolbar you want to 
restore to its default settings, and then click Reset.

reate a rule to process incoming messages that meet specifi c criteria

On  the Tools menu, click Rules and Alerts. Then in the Rules and Alerts window, 
on the E-mail Rules tab, click New Rule.

In the Rules wizard, in the Select a template list, under Start from a blank rule, 
click Check messages when they arrive, and then click Next.

In the Select condition(s) list, select the conditions you want to apply to your 
new rule.

In the Edit the rule description box, click the underlined term specifi c words.

In the Search Text dialog box, in the Specify words or phrases to search for in the 
subject box, type the words you want to search for, click Add, and click OK. Then in 
the Rules wizard, click Next.

Scroll the Select action(s) list to review and select the actions Outlook can perform 
on incoming items meeting the criteria you specify, and click OK. Then in the Rules 
wizard, click Next.

Select any exceptions you want to set for your rule, and then click Next.

Select the Run this rule now on messages already in “Inbox” check box, and click 
Finish. Then in the Rules and Alerts dialog box, click OK.

reate a Personal Folders fi le

On  the File menu, point to New, and then click Outlook Data File.

If you run Microsoft Outlook 2002 or an earlier version on a different computer 

and you might want to open this Personal Folders fi le in that version, click Outlook 
97-2002 Personal Folders File in the New Outlook Data File dialog box. Otherwise, 
select Offi ce Outlook Personal Folders File, and then click OK.

In the Create or Open Outlook Data File dialog box, in the Favorite Links list, click 
the type of link you want.

In the File name box, type the name of your personal folder fi le, and then click OK.

In the Create Microsoft Personal Folders dialog box, replace the suggested name 
with a new name or accept it, and click OK.

ove messages or folders to your Personal Folders fi le

In  the Navigation Pane, expand the Inbox to display its folder list.

Drag the messages or folders from your Inbox to your personal folder.
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To copy messages and folders to your Personal Folders fi le

1. In  the Navigation Pane, expand the Inbox to display its folder list.

2. Hold down the right mouse button, and drag the messages or folders from your 
Inbox to your personal folder. When you release the mouse button, click Copy.

To open and close data fi les from within Outlook

1. On    the File menu, point to Open, and then click Outlook Data File.

2. In the Open Outlook Data File dialog box, browse to the location of your data fi le, 
and then double-click it.

To digitally sign all outgoing messages

1. On  the Tools menu, click Trust Center, and in the page list, click E-mail Security. 
Then on the E-mail Security page, select the Add digital signature to outgoing 
messages check box.

2. If all your message recipients don’t have Secure Multipurpose Internet Mail 
Extensions (S/MIME) security, select the Send clear text signed message when 
sending signed messages check box, and then click OK.

To obtain a digital ID to sign or encrypt documents and messages

1. On  the Tools menu, click Trust Center, and then in the page list, click E-mail 
Security.

2. On the E-mail Security page, click Get a Digital ID.

3. On the Microsoft Offi ce Marketplace Web page, click the link at the end of a 
provider’s description to display the provider’s Web site.

4. Follow the instructions on the Web site to register for a digital ID.

To export or import a digital ID

1. On    the Tools menu, click Trust Center, and then in the page list, click E-mail Security.

2. On the E-mail Security page, click Import/Export.

3. In the Import/Export Digital ID dialog box, select whether you want to import or 
export your digital ID, fi ll in the information, and then click OK.

To digitally sign an individual e-mail message

 ➜ On  the Message tab, in the Options group, click the Digitally Sign Message button.
To encrypt all outgoing messages

1. On  the Tools menu, click Trust Center, and then in the page list, click E-mail Security.

2. On the E-mail Security page, select the Encrypt contents and attachments for 
outgoing messages check box.
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3. To receive verifi cation that a message recipient received an encrypted message in 
its encrypted format, select the Request S/MIME receipt for all S/MIME signed 
messages check box, and then click OK.

To encrypt an individual message

 ➜ On  the Message tab, in the Options group, click the Encrypt Message Contents 
and Attachments button.

To receive all messages in plain text format

1. On  the Tools menu, click Trust Center, and then in the page list, click E-mail 
Security.

2. On the E-mail Security page, select the Read all standard mail in plain text check 
box, and then click OK.

To prevent message recipients from forwarding, printing, or copying a message

 ➜ With   a message open, on the Message tab, in the Options group, in the 
Permissions list, click Do Not Forward.

To view the blocked content in an individual e-mail message

 ➜ In  the message header, click the InfoBar, and then click Download Pictures.

To change the way Outlook handles external content

1. On the Tools menu, click Trust Center, and then in the page list, click Automatic 
Download.

2. Select the check boxes for the options you want, and then click OK.

To apply spam fi ltering options provided by the Junk E-Mail Filter

1. On  the Actions menu, point to Junk E-mail, and then click Junk E-mail Options.

2. In the Junk E-mail Options dialog box, on the Options tab, select a level of 
protection.

3. If you want Outlook to automatically delete suspected junk e-mail, select the 
Permanently delete suspected Junk E-mail instead of moving it to the Junk 
E-mail folder check box.

4. Click the Safe Senders tab, add any e-mail addresses you want included in the Safe 
Senders List, or specify that e-mail received from a particular domain is safe.

5. Click the Safe Recipients tab, and add any addresses or domains to your Safe 

Recipients List.

6. Click the Blocked Senders tab, and add any addresses or domains to the Blocked 
Senders List.

7. Click the International tab, and set options to block messages from country-specifi c 
domains or messages containing specifi c language text encoding, and then click OK.
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To save message drafts more frequently

1. On   the Tools menu, click Options. On the Preferences tab of the Options dialog 
box, click E-mail Options. Then in the E-mail Options dialog box, click Advanced 
E-mail Options.

2. In the Save messages area of the Advanced E-mail Options dialog box, select the 
AutoSave items every check box, and enter a number in the minutes box. Then 
click OK in each of the open dialog boxes.

To specify what happens when a message arrives

1. On  the Tools menu, click Options. On the Preferences tab of the Options dialog 
box, click E-mail Options. Then in the E-mail Options dialog box, click Advanced 
E-mail Options.

2. In the Advanced E-mail Options dialog box, in the When new items arrive in my 
Inbox area, select the options for how you want to be notifi ed when a new message 
arrives. Then click OK in each of the open dialog boxes.

To set options for sending messages

1. On  the Tools menu, click Options. On the Preferences tab of the Options dialog 
box, click E-mail Options. Then in the E-mail Options dialog box, click Advanced 
E-mail Options.

2. In the Advanced E-mail Options dialog box, in the When sending a message area, 
set the options you want to apply to the messages you send. Then click OK in each 
of the open dialog boxes.
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	this	chapter,	you	will	learn	to:

✔	 View messages and message attachments.

✔	 Reply to and forward messages.

✔	 Work with new mail notifi cations.

✔	 Create a task or an appointment from a message.

✔	 Print messages.

ost new e-mail messages you receive appear in your Microsoft Offi ce Outlook Inbox. (The 
ceptions to this are messages processed by any Outlook rules you or your administrator 
s set up, and messages diverted to the Junk E-mail folder due to suspicious content.)

fter messages arrive in your Inbox, you can handle them in various ways. For example, 
u can:

l	 Read the message, either in the Reading Pane or in a message window.

l	 View any attachments, either in the Reading Pane or in the appropriate program, 
and save attachments to your hard drive.

l	 Respond to the message sender or to the message sender and all recipients.

l	 Forward the message to another person.

l	 Create an appointment or task based on the message.

l	 Categorize the message or fi le it in an Outlook folder for future electronic 
reference.

l	 Print the message for future “hard copy” reference.

l	 Delete the message.
	 	 113

hen you are working online, you usually receive messages as soon as they are processed 
 your e-mail server. If you are working offl ine, you will need to connect to your server 
 download new messages. You can do this manually or set up Outlook to automatically 
eck for new messages at regular intervals.
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e	Also	 For	information	about	Outlook	rules,	see	“Creating	Rules	to	Process	Messages”	and	
r	information	about	junk	e-mail,	see	“Blocking	Unwanted	Messages,”	both	in	Chapter	12,	
ustomizing	and	Confi	guring	Outlook.”

 this chapter, you will experiment with receiving, viewing, responding to, or otherwise 
ocessing e-mail messages. You will preview and view messages and fi les attached to 
em. You will reply to and forward messages. Then you will work with incoming mes-
ges through New Mail notifi cations and learn to confi gure the notifi cations to display 
e way you want. You will also fl ag a message for follow-up so that it appears in the To-
 list, create an appointment from a message, and print a message.

e	Also	 Do	you	need	only	a	quick	refresher	on	the	topics	in	this	chapter?	See	the	Quick	
ference	section	at	the	beginning	of	this	book.

Important	 The exercises in this chapter require only practice fi les created in earlier 
chapters; none are supplied on the companion CD. For more information about practice 
fi les, see “Using the Companion CD” at the beginning of this book.

Troubleshooting	 Graphics and operating system–related instructions in this book 
refl ect the Windows Vista user interface. If your computer is running Windows XP 
and you experience trouble following the instructions as written, please refer to the 
“Information for Readers Running Windows XP” section at the beginning of this book.

	Messages	and	Message	Attachments
ch time you start Outlook and connect to your e-mail server, any new messages 
ceived since the last time you connected appear in your Inbox. Depending on your 
ttings, Outlook downloads either the entire message to your computer or only the 
essage header, which provides basic information about the message, such as:

l	 The item type (message, meeting request, task assignment, and so on)

l	 Who sent it

l	 When you received it

Troubleshooting	 Graphics and operating system–related instructions in this book Graphics and operating system–related instructions in this book 
refl ect the Windows Vista user interface. If your computer is running Windows XP refl ect the Windows Vista user interface. If your computer is running Windows XP 
and you experience trouble following the instructions as written, please refer to the and you experience trouble following the instructions as written, please refer to the 
“Information for Readers Running Windows XP” section at the beginning of this book.“Information for Readers Running Windows XP” section at the beginning of this book.
l	 The subject

l	 If you forwarded or replied to it

l	 If it contains attachments

l	 If it has been digitally signed or encrypted

l	 If it has been marked as being of high or low importance
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Read and  
responded to

Meeting request 
with reminder

Contains one or 
more attachments

Unread  
message Importance

Sender, subject,  
and time received

ssages that you haven’t yet read are indicated by closed envelope icons and bold 
ders. You can view the text of a message in several ways:

	 You can open a message in its own window by double-clicking its header in the 
message list.

	 You can read a message without opening it by clicking its header in the message 
list to display the message in the Reading Pane. 

	 If you turn on the Single Key Reading Using Space Bar option, you can page 
through a message in the Reading Pane by pressing the Spacebar. When you reach 
the end of a message, the first page of the next message is displayed. This option 
is very convenient if you want to read through several consecutive messages in 
the Reading Pane, or if you find it easier to press the Spacebar than to scroll the 
Reading Pane by using the mouse. If you do not turn on this option, pressing the 

Viewing Messages and Message Attachments    115
Spacebar while viewing a message does nothing, so there is no harm in turning it 
on even if you aren’t sure you will use it.
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Tip	 To control whether you can page through messages by pressing the Spacebar, 
click Options on the Tools menu. On the Other tab of the Options dialog box, in the 
Outlook Panes area, click Reading Pane. Then in the Reading Pane dialog box, select 
or clear the Single Key Reading Using Space Bar check box, and click OK twice.

u  can display the fi rst three lines of each message under the message header by 
ing the AutoPreview feature. Scanning the fi rst three lines of a message frequently 
ves you enough information to make basic decisions about how to manage it. The 
ly drawback is that AutoPreview dedicates fi ve lines to each message rather than 
e two lines of the default Messages view, so fewer messages are visible on your 
reen at one time.

king	Messages	as	Read
n you open a message, Outlook indicates that you have read it, by changing 
essage icon from a closed envelope to an open envelope and changing the 

er font in the message list from bold to normal. You   can also instruct Outlook 
ark a message as read after you have previewed it in the Reading Pane for a 
in length of time. To do so:

On the Tools menu, click Options.

On the Other tab of the Options dialog box, in the Outlook	Panes area, click 
Reading	Pane.

In the Reading	Pane dialog box, select the check box corresponding to the 
way you want Outlook to handle messages you view in the Reading Pane.

❍	 Mark	items	as	read	when	viewed	in	the	Reading	Pane. Outlook will 
mark the item as read after it has been displayed in the Reading Pane 
for fi ve seconds or the amount of time you specify.

❍	 Mark	item	as	read	when	selection	changes. Outlook will mark the item 
as read when you select another item.

Click OK in the two open dialog boxes.

an manually mark an item as read or unread by right-clicking the item and 
clicking Mark As Read or Mark As Unread. (The context menu shows only the 

❍	❍	

❍	❍	

king	Messages	as	Read
n you open a message, Outlook indicates that you have read it, by changing n you open a message, Outlook indicates that you have read it, by changing 
essage icon from a closed envelope to an open envelope and changing the essage icon from a closed envelope to an open envelope and changing the 

er font in the message list from bold to normal. You er font in the message list from bold to normal. You can also instruct Outlook can also instruct Outlook 
ark a message as read after you have previewed it in the Reading Pane for a ark a message as read after you have previewed it in the Reading Pane for a 
in length of time. To do so:in length of time. To do so:

On the On the ToolsTools menu, click  menu, click OptionsOptions..

On the On the OtherOther tab of the  tab of the OptionsOptions dialog box, in the  dialog box, in the Outlook	PanesOutlook	Panes area, click  area, click 
Reading	PaneReading	Pane..

In the In the Reading	PaneReading	Pane dialog box, select the check box corresponding to the  dialog box, select the check box corresponding to the 
way you want Outlook to handle messages you view in the Reading Pane.way you want Outlook to handle messages you view in the Reading Pane.

❍	 Mark	items	as	read	when	viewed	in	the	Reading	PaneMark	items	as	read	when	viewed	in	the	Reading	Pane. Outlook will . Outlook will 
mark the item as read after it has been displayed in the Reading Pane mark the item as read after it has been displayed in the Reading Pane 
for fi ve seconds or the amount of time you specify.for fi ve seconds or the amount of time you specify.

❍	 Mark	item	as	read	when	selection	changesMark	item	as	read	when	selection	changes. Outlook will mark the item . Outlook will mark the item 
as read when you select another item.as read when you select another item.

Click Click OKOK in the two open dialog boxes. in the two open dialog boxes.OKOK in the two open dialog boxes.OKOK

an manually mark an item as read or unread by right-clicking the item and an manually mark an item as read or unread by right-clicking the item and 
clicking Mark As Read or Mark As Unread. (The context menu shows only the clicking Mark As Read or Mark As Unread. (The context menu shows only the 

❍	❍	❍	❍	

❍	❍	
ble option.)ble option.)ble option.)
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an view message attachments in several ways:

You   can open the attachment from an open message or from the Reading Pane.

You    can preview certain types of attachments (including Microsoft Offi ce Excel 
spreadsheets, Microsoft Offi ce PowerPoint slideshows, Microsoft Offi ce Word 
documents, and Portable Document Format (PDF) fi les) directly in the Reading 
Pane without opening the attached fi le. This new feature of Outlook 2007 saves 
time and increases effi ciency. If you install add-ins provided by companies other 
than Microsoft (called third-party add-ins), you can preview other types of fi les 
as well.

You   can save the attachment to your hard disk and open it from there. This strategy 
is recommended if you suspect an attachment might contain a virus, because you 
can scan the attachment for viruses before opening it (provided that you have a 
virus scanning program installed).

 receive a contact record as a message attachment, you can add it to your primary 
ss book by dragging the attachment from the e-mail message to the Contacts button 
 Navigation Pane. To add the contact record to a secondary address book, expand 
lder structure in the Navigation Pane and drag the attachment to that folder.

lso	 For	information	about	protecting	your	computer	from	viruses,	refer	to	Windows Vista 
y Step,	by	Joan	Preppernau	and	Joyce	Cox	(Microsoft	Press,	2007)	or	Microsoft Windows 

ep by Step,	by	Online	Training	Solutions,	Inc.	(Microsoft	Press,	2004).

s exercise, you will preview and open a message and an attachment.

E	 the SBS First Draft message you created in “Attaching Files to Messages” in Chapter 3, 
nding E-Mail Messages.” If you did not complete that exercise, you can do so now, or you 

n use any message with an attachment in your Inbox.

	SURE	TO	 start Outlook and display your Inbox before beginning this exercise.

On   the View menu, click AutoPreview.

Troubleshooting	 If the AutoPreview icon on the View menu is shaded, this feature 
is already turned on.

E	 the the SBS First DraftSBS First Draft message you created in “Attaching Files to Messages” in Chapter 3,  message you created in “Attaching Files to Messages” in Chapter 3, SBS First DraftSBS First Draft message you created in “Attaching Files to Messages” in Chapter 3, SBS First DraftSBS First Draft
nding E-Mail Messages.” If you did not complete that exercise, you can do so now, or you nding E-Mail Messages.” If you did not complete that exercise, you can do so now, or you 

n use any message with an attachment in your Inbox.n use any message with an attachment in your Inbox.

	SURE	TO	 start Outlook and display your Inbox before beginning this exercise.start Outlook and display your Inbox before beginning this exercise.

Troubleshooting	 If the AutoPreview icon on the View menu is shaded, this feature If the AutoPreview icon on the View menu is shaded, this feature 
is already turned on.is already turned on.

Viewing	Messages	and	Message	Attachments	 	 117
The fi rst three lines of each message appear in the Inbox below the message 
header.
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2.	 Locate   the SBS First Draft message in your Inbox, and then click the message.

Outlook displays the message in the Reading Pane . Note that the Reading Pane 
displays the message header and the names of any attached fi les.

3.	 In the Reading	Pane, point to the  Message button below the message header.

Troubleshooting	 If you are working through this exercise with a message that 
does not have an attachment, you will not see a Message button.

A ScreenTip displays the number of attachments.

Troubleshooting	 If you are working through this exercise with a message that If you are working through this exercise with a message that 
does not have an attachment, you will not see a Message button.does not have an attachment, you will not see a Message button.
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4.	 Point to the Attaching.docx attachment.

A ScreenTip displays the name, type, and size of the attached file.

5.	 Click the Attaching.docx attachment once.

Outlook asks you to confirm that you want to preview the file. This security  
measure is designed to prevent viruses or other malicious content from running 
without your consent.

6.	 In the Reading Pane, click Preview file.

Tip  If you want Outlook to display previews of attachments without your explicit 
permission in the future, clear the Always Warn Before Previewing This Type Of File 
check box.

Viewing Messages and Message Attachments    119
The fully formatted Word 2007 document appears in the Reading Pane. You can 
scroll through the entire document within this pane, without starting Word.
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7.	 Click the Attaching.pptx attachment, and then click the Preview file button.

The title slide of this PowerPoint presentation appears in the Reading Pane. You can 
move among the presentation’s slides by clicking the Previous Slide and Next Slide 
buttons in the lower-right corner of the pane.

Slide navigation buttons

8.	 In the Reading Pane, click the Message button.

The message text reappears in the Reading Pane. You can switch between the 
message and any attachments in this way.

9.	 In the Reading Pane, double-click the Attaching.pptx attachment, and then in the 
Opening Mail Attachment message box, click Open.

PowerPoint 2007 starts and opens the Attaching presentation.

See Also  For an introduction to the features of PowerPoint 2007, refer to Microsoft Office 
PowerPoint 2007 Step by Step, by Joyce Cox and Joan Preppernau (Microsoft Press, 2007).

10.	 Close the presentation to return to your Inbox.
11.	 In the message list, double-click the SBS First Draft message.

The message opens in its own window.
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Note the message header and the attached fi le at the top. You can preview an 
attachment in the message window by clicking it once, and open an attachment 
by double-clicking it.

CLOSE	 the SBS First Draft message window.

lying	to	and	Forwarding	Messages
You   can reply to or forward most e-mail messages that you receive by clicking the Reply, 
Reply To All, or Forward button either within the message window or on the Standard 
toolbar. When replying to a message, Outlook fi lls in the To and Cc boxes for you, ad-
dressing the response either to only the original message sender or to the message 
sender and all other people to whom the message was addressed or copied (recipients 
listed in the To and Cc boxes), depending on the reply option you choose. Outlook does 
not include recipients of blind courtesy copies (Bcc recipients) in message replies. You 
can add, change, and delete recipients from any reply before sending it.

To  include all recipients of a message in your reply, click the Reply To All button. Outlook 
addresses your reply to the original message sender and any recipients listed in the To 
box of the original message, and sends a copy to any recipients listed in the Cc box of 
the original message.

Similarly, you can forward a received message to any e-mail address (regardless of whether 
the recipient uses Outlook) provided the message was not sent with restricted permissions. 
When forwarding a message, Outlook does not fi ll in the recipient boxes for you.

CLOSE the SBS First Draft message window.

Replying	to	and	Forwarding	Messages	 	 121
See	Also	 For	information	about	restricting	recipients	from	copying,	printing,	or	forwarding	
messages,	see	“Securing	Your	E-Mail”	in	Chapter	12,	“Customizing	and	Confi	guring	Outlook.”
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Handling E-Mail Messages

n responding to an e-mail message, take care to use good e-mail etiquette. 
xample, don’t forward messages containing large attachments to people with 

bandwidth connections who don’t need the attachment. If your response is not 
nent to all the original recipients of a message, don’t reply to the entire recipient 
specially if the message was addressed to a distribution list that might include 
reds of members.

p  You can prevent people who are using Outlook from automatically replying to all 
cipients of a message you send, by creating a custom message form with the Reply To 
l functionality disabled. For more information, see the article “Prevent e-mail message 
cipients from using Reply All or Forward” at

fice.microsoft.com/en-us/assistance/HA011142241033.aspx

is method does not prevent recipients using Windows Mail, Microsoft Outlook Express, 
 Microsoft Outlook Web Access from using the Reply To All function. And of course, the 
rson responding to your message can always choose to manually address his or her re-
onse to all the original recipients.

 easier way to prevent people from replying to multiple message recipients is to address 
e message to yourself and send blind courtesy copies to all other recipients. Then the 
cipient list will not be visible to anyone.

 original message contains one or more attachments, be aware that replies do not 
de attachments, and forwarded messages do.

p  If a message contains voting buttons, you can respond by opening the message and 
cking the button corresponding to the response you want to send. Or you can click the 
fobar (labeled Click Here To Vote) in the Reading Pane and then click the option you want. 
u can choose to send a blank response containing your vote in the message header, or 
u can edit the response to include additional text.

lso  For information about responding to other Outlook items, see “Responding to 
ing Requests” in Chapter 6, “Managing Appointments, Events, and Meetings,” and 
aging Task Assignments” in Chapter 8, “Tracking Tasks.”

 use an e-mail signature, you can specify a different signature to appear in replies 
forwarded messages than in new messages. For example, you might want to include 
 full name and contact information in the signature that appears in new messages, 
nly your first name in the signature that appears in replies and forwarded messages.
5/16/2008   4:24:27 PM



	

	

	

c04623002.indd   123
See	Also	 For	more	information	about	e-mail	signatures,	see	“Adding	Signatures	to	Messages	
Automatically”	in	Chapter	3,	“Sending	E-Mail	Messages.”

If you reply to or forward a received message from within the message window, the 
original message remains open after you send your response. You    can instruct Outlook 
to close original messages after you respond to them—you will probably be fi nished 
working with the message at that point. To do so, click Options on the Tools menu. 
On the Preferences tab of the Options dialog box, click the E-mail Options button. In 
the E-mail Options dialog box, select the Close Original Message On Reply Or Forward 
check box, and then click OK in each of the two open dialog boxes.

In this exercise, you will reply to and forward messages.

USE	 the SBS First Draft message you created in “Attaching Files to Messages” in Chapter 3, 
“Sending E-Mail Messages.” If you did not complete that exercise, you can do so now, or you 
can use any message in your Inbox.

BE	SURE	TO	 display your Outlook Inbox before beginning this exercise.

OPEN	 the SBS First Draft message.

1.	 Look at the header information at the top of the message window.

Note that this message includes two attachments, and the message window 
Ribbon displays only one tab (the Message tab), which contains all the commands 
you can use in a received message.

2.	 On the Message tab, in the Respond group, click the  Reply button.

Outlook creates a reply message, already addressed to you (the original sender). If 
the message had been sent to any other people, the reply would not include them.

USE	 the the SBS First DraftSBS First Draft message you created in “Attaching Files to Messages” in Chapter 3,  message you created in “Attaching Files to Messages” in Chapter 3, SBS First DraftSBS First Draft message you created in “Attaching Files to Messages” in Chapter 3, SBS First DraftSBS First Draft
“Sending E-Mail Messages.” If you did not complete that exercise, you can do so now, or you “Sending E-Mail Messages.” If you did not complete that exercise, you can do so now, or you 
can use any message in your Inbox.can use any message in your Inbox.

BE	SURE	TO	 display your Outlook Inbox before beginning this exercise.display your Outlook Inbox before beginning this exercise.

OPEN	 the the SBS First DraftSBS First Draft message. message.SBS First DraftSBS First Draft message.SBS First DraftSBS First Draft

Replying	to	and	Forwarding	Messages	 	 123
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A   prefi x, RE:, appears at the beginning of the message subject to indicate that this 
is a response to an earlier message. Note that the response does not include the 
original attachments (and in fact there is no indication that the original message 
had any). The original message, including its header information, appears in the 
content pane separated from the new content by a horizontal line.

3.	 With the insertion point at the top of the content pane, type

We’ll	need	to	get	approval	from	the	Marketing	team	before	proceeding.

4.	 In the reply message header, click the Send button.

Outlook sends your reply. (If you are connected to your e-mail server, the reply will 
appear shortly in your Inbox.) The original message remains open on your screen.

5.	 In   the original message, in the Respond group, click the  Forward button.

Troubleshooting	 If the original message is closed, click the Forward button on the 
Standard toolbar.

Outlook creates a new version of the message that is not addressed to any recipient. 
The FW: prefi x at the beginning of the message subject indicates that this is a for-
warded message. The fi les that were attached to the original message appear in the 
Attached box. The message is otherwise identical to the earlier reply message.

Troubleshooting	 If the original message is closed, click the Forward button on the If the original message is closed, click the Forward button on the 
Standard toolbar.Standard toolbar.
You address and send a forwarded message as you would any other.

6.	 With the insertion point at the top of the content pane, type

Don’t	forget	to	review	these!

7.	 Send the message, and then close the original message window.
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Troubleshooting	 If you are not working online you will not receive the messages. 
Connect to your server to download the messages before continuing.

When the second message appears in your Inbox, compare the two messages. 
The forwarded message includes the original message attachments. Otherwise, 
other than the Subject prefi xes and the text you entered, the messages are 
identical.

CLOSE	 any open message windows.

Deleting	Messages
When   you delete a message, contact record, or any other item, Outlook temporarily 
moves it to the Deleted Items folder of your mailbox. You can open the folder from 
the Navigation Pane, view items that have been deleted but not purged, and restore 
items (undelete them) by moving them to other folders.

Outlook  does not permanently delete items until you purge them from the Deleted 
Items folder, You can empty the entire Deleted Items folder manually or automati-
cally, or permanently delete individual items from it.

To    permanently delete an individual item:

	 1.	 In the Navigation	Pane, click the Deleted	Items folder to display its contents.

	 2.	 In the Deleted	Items list, click the item (or select multiple items) you want to 
delete.

	 3.	 On the Standard toolbar, click the Delete button (or press the A key).

	 4.	 In the Microsoft	Offi	ce	Outlook message box asking you to confi rm that you 
want to delete the selected item(s), click Yes.

To   manually empty the Deleted Items folder:

➜	 In the Navigation	Pane, right-click the Deleted	Items folder, and then click 
Empty	“Deleted	Items”	Folder.

To automatically empty the Deleted Items folder each time you exit Outlook:

Troubleshooting	 If you are not working online you will not receive the messages. If you are not working online you will not receive the messages. 
Connect to your server to download the messages before continuing.Connect to your server to download the messages before continuing.

CLOSE any open message windows.

➜	➜	

Deleting	Messages
WhenWhen you delete a message, contact record, or any other item, Outlook temporarily  you delete a message, contact record, or any other item, Outlook temporarily 
moves it to the Deleted Items folder of your mailbox. You can open the folder from moves it to the Deleted Items folder of your mailbox. You can open the folder from 
the Navigation Pane, view items that have been deleted but not purged, and restore the Navigation Pane, view items that have been deleted but not purged, and restore 
items (undelete them) by moving them to other folders.items (undelete them) by moving them to other folders.

Outlook Outlook does not permanently delete items until you purge them from the Deleted does not permanently delete items until you purge them from the Deleted 
Items folder, You can empty the entire Deleted Items folder manually or automati-Items folder, You can empty the entire Deleted Items folder manually or automati-
cally, or permanently delete individual items from it.cally, or permanently delete individual items from it.

To To permanently delete an individual item:permanently delete an individual item:

	 1.		 1.	 In the In the Navigation	PaneNavigation	Pane, click the , click the Deleted	ItemsDeleted	Items folder to display its contents. folder to display its contents.

	 2.		 2.	 In the In the Deleted	ItemsDeleted	Items list, click the item (or select multiple items) you want to  list, click the item (or select multiple items) you want to 
delete.delete.

	 3.		 3.	 On the Standard toolbar, click the On the Standard toolbar, click the DeleteDelete button (or press the  button (or press the AA key). key).

	 4.		 4.	 In the In the Microsoft	Offi	ce	OutlookMicrosoft	Offi	ce	Outlook message box asking you to confi rm that you  message box asking you to confi rm that you Microsoft	Offi	ce	OutlookMicrosoft	Offi	ce	Outlook message box asking you to confi rm that you Microsoft	Offi	ce	OutlookMicrosoft	Offi	ce	Outlook
want to delete the selected item(s), click want to delete the selected item(s), click YesYes..

To To manually empty the Deleted Items folder:manually empty the Deleted Items folder:

➜	 In the In the Navigation	PaneNavigation	Pane, right-click the , right-click the Deleted	ItemsDeleted	Items folder, and then click  folder, and then click 
Empty	“Deleted	Items”	FolderEmpty	“Deleted	Items”	Folder..Empty	“Deleted	Items”	FolderEmpty	“Deleted	Items”	Folder.Empty	“Deleted	Items”	FolderEmpty	“Deleted	Items”	Folder

To automatically empty the Deleted Items folder each time you exit Outlook:To automatically empty the Deleted Items folder each time you exit Outlook:

➜	➜	➜	➜	

Replying	to	and	Forwarding	Messages	 	 125
	 1.	 On the Tools menu, click Options.

	 2.	 On the Other tab of the Options dialog box, select the Empty	the	Deleted	
Items	folder	upon	exiting check box. Then click OK.

	 1.		 1.	 On the On the ToolsTools menu, click  menu, click OptionsOptions..

	 2.		 2.	 On the On the OtherOther tab of the  tab of the OptionsOptions dialog box, select the  dialog box, select the Empty	the	Deleted	Empty	the	Deleted	
Items	folder	upon	exitingItems	folder	upon	exiting check box. Then click  check box. Then click OKOK..
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apter 4  Handling E-Mail Messages

ing with New Mail Notifications
When new messages, meeting requests, or task delegations arrive in your Inbox, Outlook 
alerts you in several ways so that you can be aware of e-mail activity if you are working 
in another application or away from your computer:

	 l	 A New Mail Message icon appears in the notification area at the right end of the 
Windows taskbar.

New Mail Message icon

	 l	 A semi-transparent desktop alert appears on your screen for a few seconds, dis-
playing the name of the sender, the subject, and the first few words of the message 
(approximately 125 characters). From the desktop alert, you can open a message, 
mark it as read, flag it for action, respond to it, or delete it.

You can change the location, transparency, and length of time desktop alerts appear, 
or choose to not display them:

❍	 You can position the alert inside or outside of the Outlook program window. 
For example, if you usually work with the Windows taskbar hidden, you might 
want to position the alert away from the taskbar to prevent you from acciden-
tally displaying the taskbar each time you point to an alert.

❍	 The alert can stay on screen for 3 to 30 seconds. The default is 7 seconds.
❍	 The alert can be a solid color or up to 80% transparent. The default is 20% 
transparent. You might find that transparent alerts are less likely to interfere 
with your view of the work you’re doing.
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❍ If   Outlook is minimized or another application window is active, a beep sounds. 
You can change the sound or turn it off.

❍ The mouse pointer briefl y changes shape when you receive a message. You can 
turn off this feature.

You can customize and turn off these notifi cations.

In this exercise, you will customize your desktop alert settings and process messages 
through desktop alerts as you receive them. There are no practice fi les for this exercise.

BE	SURE	TO	 display your Outlook Inbox before starting this exercise.

1.	 On the Tools menu, click Options.

The Options dialog box   opens.

2.	 On the Preferences tab, click E-mail	Options. Then in the E-mail	Options dialog 
box, click Advanced	E-mail	Options.

BE	SURE	TO	 display your Outlook Inbox before starting this exercise.display your Outlook Inbox before starting this exercise.

Working	with	New	Mail	Notifi	cations	 	 127
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Handling E-Mail Messages

In the Advanced E-mail Options dialog box, click Desktop Alert Settings.

Tip  To turn off desktop alerts, clear the Display A New Mail Desktop Alert check box.

Click the Desktop Alert Settings button.

The Desktop Alert Settings dialog box opens.
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Tip  To quickly access the Desktop Alert Settings dialog box, when a desktop alert 
arrives, click the Options button in the alert, and then click Desktop Alert Settings. 
You can turn off desktop alerts by clicking the Options button and then clicking 
Disable New Mail Desktop Alert.

5.	 Drag the How long should the Desktop Alert appear slider to the left end of the 
slider bar to set it to 3 seconds, and then click Preview.

A semi-transparent sample desktop alert appears in the lower-right corner of your 
desktop and fades away after three seconds.

6.	 Click Preview again, and when the alert appears, point to it.

The transparent alert becomes solid. As long as the mouse pointer is positioned 
over the alert, it remains visible.

7.	 Drag the sample desktop alert to the upper-right corner of your screen.

Future desktop alerts will appear wherever you move the sample alert.

8.	 In the Desktop Alert Settings dialog box, drag the How transparent should the 
Desktop Alert be slider to the left end of the slider bar to set it to 0% transparent, 
and then click Preview.

The sample desktop alert appears in the upper-right corner of the screen, and 
darkens until it is opaque.

9.	 Move the desktop alert to the position you want it to appear in the future. Then 
experiment with the options in the Desktop Alert Settings dialog box, and set the 
duration and transparency as you want, previewing your changes as necessary.

10.	 When you’re done, click OK in each of the four open dialog boxes.

11.	 On the Standard toolbar, click the New Mail Message button.

A new message window opens.

12.	 Enter your e-mail address in the To box, and then in the Subject box, type SBS 
Alert Test 1.

Important  The subject of each message we have you send to yourself while working 
through the exercises in this book begins with SBS so that you can easily differentiate 
the practice files from other messages in your Inbox and Sent Items folders.

il il 

Working with New Mail Notifications    129
13.	 In the message body, type This is a test. Then send the message.
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When the message arrives in your Inbox, a New Mail Message icon appears in  
the notification area at the right end of  the Windows taskbar, and a desktop 
alert appears on your screen.

14.	 When the desktop alert appears, point to it to keep it active.

Add message to task list

Display message options

If you point to the text displayed in the alert, it appears underlined. You can click 
the underlined text to open the message in a message window.

15.	 In the desktop alert, click the Options button, and then click Mark as Read.

The desktop alert closes, and the message in your Inbox is marked as read (whether 
on not the Inbox is visible).

16.	 On the Standard toolbar, click the New Mail Message arrow, and then in the list, 
click Meeting Request.

A new meeting request window opens.

17.	 In the To box, type your e-mail address; in the Subject box, type SBS Alert Test 2; 
and in the Location box, type my Inbox. Then send the meeting request.

18.	 If a Reminder window opens, click Dismiss.

See Also  For more information about meeting requests, see “Scheduling, Updating, and 
Canceling Meetings” in Chapter 6, “Managing Appointments, Events, and Meetings.”

19.	 When the desktop alert appears, point to it, and then click the Delete Item button.

Delete message

Close alert

The message moves from your Inbox to the Deleted Items folder, and the desktop alert 

closes.

ng a Task or an Appointment from a Message
Frequently you need to take some type of action based on the information you receive 
from another person in an e-mail message. Among other actions, you might need to 
add an item to your task list or calendar.
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Outlook 2007 makes it incredibly simple to add a task to your task list from an e-mail 
message. In Outlook 2003, you could flag messages for follow up, locate flagged mes-
sages within a folder by sorting it on flags, or within your entire mailbox by viewing the 
For Follow Up Search Folder. In Outlook 2007, flagging a message in any mail folder or 
flagging a contact record adds that item to your task list, which you can view from the 
To-Do Bar or the Tasks module.

See Also  For more information about the To-Do Bar and the To-Do Bar Task List, see 
“Personalizing Your Outlook Workspace” in Chapter 1, “Getting Started with Outlook 2007.” 
For information about creating and managing tasks, see Chapter 8, “Tracking Tasks.”

Although creating a task by flagging a message is very useful, you should be aware of 
a few limitations. Flagging the message doesn’t create a regular task; it simply adds the 
message to the task list. Because of this, you can’t assign a flagged message to another 
Outlook user or track its status. You can mark it as complete by clicking its flag in either 
the message window, message list, or task list, or by selecting the message and then 
clicking the Follow Up button on the Standard toolbar: doing so removes the message 
from your task list and changes the flag to a check mark. The biggest drawback, how-
ever, is that you must retain the message—you can move it between mail folders, but 
deleting the message deletes the task as well.

Tip  Tasks created by simply clicking a message flag appear on your task list under the 
default due date header. You can change the default due date by right-clicking the flag 
and then clicking Set Quick Click. In the Set Quick Click dialog box, click the due date 
you want to appear by default (options are limited to Today, Tomorrow, This Week, 
Next Week, No Date, and Complete), and then click OK.

You can specify a task due date other than the default when you flag the message, by 
right-clicking the flag and then clicking the due date: Today, Tomorrow, This Week, 
Next Week, No Date, or Custom (which allows you to set specific start and end dates). 

Outlook also provides a convenient method of creating a Calendar items (an appoint-
ment, event, or meeting request) based on an e-mail message; you simply drag the 
message to the Calendar button in the Navigation Pane. When you release the mouse 
button, an appointment window opens, already populated with the message subject 
as the appointment subject, the message text in the content pane, and any message 

Creating a Task or an Appointment from a Message    131
attachments attached to the appointment. The start and end times are set to the next 
half-hour increment following the current time. You can convert the appointment to 
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andling	E-Mail	Messages

nt or meeting in the same way that you would create an event or meeting from 
 the Calendar module. You can retain any or all of the information within the 
ge as part of the Calendar item so that you (and other participants, when creating 
ting request) have the information on hand when you need it. After creating the 
dar item, you can delete the actual message from your Inbox.

so	 For	information	about	creating	and	managing	Outlook	Calendar	items,	see	Chapter	6,	
ging	Appointments,	Events,	and	Meetings.”

 exercise, you will create a task and then an appointment from an e-mail message.

E	 the SBS Tradeshow Schedule message you created in “Creating and Sending Messages” 
hapter 3, “Sending E-Mail Messages.” If you did not complete that exercise, you can do 
ow, or you can use any message in your Inbox.

SURE	TO	 display your Outlook Inbox and the To-Do Bar before beginning this exercise.

n    the message list, scroll to the SBS Tradeshow Schedule message, and then click 
he transparent fl ag in the right margin of the message header.

he fl ag becomes red, and a task named SBS Tradeshow Schedule appears under 
he Today header on your To-Do Bar task list.

E	 the the SBS Tradeshow ScheduleSBS Tradeshow Schedule message you created in “Creating and Sending Messages”  message you created in “Creating and Sending Messages” 
hapter 3, “Sending E-Mail Messages.” If you did not complete that exercise, you can do hapter 3, “Sending E-Mail Messages.” If you did not complete that exercise, you can do 
ow, or you can use any message in your Inbox.ow, or you can use any message in your Inbox.

SURE	TO	 display your Outlook Inbox and the To-Do Bar before beginning this exercise.display your Outlook Inbox and the To-Do Bar before beginning this exercise.
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2.	 In the To-Do Bar Task List, point to the SBS Tradeshow Schedule task.

A ScreenTip appears displaying the start date, reminder time, due date, the folder 
in which the message appears, and any categories assigned to the message.

3.	 Double-click the SBS Tradeshow Schedule task.

The flagged message opens in a message window. The message header indicates 
that you need to follow up on this message. The start and due dates given are 
tomorrow’s date.

Task information

4.	 Close the message window.

5.	 In the Navigation Pane, click the Tasks button to display the Tasks module.

Your active tasks appear in the To-Do List. The icon preceding each item in the 
list indicates whether it is a standard task, e-mail message, contact, and so on. 
Message icons match those shown in the Inbox, indicating whether the message 
is read or unread and whether you’ve replied to or forwarded the message.

TasksTasks

Creating a Task or an Appointment from a Message    133
3 5/16/2008   4:24:38 PM
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Handling E-Mail Messages

	 In the To-Do List, click the SBS Tradeshow Schedule task to display its details in the 
Reading Pane.

For the purposes of this exercise, assume that you flagged this message for  
follow-up because you need to organize a meeting with colleagues to discuss  
its contents.

	 Drag the message from the To-Do List to the Calendar button in the Navigation 
Pane, but don’t release the mouse button.

As you hold the dragged message over the Calendar button, the Navigation Pane 
changes to display the Calendar module information instead of the Mail module 
information.

	 Drop the message on the Calendar button to create an appointment based on the 
message.
5/16/2008   4:24:38 PM
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You can convert the appointment to an event by selecting the All Day Event check 
box, or convert it to a meeting by inviting other people to attend. You can edit 
the information in the content pane without affecting the content of the original 
message, and you can move or delete the original message without affecting the 
appointment.

9.	 In the appointment window, click the Save & Close button to save the appointment 
to your calendar. 

10.	 When the appointment reminder window appears (15 minutes prior to the start 
time of the appointment) click Dismiss.

See Also  For information about appointment reminders, see “Scheduling and Changing 
Appointments” in Chapter 6, “Managing Appointments, Events, and Meetings.”

Creating a Task or an Appointment from a Message    135
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essages
n print an e-mail message, for example, if you want to take a hard copy of it to 
ing for reference, or if you keep a physical fi le of important messages or kudos. 
n print the message exactly as it appears in your Inbox, or embellish it with page 
s and footers. Outlook prints the message as shown on-screen, including font and 
aph formats.

exercise, you will preview a message as it will appear when printed, add a page 
, and then print the message.

	 the SBS Tradeshow Schedule message you created in “Creating and Sending Messages” 
hapter 3, “Sending E-Mail Messages.” If you did not complete that exercise, you can do 
ow, or you can use any message in your Inbox.

URE	TO	 install a printer before beginning this exercise.

N	 the SBS Tradeshow Schedule message.

 the message window, click the  Microsoft	Offi	ce	Button, and then point to Print.

Tip	 Unlike previous versions of Outlook, the Print and Print Preview commands are 
not available from the message window toolbar (or in this case, the Ribbon).

	 the the SBS Tradeshow ScheduleSBS Tradeshow Schedule message you created in “Creating and Sending Messages”  message you created in “Creating and Sending Messages” 
hapter 3, “Sending E-Mail Messages.” If you did not complete that exercise, you can do hapter 3, “Sending E-Mail Messages.” If you did not complete that exercise, you can do 
ow, or you can use any message in your Inbox.ow, or you can use any message in your Inbox.

URE	TO	 install a printer before beginning this exercise.install a printer before beginning this exercise.

N	 the the SBS Tradeshow ScheduleSBS Tradeshow Schedule message. message.
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The right pane displays these preview, print, and page setup options:

❍	 Print opens the Print dialog box, where you can make changes to the default 
printing options before printing.

❍	 Quick Print prints the open or selected message with the default printing 
options, without first displaying the Print dialog box.

❍	 Print Preview displays the message as it will appear when printed. You can 
change the page setup options before printing the message.

❍	 Define Print Styles allows you to make changes to an existing print style (the 
way the message is presented on the printed page) or create a new one. 
The default print style is Memo style, which prints your name, the message 
header information, and then the message content.

2.	 Click the Print button (not its arrow).

The Print dialog box opens, displaying your default printer settings, which you can 
change before printing just as you would when printing from any Office program. 
Clicking OK prints the message with the default settings.

3.	 In the Print dialog box, click Preview.

The Print Preview window opens, displaying the message as it will appear when 
printed.

Printing Messages    137
Tip  You can also display the Print Preview window by pointing to Print on the Office 
menu and then clicking Print Preview.
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hapter 4  Handling E-Mail Messages

4.	 On the Print Preview window toolbar, click the Actual Size button to display the 
message at 100% magnification.

Tip  When previewing a message that will be longer than one page when printed 
with the current settings, you can click the Multiple Pages button to preview all pages 
of the message at the same time. This can be useful when, for example, you want to 
check page breaks or scan a document for a particular element.

Multiple Pages button

ee
5.	 In the Print Preview window, click the Page Setup button.

The Page Setup: Memo Style dialog box opens. You can change the font, paper 
size, page margins, header, and footer from this dialog box.

Tip  You can also display the Page Setup dialog box by pointing to Print on the Office 
menu and then clicking the print style you want under Page Setup.

5/16/2008   4:24:42 PM
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6.	 In the Page Setup: Memo Style dialog box, click the Paper tab to see the available 
options.

Printing Messages    139
In addition to choosing the paper size, you can select the number of pages that 
print on each sheet of paper and set the page margins and the orientation.
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Handling	E-Mail	Messages

	 Click   the Header/Footer tab.

	 In the Header area, type For	Your	Information in the center box, and then click the 
Font button. In the Font dialog box, under Size, click 16, and then click OK.

	 In the Footer section, select the default text (the page number) that appears in the 
center box. Then in the AutoText box, click the User	Name button.

AutoText box

Outlook will print the specifi ed text at the top of the page and your name (or user 
name, if different) at the bottom.

	 In the Page	Setup dialog box, click Print, and then in the Print dialog box, click OK.

Troubleshooting	 If   the Save As dialog box opens, you do not have a printer in-
stalled. Click the Start button, click Printers And Faxes, and then under Printer Tasks, 
click Add A Printer. Follow the wizard’s instructions to install a local or network printer.

Troubleshooting	 If If the Save As dialog box opens, you do not have a printer in-the Save As dialog box opens, you do not have a printer in-
stalled. Click the Start button, click Printers And Faxes, and then under Printer Tasks, stalled. Click the Start button, click Printers And Faxes, and then under Printer Tasks, 
click Add A Printer. Follow the wizard’s instructions to install a local or network printer.click Add A Printer. Follow the wizard’s instructions to install a local or network printer.
Outlook prints the message, including your custom header and footer.

E	SURE	TO	 remove the custom header and footer from the Memo print style if you 
on’t want to retain them.

LOSE	 the SBS Tradeshow Schedule message.

E	SURE	TO remove the custom header and footer from the Memo print style if you 
on’t want to retain them.

LOSE the SBS Tradeshow Schedule message.

5/16/2008   4:24:45 PM
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 Points
	 l	 By default, messages you receive appear in your Inbox. Outlook alerts you to new 

messages in several ways, all of which are customizable.

	 l	 You can see the first few lines of each message in AutoPreview, open a message in 
its own window, or preview messages in the Reading Pane.

	 l	 You can preview message attachments in the Reading Pane.

	 l	 You can reply to the message sender only or to the sender and all other recipients. 
You can also forward a message and its attachments to other people.

	 l	 You can create tasks or calendar items from received e-mail messages.

	 l	 You can print a message when you need a paper copy of its information.

Key Points    141
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6  Managing 
  Appointments, 
  Events, and 
  Meetings

In this chapter, you will learn to:

	 ✔	 Work in the calendar item windows.

	 ✔	 Schedule and change appointments and events.

	 ✔	 Schedule, update, and cancel meetings.

	 ✔	 Respond to meeting requests.

You might fi nd that your Microsoft Offi ce Outlook Calendar runs your life—but that isn’t 
necessarily a bad thing! Using the Calendar effectively can help you to stay organized, on 
task, and on time. You can schedule and track appointments, meetings, and events. Because 
Outlook 2007 maps your scheduled tasks to your calendar, you can look at your calendar in 
Day view or Week view to see the tasks that need to be completed that day or that week, 
and you can track your progress by marking tasks as complete when you fi nish them.

In this chapter, you will record different types of information in your Outlook calendar, 
scheduling an appointment and an event on your own calendar and then scheduling 
a meeting with another person. You will learn methods of determining meeting times 
during which other people are available. Then you will learn about responding to, up-
dating, and canceling meeting requests.

See Also  Do you need only a quick refresher on the topics in this chapter? See the Quick 
Reference section at the beginning of this book.
    175

Important  No practice fi les are required to complete the exercises in this chapter. For 
more information about practice fi les, see “Using the Companion CD” at the beginning of 
this book.
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in the Calendar Item Windows
efer to the window in which you create or respond to an appointment as the 
intment window, to a meeting as the meeting window, and to an event as the 
t window; collectively we refer to these windows as the calendar item windows. 
he contact and message windows, the calendar item windows contain their own 
ands, arranged on the new Offi ce Ribbon instead of on menus and toolbars.

lso  For more information about the user interface for Outlook 2007 item windows, see 
king in the Contact Window” in Chapter 2, “Managing Contact Information.”

s exercise, you will take a tour of the calendar item window elements that differ 
 the contact and message window elements discussed in earlier chapters, and you’ll 
 about the differences between the types of calendar items. There are no practice 
or this exercise.

 SURE TO  start Outlook before beginning this exercise.

In the Navigation Pane, click the Calendar button to display the Calendar 
module.

 SURE TO  start Outlook before beginning this exercise.start Outlook before beginning this exercise.
5/16/2008   4:06:39 PM
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Troubleshooting  Graphics and operating system–related instructions in this book 
refl ect the Windows Vista user interface. If your computer is running Windows XP 
and you experience trouble following the instructions as written, please refer to the 
“Information for Readers Running Windows XP” section at the beginning of this book.

2.  On  the Standard toolbar, click the  New Appointment button.

An   untitled appointment window opens.

Important  Depending on your screen resolution and the size of the appointment 
window that opens, you might see more or fewer buttons in each of the groups, or the 
buttons you see might be represented by larger or smaller icons than those shown in 
this book. Experiment with the size of the appointment window to understand the 
effect on the appearance of the Ribbon.

See Also  For more information about the tabs and groups on the Ribbon, see “Working 
in the Contact Window” in Chapter 2, “Managing Contact Information.”

3.  In the upper-left corner of the window, click the  Microsoft Offi ce Button.

Commands  related to managing appointments (such as creating, saving, deleting, 

Troubleshooting  Graphics and operating system–related instructions in this book Graphics and operating system–related instructions in this book 
refl ect the Windows Vista user interface. If your computer is running Windows XP refl ect the Windows Vista user interface. If your computer is running Windows XP 
and you experience trouble following the instructions as written, please refer to the and you experience trouble following the instructions as written, please refer to the 
“Information for Readers Running Windows XP” section at the beginning of this book.“Information for Readers Running Windows XP” section at the beginning of this book.

New 
pointment

New 
pointment

osoft Offi ce osoft Offi ce 

Working in the Calendar Item Windows    177
and printing) are available from the Offi ce menu that appears.ButtonButton
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See Also  For information about the Print commands, see “Printing Messages” in 
Chapter 4, “Handling E-Mail Messages.” For information about the commands available 
in the Editor Options window, see “Personalizing Your Office and Outlook Settings” in 
Chapter 12, “Customizing and Configuring Outlook.”

4.	 Click away from the Office menu to close it.

The appointment window commands are organized in groups on three tabs:

❍	 Appointment

❍	 Insert

❍	 Format Text

Tip  Depending on what programs you have installed on your computer, tabs 
and groups other than those described here might also appear on the Ribbon. For 
example, if Microsoft Office OneNote is installed on your computer, a OneNote 
group appears on the Appointment tab.

The Appointment tab is active by default. Buttons representing commands related 

to creating appointments are organized on this tab in four groups: Actions, Show, 
Options, and Proofing. You can create a simple appointment by using only the 
commands available on this tab.

5/16/2008   4:06:42 PM
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5.	 Click the Insert tab.

Buttons representing commands related to items you can insert are organized on 
this tab in six groups: Include, Tables, Illustrations, Links, Text, and Symbols.

6.	 Click the Format Text tab.

Buttons representing commands related to the appearance of message content are 
organized on this tab in six groups: Clipboard, Font, Paragraph, Styles, Zoom, and 
Editing.

7.	 On the Appointment tab, in the Options group, click the Time Zones button.

A new field displaying the time zone for each of the start and end times appears. 
With this useful Outlook 2007 feature, you can schedule an appointment that 
crosses time zones—for example, a flight from Los Angeles to New York.

Working in the Calendar Item Windows    179
5/16/2008   4:06:42 PM
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See Also  For more information about configuring Outlook for different time zones, see 
“Configuring Outlook for Multiple Time Zones” in Chapter 7, “Managing Your Calendar.”

Time zones

8.	 In the Start time area, select the All day event check box.

The window changes from an appointment window to an event window. The  
contents of the Format Text and Insert tabs don’t change, but an Event tab  
replaces the Appointment tab.

9.	 Click the Event tab.
5/16/2008   4:06:43 PM
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The Event tab contents are nearly identical to the Appointment tab contents—the 
only change is that on the Event tab, in the Options group, by default your time is 
shown as Free rather than Busy, and the reminder is set to display 18 hours prior to 
the event rather than 15 minutes.

10.  In   the Start time area, clear the All day event check box to change the event to an 
appointment.

11.  In    the Actions group, click the  Invite Attendees button.

The window changes from an appointment window to a meeting window. The 
contents of the Format Text and Insert tabs don’t change, but a Meeting tab that 
includes one additional group, Attendees, replaces the Appointment tab:

Tip  You can invite people to an event in the same way you do to a meeting, by 
clicking the Invite Attendees button  from within an event window.

The    meeting request header includes a To fi eld in addition to the standard Subject 
and Location fi elds. You can invite attendees by entering them in the To fi eld or by 
clicking the Scheduling button in the Show group.

BE SURE TO  click the Time Zones button to hide the time zone settings, if you don’t want 
to display them.
BE SURE TO click the Time Zones button to hide the time zone settings, if you don’t want 
to display them.

Working in the Calendar Item Windows    181
CLOSE  the meeting window without saving your changes.CLOSE the meeting window without saving your changes.
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ling and Changing Appointments
pointments are blocks of time you schedule for only yourself (as opposed to meetings, 

 which you invite other people). If an appointment recurs at specific intervals, such as 
ery Tuesday and Thursday, every other week or every month, you can set it up in your 
utlook calendar as a recurring appointment; doing so creates multiple instances of the 
pointment in your calendar at the time interval you specify. Recurring appointments 
e linked. When making changes to recurring appointments, you can choose to update 
l occurrences or only an individual occurrence of the appointment.

hen creating an appointment, you can show your time on the calendar as Free, 
ntative, Busy, or Out Of Office. This information is available to other people on your 
twork, and also when you send your schedule information to other people in an e-mail 
essage or share your calendar. You can include information such as driving directions or 
eb site links in the Notes field, and attach related files so that they are easily available to 
u at the time of the appointment.

e Also  For information about sending your schedule information via e-mail, see “Sending 
lendar Information in an E-Mail Message” in Chapter 7, “Managing Your Calendar.” For 

formation about sharing your calendar, see “Sharing Your Folders with Other People” in 
apter 10, “Collaborating with Other People.”

Tip  When viewing your calendar in Day or Week view, each item on your Outlook task list 
appears in the Tasks section below its due date. You can schedule specific time to complete 
a task by dragging it from the Tasks area to your calendar.

e Also  For information about creating an appointment from an e-mail message, see 
reating a Task or an Appointment from a Message” in Chapter 4, “Handling E-Mail 
essages.” For information about assigning appointments to categories, see “Organizing 
essages by Using Color Categories” in Chapter 5, “Managing Your Inbox.”

hen Outlook is running, it displays a reminder message 15 minutes before the appoint-
ent start time—you can change the reminder time or turn it off completely if you want 
. If you synchronize your Outlook installation with a mobile device such as a BlackBerry 
 a mobile phone running Windows Mobile, you can also receive reminders on your de-
ce. This is very convenient when you are away from your computer.

 this exercise, you will schedule an appointment and a recurring appointment. There 
e no practice files for this exercise.
5/16/2008   4:06:45 PM
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BE SURE TO  display the Calendar before beginning this exercise.

Troubleshooting  The default Calendar display is Day view. If your calendar does not look 
like the one shown in this exercise, click the Day button on the Standard toolbar.

1.  In  the Navigation Pane, in the Date Navigator, click tomorrow’s date.

Tip  The  Date Navigator displays six weeks at a time, including the selected month. 
The days of the selected month are black; days of the previous and next months are 
gray, but you can still select them in the Date Navigator.

Outlook displays tomorrow’s schedule.

2.  In the Calendar pane, point to the 1:00 P.M. time slot (or, if you already have an 
appointment scheduled at 1:00 P.M., to another time when you have 30 minutes 
available).

Click To Add Appointment appears in the time slot.

3.  Click   once to activate the time slot.

In this mode, you can enter basic appointment details directly in the Calendar pane.

4.  Type SBS Lunch with Jane, and then press F.

Important  The subject of each appointment, meeting, or event we have you 
create while working through the exercises in this book begins with SBS so that 
you can easily differentiate the practice fi les from other items on your calendar.

Outlook creates a half-hour appointment beginning at 1:00 P.M.

5.  Drag    the appointment from the 1:00 P.M. time slot to the 12:00 P.M. time slot (or, 
if you already have an appointment scheduled at noon, to another time when you 
have an hour available).

Outlook changes the appointment start time.

6.  Point  to the bottom border of the appointment, and when the pointer becomes a 

BE SURE TO  display the Calendar before beginning this exercise.display the Calendar before beginning this exercise.

Troubleshooting  The default Calendar display is Day view. If your calendar does not look The default Calendar display is Day view. If your calendar does not look 
like the one shown in this exercise, click the Day button on the Standard toolbar.like the one shown in this exercise, click the Day button on the Standard toolbar.

Scheduling and Changing Appointments    183
double-headed arrow, drag down so that the appointment ends at 1:00 P.M.

You can add more details to the appointment and vary from the default settings 
from within the appointment window.

5/16/2008   4:06:46 PM
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7.	 Double-click the SBS Lunch with Jane appointment.

The appointment window opens. The subject, start time, and end time are set  
according to the information you entered in the Calendar pane.

8.	 In the Location box, type Fourth Coffee.

9.	 On the Appointment tab, in the Options group, click the Show As arrow, and then 
in the list, click Out of Office.

10.	 In the Options group, click the Reminder arrow, and then in the list, click 1 hour.

11.	 In the Options group, click the Private button.

Marking an appointment, event, or meeting as Private hides the details from anyone 
you share your calendar with.

12.	 In the Actions group, click the Save & Close button.

Outlook adds a purple stripe at the left side of the appointment to indicate you 
will be out of the office, and displays the location. The lock icon in the lower-right 
corner indicates that the appointment has been marked as private.

13.	 Double-click the 2:00 P.M. time slot.

Outlook opens an appointment window with the appointment start time set to 
2:00 P.M. and the end time set 30 minutes later.

14.	 In the Subject box, type SBS Staff Meeting. Then in the Location box, type 
Conference Room.
15.	 On the Appointment tab, in the Options group, click the Recurrence button.

The Appointment Recurrence dialog box opens.
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Recurrence options

The default appointment recurrence is weekly on the currently selected day of the 
week. You can set the appointment to recur until further notice, or to end after a 
certain number of occurrences or by a certain date.

16.	 In the Range of recurrence area, click End after, and then in the box, replace 10 
with 2.

17.	 To create a 30-minute appointment beginning at 2:00 P.M. on the selected day of 
the week, this week and next week only, click OK.

The appointment window title bar changes to reflect that this is now a recurring 
appointment, the Appointment tab changes to a Recurring Appointment tab, and 
the frequency (labeled Recurrence) appears in the message header.

Scheduling and Changing Appointments    185
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On the Recurring Appointment tab, in the Actions group, click the Save & Close 
button.

The appointment appears on your calendar. The circling arrow icon at the right end 
of the time slot indicates the recurrence.

Private appointment

Recurring appointment

In the Date Navigator, click the day of the appointment in each of the next two 
weeks, to verify that the appointment appears on your calendar the next week, but 
not the following week.

lso  For information about creating a OneNote page linked to an appointment, see 
idebar “Creating a OneNote Page Linked to an Appointment, an Event, or a Meeting” in 
ter 7, “Managing Your Calendar.”

g and Changing Events
ts are day-long blocks of time that you schedule on your Outlook calendar—for 
ple, a birthday, a payroll day, or anything else occurring on a particular day but 
t a specific time. In all other respects, events are identical to appointments, in  
you can specify a location, indicate recurrence, indicate your availability, invite  
dees, and attach additional information to the event item.

can create an event when viewing your calendar in Day view, Week view, or Month view.

lso  For information about creating an event from an e-mail message, see “Creating a 
or an Appointment from a Message” in Chapter 4, “Handling E-Mail Messages.”

is exercise, you will schedule an event and convert it to a recurring event. There are 

ractice files for this exercise.
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BE SURE TO  display the Calendar in Day view before beginning this exercise.

1.  In the Date Navigator, click tomorrow’s date.

2.  In  the Calendar pane, point to the blank space below the day header and above 
the delineated time slots.

Click To Add Event appears in the space.

3.  Click once to activate the event slot.

In this mode, you can enter basic event details directly in the Calendar pane.

4.  Type SBS Anniversary, and then press F.

Outlook creates a one-day event. You can add more details to the event and vary 
from the default settings from within the event window.

5.  Double-click     the SBS Anniversary event.

The event window opens. The subject and date are set according to the information 
you entered in the Calendar pane.

6.  On  the Event tab, in the Options group, click the  Recurrence button.

The Appointment Recurrence dialog box   shown earlier in this chapter opens. The 
default recurrence for events is the same as for appointments—weekly on the 
currently selected day of the week.

7.  In the Recurrence pattern area, click Yearly.

You can schedule an annual event to recur on a specifi c date or on a selected (fi rst, 
second, third, fourth, or last) day of the month.

BE SURE TO  display the Calendar in Day view before beginning this exercise.display the Calendar in Day view before beginning this exercise.

Scheduling and Changing Events    187
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8.	 To create a recurring annual appointment on the same date each year, click OK.

The event window title bar changes to reflect that this is now a recurring event, the 
Event tab changes to a Recurring Event tab, and the frequency appears in the header.

9.	 On the Recurring Event tab, in the Actions group, click the Save & Close button.

The event appears at the top of the Calendar pane. The circling arrow icon at the 
right end indicates the recurrence.

Recurring  
event

duling, Updating, and Canceling Meetings
Scheduling meetings through Outlook is significantly simpler than scheduling meet-
ings manually, particularly when you are coordinating the schedules of several people. 
A primary difficulty when scheduling a meeting is finding a time that works for every-
one. Outlook displays the individual and collective schedules of people within your 
own organization, and of people outside of your organization who have published 
their availability to the Internet.

You can send a meeting invitation (referred to as a meeting request) to any person 
who has an e-mail account (even to people who don’t use Outlook). You can inform 
non-critical attendees of the meeting by marking their attendance as Optional. You 
can invite entire groups of people by using an e-mail alias or distribution list. The 
meeting request can include text and Web links, as well as file attachments. This is a 
convenient way of ensuring that meeting attendees have specific information available 
to them. Outlook automatically tracks responses from attendees and those responsible 
for scheduling the resources you requested, so you always have an up-to-date report 
of how many people will be attending your meeting.

If your organization is running Microsoft Exchange Server and the Exchange Server direc-
tory includes shared resources such as conference rooms or presentation equipment, you 

can request these resources by inviting them to the meeting. Resource requests may be 
automatically approved, or an individual may be assigned the responsibility of approving 
each resource request.
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Using the Exchange Server 2007 Smart Scheduling Feature
If   your organization is running Exchange Server 2007, Outlook simplifi es even 
further the process of selecting a suitable meeting time by presenting you with a 
list of meeting times of any duration you specify, and indicating for each time the 
number of required and optional attendees who are available.

The Scheduling Assistant page is similar to the Scheduling page displayed when 
organizing a meeting on an Exchange Server 2003 network.

The calendar on the right side of the window indicates the collective availability of 
the group by color. Dates that occur in the past and non-working days are shaded; 
scheduling suggestions are not provided for those days.

l	 Days when all attendees are available are white (Good)

l	 Days when most attendees are available are light blue (Fair)

l	 Days when most attendees are not available are medium blue (Poor)

In the Suggested Times list, Outlook displays attendee availability for appointments 
of the length specifi ed in the Duration list. The availability of required attendees is 

l	l	

l	l	

l	l	

Using the Exchange Server 2007 Smart Scheduling Feature
If If your organization is running Exchange Server 2007, Outlook simplifi es even your organization is running Exchange Server 2007, Outlook simplifi es even 
further the process of selecting a suitable meeting time by presenting you with a further the process of selecting a suitable meeting time by presenting you with a 
list of meeting times of any duration you specify, and indicating for each time the list of meeting times of any duration you specify, and indicating for each time the 
number of required and optional attendees who are available.number of required and optional attendees who are available.

The Scheduling Assistant page is similar to the Scheduling page displayed when The Scheduling Assistant page is similar to the Scheduling page displayed when 
organizing a meeting on an Exchange Server 2003 network.organizing a meeting on an Exchange Server 2003 network.

The calendar on the right side of the window indicates the collective availability of The calendar on the right side of the window indicates the collective availability of 
the group by color. Dates that occur in the past and non-working days are shaded; the group by color. Dates that occur in the past and non-working days are shaded; 
scheduling suggestions are not provided for those days.scheduling suggestions are not provided for those days.

l	 Days when all attendees are available are white (Good)Days when all attendees are available are white (Good)

l	 Days when most attendees are available are light blue (Fair)Days when most attendees are available are light blue (Fair)

l	 Days when most attendees are not available are medium blue (Poor)Days when most attendees are not available are medium blue (Poor)

In the Suggested Times list, Outlook displays attendee availability for appointments In the Suggested Times list, Outlook displays attendee availability for appointments 
of the length specifi ed in the Duration list. The availability of required attendees is of the length specifi ed in the Duration list. The availability of required attendees is 

l	l	

l	l	

l	l	
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shown separately from that of optional attendees and resources.

Selecting a date in the calendar displays the suggested meeting times for that day. 
Clicking a meeting time in the Suggested Times list updates the meeting request.

shown separately from that of optional attendees and resources.shown separately from that of optional attendees and resources.

Selecting a date in the calendar displays the suggested meeting times for that day. Selecting a date in the calendar displays the suggested meeting times for that day. 
Clicking a meeting time in the Suggested Times list updates the meeting request.Clicking a meeting time in the Suggested Times list updates the meeting request.
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u    might fi nd it necessary to change the date, time, or location of a meeting—for example, 
cause of a schedule confl ict. You can change any information in a meeting request at 
y time, including adding or deleting invited attendees, or canceling the meeting. To 
it a meeting request, double-click the meeting on your calendar. If the meeting is one 
 a series (a recurring meeting), Outlook prompts you to indicate whether you want 
 edit the meeting series or only the selected instance of the meeting. After you make 
anges, Outlook sends an updated meeting request to the invited attendees to keep 
em informed. If the only change you make is to the attendee list, Outlook gives you 
e option of sending an update only to the affected attendees.

e Also  For information about creating a meeting request from an e-mail message, 
e “Creating a Task or an Appointment from a Message” in Chapter 4, “Handling E-Mail 
essages.”

 this exercise, you will create and send a meeting request. There are no practice fi les for 
is exercise.

BE SURE TO  display the Calendar and inform a co-worker or friend that you are going to 
practice inviting him or her to a meeting.

.  In the Date Navigator, click tomorrow’s date. Then in the Calendar pane, click the 
3:00 P.M. time slot (or if you have a confl icting appointment, click a time when you 
have 30 minutes available).

.  On  the Standard toolbar, click the  New Appointment arrow, and then in the list, 
click Meeting Request.

An untitled meeting window opens.

Troubleshooting  If   the active selection in the Calendar pane is an event, Outlook 
will create an Invited Event request instead; if this happens, clear the All Day Event 
check box to convert the Invited Event to a Meeting.

.  In the To box, type the e-mail address of someone within your organization, or if 
you aren’t working on an Exchange Server network, type any e-mail address, for 
example, adam@contoso.com.

.  In the Subject box, type SBS Meeting 1.

BE SURE TO  display the Calendar and inform a co-worker or friend that you are going to display the Calendar and inform a co-worker or friend that you are going to 
practice inviting him or her to a meeting.practice inviting him or her to a meeting.

Troubleshooting  IfIf the active selection in the Calendar pane is an event, Outlook  the active selection in the Calendar pane is an event, Outlook IfIf the active selection in the Calendar pane is an event, Outlook IfIf
will create an Invited Event request instead; if this happens, clear the All Day Event will create an Invited Event request instead; if this happens, clear the All Day Event 
check box to convert the Invited Event to a Meeting.check box to convert the Invited Event to a Meeting.
5.  In the Location box, type Test – please accept to indicate to the person you are 
inviting that the meeting request is for testing purposes only.
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6.	 On the Meeting tab, in the Show group, click the Scheduling button.

The All Attendees list on the Scheduling page includes you and the e-mail address 
(or if the person is in your address book, the associated name) you entered in the To 
box. The black icon next to your name indicates that you are the meeting organizer. 
The red icon next to the sole attendee’s name indicates that he or she is a required 
attendee. You can click an attendee’s icon to switch between Required Attendee 
and Optional Attendee status, or to indicate a resource rather than a person.

Tip  You can enter additional attendees in the To box on the Appointment page or 
in the All Attendees list on the Scheduling page. If you prefer, you can organize a 
meeting directly from a Scheduling page-like interface by clicking Plan A Meeting 
on the Actions menu.

Outlook indicates the suggested meeting time with green (start time) and red (end 
time) vertical bars. If free/busy information is available for meeting invitees, their 
time is shown as white (Available), blue (Busy), or purple (Out of Office). Tentative 
bookings are indicated by light-blue diagonal stripes. If no information is available 

Scheduling, Updating, and Canceling Meetings    191
(either because Outlook can’t connect to a person’s calendar or because the pro-
posed meeting is further out than the scheduling information stored on the server), 
Outlook indicates this by gray diagonal stripes. The gray row at the top of the 
schedule indicates the collective schedule of all the invitees.

5/16/2008   4:06:54 PM
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You can change the time and duration of the meeting to work with the displayed 
schedules by selecting from the lists at the bottom of the Scheduling page, by 
dragging the green and red vertical bars in the schedule area, or by clicking the 
time you want in the schedule area.

7.	 In the lower-right corner of the Scheduling page, click the AutoPick Next button.

The Start Time and End Time bars move to the next available half-hour time slot.

You can change the Show As and Reminder settings, create recurrences, assign 
color categories, and make any other changes you want. The availability specified 
in the Show As list will apply to all attendees who accept your meeting request.

8.	 After you select the meeting time you want, click the Appointment button in the 
Show group.

The Appointment page is displayed.

9.	 Verify the meeting details, and then click the Send button.

The meeting appears in your calendar on the specified date and in the specified 
time slot.

nding to Meeting Requests
When you receive a meeting request from another Outlook user, the meeting appears 
on your calendar with your time scheduled, but shown as Tentative. Until you respond to 
the meeting request, the organizer doesn’t know whether you plan to attend. You can 
respond in one of four ways:

	 l	 You can accept the request. Outlook deletes the meeting request and adds the 
meeting to your calendar.

	 l	 You can tentatively accept the request, indicating that you might be able to attend 
the meeting but are undecided. Outlook deletes the meeting request and shows 
the meeting time on your calendar as tentatively scheduled.

	 l	 You can propose a new meeting time. Outlook sends your request to the meeting 
organizer for confirmation and shows the original time on your calendar as tenta-
tively scheduled.

	 l	 You can decline the request. Outlook deletes the meeting request and removes the 

meeting from your calendar.

If you don’t respond to a meeting request, the meeting remains on your calendar, with 
your time shown as tentatively scheduled.
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Creating a Meeting Workspace
If  your organization has a collaboration site built with Microsoft SharePoint 
products and technologies, such as a team site, on which you have permission 
to create document libraries, you can create a meeting workspace (a shared site 
for planning a meeting and tracking related tasks and results) at the same time 
that you schedule the meeting. You can also create a meeting workspace for a 
meeting that you previously scheduled; after you change the meeting request to 
include the meeting workspace information, Outlook sends an updated request 
containing the information to all attendees.

To create a meeting workspace in a new or existing meeting request:

  1.  In  the meeting window, on the Meeting tab, in the Attendees group, click the 
Meeting Workspace button.

  2.  In  the Meeting Workspace pane that opens on the right side of the meet-
ing window, click the Select a location arrow, and then in the list, click the 
SharePoint site where you want to create the meeting workspace. (If this is 
the fi rst time you’ve used the Meeting Workspace pane, you might fi rst need 
to click Change settings.) If you haven’t previously set up a meeting work-
space or document library on the SharePoint site you want to use, click Other 
in the Select a location list, enter the SharePoint site address in the Other 
Workspace Server dialog box that opens, and then click OK.

  3.  In the Select a workspace area, select the template language and meeting 
workspace template you want to use, and then click OK. Or if you want to 
link to an existing meeting workspace, select that option, click the Select the 
workspace arrow, and then in the list, click the existing workspace.

  4.  In the Meeting Workspace pane, click OK.

Attendees can link to the meeting workspace from the meeting request or from 
the meeting item on their calendars.

See Also  For more information about using Outlook with SharePoint products and 
technologies, see Chapter 10, “Collaborating with Other People.”

Creating a Meeting Workspace
IfIf your organization has a collaboration site built with Microsoft SharePoint  your organization has a collaboration site built with Microsoft SharePoint IfIf your organization has a collaboration site built with Microsoft SharePoint IfIf
products and technologies, such as a team site, on which you have permission products and technologies, such as a team site, on which you have permission 
to create document libraries, you can create a to create document libraries, you can create a meeting workspace (a shared site  (a shared site 
for planning a meeting and tracking related tasks and results) at the same time for planning a meeting and tracking related tasks and results) at the same time 
that you schedule the meeting. You can also create a meeting workspace for a that you schedule the meeting. You can also create a meeting workspace for a 
meeting that you previously scheduled; after you change the meeting request to meeting that you previously scheduled; after you change the meeting request to 
include the meeting workspace information, Outlook sends an updated request include the meeting workspace information, Outlook sends an updated request 
containing the information to all attendees.containing the information to all attendees.

To create a meeting workspace in a new or existing meeting request:To create a meeting workspace in a new or existing meeting request:

  1.   1.  InIn the meeting window, on the  the meeting window, on the MeetingMeeting tab, in the  tab, in the AttendeesAttendees group, click the  group, click the 
Meeting WorkspaceMeeting Workspace button. button.

  2.   2.  InIn the  the Meeting WorkspaceMeeting Workspace pane that opens on the right side of the meet- pane that opens on the right side of the meet-
ing window, click the ing window, click the Select a locationSelect a location arrow, and then in the list, click the  arrow, and then in the list, click the 
SharePoint site where you want to create the meeting workspace. (If this is SharePoint site where you want to create the meeting workspace. (If this is 
the fi rst time you’ve used the Meeting Workspace pane, you might fi rst need the fi rst time you’ve used the Meeting Workspace pane, you might fi rst need 
to click to click Change settingsChange settings.) If you haven’t previously set up a meeting work-.) If you haven’t previously set up a meeting work-
space or document library on the SharePoint site you want to use, click space or document library on the SharePoint site you want to use, click OtherOther
in the in the Select a locationSelect a location list, enter the SharePoint site address in the  list, enter the SharePoint site address in the Other Other 
Workspace ServerWorkspace Server dialog box that opens, and then click  dialog box that opens, and then click OKOK..

  3.   3.  In the In the Select a workspaceSelect a workspace area, select the template language and meeting  area, select the template language and meeting 
workspace template you want to use, and then click workspace template you want to use, and then click OKOK. Or if you want to . Or if you want to 
link to an existing meeting workspace, select that option, click the link to an existing meeting workspace, select that option, click the Select the Select the 
workspaceworkspace arrow, and then in the list, click the existing workspace. arrow, and then in the list, click the existing workspace.

  4.   4.  In the In the Meeting WorkspaceMeeting Workspace pane, click  pane, click OKOK..

Attendees can link to the meeting workspace from the meeting request or from Attendees can link to the meeting workspace from the meeting request or from 
the meeting item on their calendars.the meeting item on their calendars.

See AlsoSee Also  For more information about using Outlook with SharePoint products and 
technologies, see Chapter 10, “Collaborating with Other People.”

Responding to Meeting Requests    193
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Display the meeting dateResponse options

If you’re unsure whether a meeting time works for you, you can click the Calendar button 
within the meeting request window to open your Outlook calendar for the suggested 
meeting day in a separate window, so you can view any conflicting appointments.

When accepting or declining a meeting, you can choose whether to send a response to 
the meeting organizer. If you don’t send a response, your acceptance will not be tallied in 
the Meeting form, and the organizer and other attendees will not know whether you are 
planning to attend the meeting. If you do send a response, you can add information to the 
response before sending it, if you want to convey a message to the meeting organizer.

To manually respond to a meeting request:

	 1.	 In the meeting request window, in the Reading Pane, or on the shortcut menu that 
appears when you right-click the meeting request, click Accept, Tentative, or Decline.

	 2.	 Choose whether to send a standard response, a personalized response, or no  
response at all.

To propose a new time for a meeting:

	 1.	 In  the meeting request window, in the Reading Pane, or on the shortcut menu that 
appears when you right-click the meeting request, click Propose New Time.
	 2.	 In the schedule area of the Propose New Time dialog box, similar to the Scheduling 
page of the meeting request window shown earlier, change the meeting start and end 
times to the times you want to propose, and then click the Propose Time button.
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	 3.	 In the meeting response window that opens, enter a message to the meeting  
organizer if you want to, and then click Send.

Outlook sends your response and adds the meeting to your calendar as tentatively 
scheduled for the original meeting time. After the meeting organizer approves the 
meeting time change, you and other attendees will receive updated meeting requests.

You can also choose to respond to meeting requests automatically. If you do, Outlook 
will process meeting requests and cancellations in accordance with your instructions.

To instruct Outlook to automatically respond to meeting requests:

	 1.	 On the Tools menu, click Options.

	 2.	 On the Preferences tab of the Options dialog box, click the Calendar Options button.

	 3.	 In the Calendar Options dialog box, click the Resource Scheduling button.

	 4.	 In the Resource Scheduling dialog box, select the Automatically accept meeting 
requests and process cancellations check box.

	 5.	 Select the Automatically decline conflicting meeting requests and/or the 
Automatically decline recurring meeting requests check boxes if you want 
Outlook to do this.

	 6.	 Click OK in each of the open dialog boxes.

 Points
	 l	 You can create and manage appointments and all-day events in your calendar.

	 l	 You can use Outlook to set up meetings, invite participants, and track their responses. 
Outlook can help you choose a meeting time based on participants’ schedules.

	 l	 Other people in your organization can see your free, busy, and out-of-office time that 
you indicate in your calendar. You can personalize the display of your available work-
ing hours, and mark appointments as private to hide the details from other people.

	 l	 If your organization has a SharePoint collaboration site, you can create a meeting 
workspace to accompany a meeting request. Meeting workspaces provide a central 
location for sharing information and files among meeting attendees.

	 l	 If your organization is running Exchange Server 2007, you can use the Smart 
Scheduling feature to quickly identify meeting times of a specific duration during 

Key Points    195
which your planned attendees are available.
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contacts, fi nding with, xl
implementing, 145

automatic setup
defi ned, 3
troubleshooting, 7

AutoPick Next button, 192
AutoPreview, 26, 116–17, 153
AutoSave, 329
availability, sharing, 213

B
Background Color button, 51
background color of messages, 104
backing up Personal Folder fi les, 314
Bcc fi eld, xlii
BE SURE TO paragraphs, xxiv
birthdays, entering in contact records, 42

appointment window
ents, 90
ng, xlii
ting, 320 (see also digital IDs)
ng messages by, 149
forwarding as, 257
g, xliv, 117, 120
ing, xliv

blind carbon copies, xlii
blocked content, viewing, lxiii, 322
Blocked Senders List, 326
blocking 

e-mail, 326
external content, 322
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46, 333. See also RSS feeds
 lists
ing level in, 85
ng, 84
oting/demoting list items in, 85
button, 84
gallery, 85
s Card button, 51
s cards, 49
round color, applying, 51
ling, xlii, 91
g, 51, 52
ics, adding, 51
g to other people, 50

natures, 109
s Contact Manager, 13
s Tools tab, 35
, toolbar, 298. See also specifi c button 
es; tabs

g, 299, 306
s on, 32
n icons for, xxiv
g, 300, 306
ing, 301, 306
gory view, 199

 Exchange mode
d, 283, 333

load options, 284
r bar. See To-Do Bar
r button, 134, 200
r item windows
d, 176, 333
79–181
r Options button, 206
r Options dialog box, 195, 203, 205–06
rs
 Appointments view, 198
pointments view, 198
l Events view, 198

ble time, 201, 204–205
tegory view, 199

Events view, 198
holidays, l, 203
Internet, 216
items, creating from e-mail messages, 131, 134
items, moving between calendars, 219
level of detail, setting, 202
Month view, 201
multiple, 218–19
navigating, 199, 202
OneNote, linking to, lii, 216
Outlook Data Files view, 199
permissions, granting to other users, liii, 220
printing, li (see printing calendars)
publishing on the Web, 212
Recurring Appointments view, 198
resetting, 201
saving as Web pages, lii, 212
SharePoint, 274
sharing, li, 212–14
Side-By-Side mode, 219
switching to other calendar from, 216
time periods, switching between, 198
views, 198–99
week numbers, displaying, 199
work week, 201, 204–205
Work Week view, 198

canceling messages, xlii, 88
categories, 44, 161

adding, 163
applying, 161
calendars, viewing grouped by, 199
colors, changing, xlvii, 163
contacts, assigning to, xxxix, 45
creating, xlvii
default, setting, 161
defi ned, 333
displaying current, 162
displaying default, xlvii
e-mail messages, assigning to, 99
grouping contacts by, 60
grouping messages by, 149, 161, 164
for holidays, adding, 203
as Quick Click categories, 161
renaming, xlvii, 162
shortcut keys, assigning to, 163
sorting Inbox by, xlvii

Category bar  341
g items between, 219
iew, 199Day/Week/Month view, 198
lt display, 200–201
ating control of, liii, 220
ying multiple, 219
l messages, creating items from, 131, 134
ling (see sharing calendars)

standard, 44
for tasks, changing, 235
viewing messages in, 161

Categorize button, 45, 161–62
Categorized Mail folder, 160
Category bar, 161
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 xxiv
te Import Wizard, 7
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ion authorities, 318. See also digital IDs
olors button, 96
-Mail Account dialog box, 279
 tracking, 304
humb tabs, xxiii
r positioning options, 304
dress dialog box, 41
 e-mail addresses, xli, 9, 82
 spelling as you type, 302
 SmartArt Graphic dialog box, 92
rofi le dialog box, 16
rch button, 64, 148
searches, 64, 148
es, 307, 333
d task pane, 36
tton, 31, 253
ragraphs, xxiv

es, lxiii
messages, after replying, xlv, 123
, 35
53

g Pane, 23
Bar, 22
tion sites
rs, 274
ting to Outlook from, lvii, 272
 button, 61, 155
g
messages, 61
, xlvi, 155
, 178

ound, 51, 104
s cards, applying to, 51
3
s, changing, 252

contacts, assigning to, xxxix, 45
creating, xlvii
default, setting, 161
defi ned, 333
dialog box, 46, 162
displaying current, 162
displaying default, xlvii
e-mail messages, assigning to, 99
grouping by, 60, 149, 161, 164
for holidays, adding, 203
as Quick Click categories, 161
renaming, xlvii, 162
shortcut keys, assigning to, 163
sorting Inbox by, xlvii
standard, 44
for tasks, changing, 235
viewing messages in, 161

color-coding message headers, 161
Colors gallery, 96
columns

deleting from Inbox, 158
reordering, xlvi, 157

commands, 298
displaying list of, 300
new organization of, xii
on Quick Access Toolbar (see Quick Access 

Toolbar)
commas as separators when addressing 

messages, 81, 329
companion CD

how to use, xxiii
practice fi les on, xxv
resources available on, xxvi

conference rooms, requesting, 190. See also 
meetings

Confi dential, marking messages as, 98
Confi gure Buttons button, 256
confi guring

Exchange Server, as IMAP account, 7
server settings, manually, 5, 8

Connect dialog box, 282
Connect To A Network dialog box, 281
connecting Outlook over HTTP, lvii, 279
connection speed minimum for Offi ce 2007, xxvii
contact records

as address cards, 57

category views
, changing, 232
egories
, 163
g, 161
rs, viewing grouped by, 199

changing, xlvii, 163

addressing messages from, 44
assigning tasks from, 44
Business Card area (see electronic business cards)
as business cards (see electronic business cards)
color categories, xxxix, 45, 60
creating, xxxviii, 33, 43
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ed, 333
ay As box, 40
ying, 33, 56, 255
e-mail attachments, 117
s fi eld, 40
ing by color category, 60

rting, 56
 linked to, displaying, 255
 of contact addresses, displaying, 44
ing requests, creating from, 44
ating, 57
, adding to, lv, 254
ote, linking to, xli, 71

one list, 57
g Internet calls from, 44

ng selected, 67, 70
g, xl, 59
, xl, 57
sites, displaying from, 44
t tab, 35
t window
ed, 333
 Access Toolbar in, adding items to, 31
n, 35
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ional details, displaying, 42
ssing Outlook items to, 26, 38

days, entering, 42
lt mailing address, displaying, 41
ed, 333
ying as address cards, 57
ying as business cards, 57
ying as phone list, 57 

bution lists of, 46, 48
il addresses, entering, 40
iling, 91
g, xxxviii–xxxix
rs (see contacts folders)

ation stored for, 39
al, recording activities in, 256
s, entering, 40
ating, 58
ing records for, 42
e numbers, entering, 40
hing, xl, 63
g by column, 59

contacts folders
creating, xxxix, 53
defi ned, 38, 333
sharing, 53
storage location, selecting, 54

Contacts For Note dialog box, 254
Contacts list, 47
Contacts module, defi ned
Contacts pane, 33, 255
context toolbar, 102, 302
Contextual tabs, 86
Control Panel, 14
conversations, 149
converting text to bulleted list, 84
copying

calendar items, between calendars, 219
e-mail messages, preventing, 99
formatting, 103
text, 304

courtesy copies, xlii, 82
Create Microsoft Personal Folders dialog box, 315
Create New Folder dialog box, 53, 166, 231, 311
Create Or Open Outlook Data File dialog box, 315
Custom dialog box, 242
Custom View Organizer dialog box, 159
Customize dialog box, 306
Customize Quick Access Toolbar button, 76
Customize View dialog box, 156, 201
customizing

forms, 305
Outlook, lxi, 301
Quick Access Toolbar, 76, 299
Search Folders, xlvii, 160
To-Do Bar, 22

cutting and pasting, 304

D
Daily Style for printed calendars, 207
Daily Task List, 230
dashboard, Business Contact Manager, 13
data fi les

closing, lxiii
creating, 314
defi ned, 333

date bar  343
t addresses, 40–41
, default, 58
, managing, 59
page associated with, viewing, 26
ow for entering information about, 31, 35
ts button, 33

on network server, 314
opening, lxiii, 316
on personal computer (see Personal Folders fi les)

date, grouping messages by, 149
date bar. See To-Do Bar
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tments, adding in, 183
izing number of months displayed in, 22
 display of, 183
, 333

ing different date in, 183
s shown in, increasing, 199
, 199
k/Month view, 198
s. See due dates
 tasks, reclaiming, 239
 meeting requests, 192, 195

 message delivery, 99
 Permissions dialog box, 221
s
, 333
r, 263
g
r control, liii, 220

, 263
er permission, 263
ee assigning tasks)
em button, 130
Items folder, 125

messages, 125
messages, with desktop alerts, xliv, 130
s, 203
olumns, 158
t calendars, 216
mail, automatically, 325
ently, 125
ds, 248
res, 110

inders, 240
iv, 240, 242
options, 99
receipts, 99
g bulleted list items, 85
 Alert Settings dialog box, xliv, 128–29
alerts. See also reminders
ointments, 182, 184
izing, xliii
, 333

g messages with, xliv, 130
ail messages, 126

ing, 26

Desktop Search Engine. See Instant Search
Detailed Address Cards view, 57
Details button, 42, 236
Developer tab on Ribbon, 302
diagrams in e-mail messages. See SmartArt
dial-up networking, 334
Dialog Box Launcher, 32, 36, 99, 334
dialog boxes

Account Settings, 12, 248
Add Card Picture, 51
Add Holidays To Calendar, 203
Add New Category, 163
Add New Member, 48
Appointment Recurrence, 185, 187
Archive, 172
AutoArchive, 170
Calendar Options, 195, 203, 205–206
Change E-Mail Account, 279
Check Address, 41
Choose A SmartArt Graphic, 92
Choose Profi le, 16
Color Categories, 46, 162
Connect, 282
Connect To A Network, 281
Contacts For Note, 254
Create Microsoft Personal Folders, 315
Create New Folder, 53, 166, 231, 311
Create Or Open Outlook Data File, 315
Custom, 242
Customize, 306
Customize View, 156, 201
Custom View Organizer, 159
Delegate Permissions, 221
Desktop Alert Settings, xliv, 128
Edit Business Card, 51
Edit Rule, 289
Folder Properties, 264
Font, 37
Group Schedules, 271
Import/Export Digital ID, 319
Inbox Properties, 171
Insert Business Card, 91
Insert File, 89
Internet Accounts, 251
Journal Options, 256
Junk E-mail Options, 324
Location Information, 40

Date Navigator
g messages as read with, xliv, 130
, xliii, 129

 length of time visible for, 129
rency, setting, 129
 off, xliv, 128

Mail, 15–16
Mail Setup, 14
Microsoft Exchange, 279
Microsoft Exchange Proxy Settings, 279
Move Items, 167
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ove Or Copy Pages, 216
ew Outlook Data File, 314
ew Profi le, 15
ew Signature, 108
pen Other User’s Folder, 266
ptions, 107, 127, 169, 327
ther Settings, 158
ut Of Offi ce Assistant, 288, 292
age Setup, 138, 209
lan A Meeting, 26
rint, 66, 137, 208
ropose New Time, 195
earrange Commands, 306
ecall This Message, 88
ename Category, 45
ules And Alerts, 26, 310, 312
ave As, 257
ave As Web Page, 212
earch Options, 64
earch Text, 310
elect Contacts, 254
elect Members, 47
end A Calendar Via E-mail, 214
ervice Sign-Up, 321
et Quick Click, 131
how Fields, 151, 157
ignatures And Stationery, 107
ask Options, 232
ime Zone, 206
o-Do Bar Options, 22

gital certifi cates, 7
gital IDs
xporting/importing, lxiv, 319
ultiple, 318

btaining, lxiv
gital signatures
ttaching, lxiii, 319
s default, 317
efi ned, 334

cons for, 319
iewing information on, 319

gitally Sign Message button, 319
scussion groups, 250–51
splay As box, in contact records, 40
splay name, replacing user name with, 9
splaying

document libraries, 272–73
document workspaces

creating from Outlook, lvii, 269
defi ned, 334

documents
sharing, lvii, 269–70, 272–73
title bar, 31

Documents folder in Windows XP, xv
domains, blocking e-mail from, 326
double-clicking tabs, 78
downloading

blocked pictures, 322
Internet calendars, 217

drafts
defi ned, 334
saving, 82
settings, lxiv

dragging menu bar, 23
due dates, task

changing, 234
grouping messages by, 150
setting for This Week, 235
specifying, xlv

E
e-mail. See also e-mail accounts; e-mail 

messages
attachments (see e-mail attachments)
defi ned, 334
digital signatures, 317, 319
junk (see junk e-mail)
options, 327
securing, 317
signing digitally, 317, 319

e-mail accounts
adding to profi les, 9–10
connecting, xxxvii
different signatures for, 109
grouping messages by, 150
Outlook support for different types, 2
switching between, 10

e-mail addresses
commas, separating with, 329

e-mail attachments  345
ontacts pane, 255
ield Chooser window, 26
ournal, 256
eading Pane, 25

stribution lists, 46, 48. See also contacts
cking menu bar, 23

validating, xli, 9, 82
e-mail attachments, 90

attaching, xlii
encrypting, 320 (see also digital IDs)
grouping messages by, 149
notes, forwarding as, 257
opening, xliv, 117, 120
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ttachments (continued)
wing, xliv, 117, 119
eplying to messages, 124

ting permissions for, 321
 to hard disk, 117
ing, 144
 (see shared attachments)
ing between messages and, 120
g details about, 119
essage window, 75-80
essages
sing (see addressing messages)
tments, creating from, xlv, 134
ng, xlviii, 169, 172 (see also AutoArchive)
ing, 148, 151
ing fi les to (see attachments)
eply (see auto-reply messages)
ve settings, 329
ound color, 104
d content, viewing, 322
ss cards (see business cards)
ar items, creating from, 131, 134

ling, xlii, 88
 after replying, xlv, 123
ing, 61
ategories for (see color categories)
as as address separators in, 329
sy copies, xlii, 82
g, xli
t appearance of, 100
g, xiiv, 125, 130
ms in (see SmartArt)
ing in Reading Pane, 115

 saving, 82
ting, lxiii, 320
tte, 122
ing, 61

ttaching (see attachments)
g (see rules)
g, 98, 131–32
 (see folders)
lor, 103

ze, 103
ting text of, xliii
ding (see forwarding e-mail messages)
cs in (see SmartArt)
ing (see grouping messages)

moving into folders, 167
new, getting notifi cations for, 126–27
old, storing, xlviii, 169, 172 (see also AutoArchive)
opening in own window, 115, 120
organizing, xlvi (see also folders)
paging through, with Spacebar, 115
plain text, 321
predefi ned text blocks in (see signatures)
preventing from being forwarded or copied, 

99, 322
previewing, 26, 116–18, 153
printing, xlv
read status, xliv, 116, 130, 152
recalling, xlii, 88
receipts, requesting, 99
replacing, after sending, 88
replying to (see replying to e-mail messages)
restricting permissions for, 99
saving, changing automatic settings for, 329
schedule information in, li
sending (see sending messages)
sensitivity of, 98
setup, confi guring, lxv
signatures in (see signatures)
size, grouping by, 150
SmartArt diagrams in (see SmartArt)
sorting, 151
starting, 75
styles, 101
tables in, 85–86
tasks, creating from, xlv, 131
text, formatting, xliii
themes, applying, xliii
tracking, 99
unread (see unread messages)
viewing in Reading Pane, consecutively, 115
voting buttons, 99, 122

E-mail Options button, 81
e-mail pane. See Reading Pane  
e-mail server, 334
e-mail signatures, 334
e-mail trails, 334
e-mailing 

business cards, xlii, 91
calendars (see sharing calendars)
contacts, 91

Edit Business Card dialog box, 51

e-mail message window
rs, 161
tance of (see importance)
g as read, xliv, 116, 130
g as unread, 152
g attendees, sending to, 192

Edit Rule dialog box, 289
editing

business cards, 51, 52
contacts, xxxviii–xxxix
tasks, 237
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ole for delegating, 263
nic business cards, 49
round color, applying, 51

iling, xlii, 91
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ics, adding, 51

ng to other people, 50
natures, 109
nic notes. See notes; OneNote
ng Deleted Items folder, 125
t Message Contents And Attachments 
ton, 320

ted connection not available message, 7
tion
d, 334

dividual messages, 320
cipients without encryption support, 320
ndicating, 320

E receipts, requesting for, 320
g as default, 320
igital IDs, lxiv, 318–19
ment, 30
ent, requesting for meetings, 190

ab, 181
indows
d, 176, 334

ing, 187
ing between, 180–81

 See also appointments
dars, viewing grouped by, 198
ng, 180, 187
d, 186, 334

ings, converting to, 190
ing, 187
ring, xlix, 187–88
uling, xlix
view, 198
ge Server, 189
ss list, 37, 334
cting to, troubleshooting, 7

il accounts, ability to confi gure only 
, 11

il accounts, multiple profi les for, 12
AP account, 7
ok support for, 2

expanding
e-mail messages, 61
groups, xlvi
Navigation Pane, 21

exporting
address books, xl, 56
digital IDs, lxiv, 319

external content, blocked, 322

F
Field Chooser window, 26
fi eld codes, 304
fi elds

adding/removing, xlvi
in Inbox, adding/deleting, 157–58
organizing, 151
reordering, 157

File As fi eld, in contact records, 40
fi le attachments, 90

attaching, xlii
encrypting, 320 (see also digital IDs)
grouping messages by, 149
notes, forwarding as, 257
opening, xliv, 117, 120
previewing, xliv, 117, 119
when replying to messages, 124
restricting permissions for, 321
saving to hard disk, 117
searching, 144
sharing (see shared attachments)
switching between messages and, 120
viewing details about, 119

File menu. See Offi ce menu
fi le name extensions, 90
fi le types, 90
fi les, attaching to messages. See attachments
fi ling messages. See archiving messages
fi ltering

e-mail messages (see rules)
Inbox, xlvi, 145
tasks, as you type, 231

fl agging messages
creating tasks with, 132

folders  347
gs, xxxvii
g folders over, lvi, 262, 268

es in book, system requirements for, 
ii
 button, 61, 155
 The Query Builder button, 146

outgoing, 98
setting task due dates when, 131

fl oating menu bars/toolbars, 24, 334
folders

archive settings, 172
available views, displaying, 26
bold names, 160
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tact information, xxxix, 38, 53–54
g, xlviii, 53, 166
ting control of, 263
ing, 168
g for offl ine use, lix

g, 316
g messages into, 167
, bold, 160
ting, 25
 availability, 285
g, from other user, 266
zing messages in, 165
sion to view, requesting, 266
sions, changing, 264
 feeds, 246–47
, linking to, 268
oint document libraries as, 272
, lvi, 262
ring, 165

ks, liii, 231
ton, 102
r, 103

lor button, 103
lor gallery, 103
log box, 37
, 103

e button, 103

ng to text, 103
t, 100
alphabets, 58
ainter button, 103
ext tab, 36, 80, 179, 228
ng
ions of (see themes)
g, 103
t, 100
s for, 100
Styles, 100–101
s (see themes)
ng marks, 302

g, 305
izing, 305

d, 334
ed with Outlook, 305

publishing, 305
saving, 305

forums, 334. See also newsgroups
Forward button, 124, 202
forwarding e-mail messages, xliv, 121, 124

automatically, when out of the offi ce, lix, 290 
(see also auto-reply messages; Out Of Offi ce 
Assistant)

preventing, lxiii, 99, 322
specifying signature for, 122

forwarding notes, lvi, 257
free/busy information, 191
freezing menu bar, 23

G
GAL (Global Address List), 37, 334
galleries

Bullets, 85
Colors, 96
Font Color, 103
Layouts, 96
Page Color, 104
Quick Styles, 101
SmartArt Styles, 96
Themes, 105

getting help
 with book/companion CD, xxxi
 on the Internet, xxxv
 with Outlook, xxxi
 ScreenTips and, 302, 304 

Global Address List (GAL), 37, 334
global formatting

defi ned, 334
options, 100

glossary terms, formatting of, xxiv
graphics

blocked, downloading, 322
in business cards, 51 (see also business cards)
in e-mail messages (see SmartArt)
placeholders, turning on/off, 304

gridlines, 158
Group By box, 26
group schedules

creating, lvi, 271
defi ned, 334

Font button
d, accessing, 305
s, accessing, 305

izational Forms Library, publishing 
05
ties, 305

viewing, 271
Group Schedules dialog box, 271
grouping messages, 149

by color categories, 161, 164
by sender, 154
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llapsing, 155
fi ned, 334
alog Box Launcher, 32, 36, 99
panding/collapsing, xlvi

 disk requirements for Offi ce 2007, xxvii
ders
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lor-coding, 161

th book/companion CD, xxxi
 the Internet, xxxv
th Outlook, xxxi 
reenTips and, 302, 304
ng
pointments, 184
ld Chooser window, 26

avigation Pane, 21
ading Pane, 25

bbon, 79
bs, 79
 importance, 98

days, l, 203
L message format, 80, 335

P
nnecting Outlook over, lvii, 279
fi ned, 335
mail accounts, 307
erlinks in notes, 253
ertext Markup Language (HTML) message 
format, 80, 335
ertext Transfer Protocol (HTTP)
nnecting Outlook over, lvii, 279
fi ned, 335
mail accounts, 307

s
r digital signatures, 319

in business cards, 51 (see also business cards)
in e-mail messages (see SmartArt)
placeholders, turning on/off, 304

IMAP message format, 80, 335
Import And Export Wizard, 56
Import/Export Digital ID dialog box, 319
importance, 98

default, changing, 329
defi ned, 335
grouping messages by, 150

Important paragraphs, xxiv
importing

contact records, 56
digital certifi cates, 7
digital IDs, lxiv, 319
SharePoint Contacts List, xli, 31

Inactive Message fl ag, 132
Inbox

conversations in, 149
default settings, restoring, xlvi
fi elds in, 157–58
fi ltering, xlvi
fi ltering to display search results, 145
grid lines, customizing, 158
searching in, 145
sorting, by category, xlvii
threaded conversations in, 149

Inbox Properties dialog box, 171
incomplete tasks, 241
index of book, how to use, xxiii
Information Rights Management (IRM), 321. 

See also permissions
Insert Business Card button, 91
Insert Business Card dialog box, 91
Insert File dialog box, 89
Insert SmartArt button, 92
Insert tab, 35, 79, 179, 228
inserting

business cards, in messages, 91
fi les, in e-mail messages (see attachments)
signatures, xliii
SmartArt, in messages, 92
tables, 85

Install Certifi cate button, 7
installing

digital certifi cates, 7

internal addresses, addressing messages to  349
r encrypted messages, 320
r new mail, 126
r recurring events, 188
r toolbar buttons, xxiv
fi les, 213–14
ges
ocked, downloading, 322

practice fi les, xxviii
printers, 140, 208

Instant Search, xlvi, 62, 144. See also searching
contacts, fi nding with, xl
implementing, 145

interface elements in exercises, formatting of, xxiv
internal addresses, addressing messages to, 81
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t Accounts dialog box, 251
t calendars, 216
t calls, 44
t Message Access Protocol (IMAP), 80, 335
ttendees button, 181
 meeting attendees, 182. See also 
etings
formation Rights Management), 321. 
 also permissions

ting, 256
d, 335
ying, lv, 256
ing activities with, lv

 button, lv, 256
 Options dialog box, 256
mail, 323
d, 335

ng automatically, 325
f protection, selecting, 324

cations of receipt, 322
eacons, 322

Mail Filter, lxiv, 323
Mail Options dialog box, 324

rd shortcuts
ing to color categories, 163
ble, 298
d, 335

eenTips, turning on/off, 304

es, displaying additional, 58
ail folder, 160
 gallery, 96
s, document, 272–73. See also document 
rkspaces

lists
changing level in, 85
creating, 84
promoting/demoting list items in, 85

local formatting, 335
Location Information dialog box, 40
logos on business cards, 51. See also business 

cards
Low detail level, setting in calendar, 202

M
Mail dialog box, 15, 16
Mail module, 74
Mail Setup dialog box, 14
mailbox, viewing size of, 169
Mailbox Cleanup, 169
mailing address, specifying default for 

contacts, 41
maps of contact addresses, displaying, 44
Mark Complete button, 241
marketing communications, distributing with 

Business Contact Manager, 13
marking e-mail messages as read, 116

manually, xliv
with desktop alerts, xliv, 130

marking tasks as complete, liv, 241
Medium detail level, setting in calendar, 202
meeting requests

accepting, 192, 195
attendee status, 191
creating, 44, 190
declining, 192, 195
defi ned, 188, 335
delivering to delegate, liii, 220
Optional Attendee status, 191
Required Attendee status, 191
for resources, 188
responding to, xlix, l, 192, 194–195
scheduling, 191
sending, xlix
status, of attendees, 191
tentative bookings, 191

Meeting tab, 181
meeting window, 176, 182, 335
Meeting Workspace button, 193

Internet Accounts dialog box
dars, to OneNote, 216
cts, to notes, 254
ote notes, to Outlook, 243
red folders, 268

meeting workspaces, 193, 335
meetings

addressing to currently selected contact, 26
attendees, adding, 191
confl icting appointments, viewing, 194
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ting, 181
ts, converting to, 190
ange Server 2007 and, 189
ing attendees, 182
ifying, 192
osing new time for, l, 192, 194
esting (see meeting requests)

heduling, 190
duling, 188
, changing, 191
ating, 190
ry requirement for Offi ce 2007, xxvii

 bar
king, 23
ging, 23

ting, 24
ing, 23
s
ing, 35
psing, 178
 organization of, xii
ge button, 118
ge headers
ing, 140
r-coding, 161
ned, 335
ge importance, 98
ult, changing, 329

ned, 335
ping messages by, 150
ge tab, 78
ge window
ned, 74, 335
ning, 75
on (see Ribbon)
ges, e-mail
ressing (see addressing messages)
ointments, creating from, xlv, 134
iving, xlviii, 169, 172 (see also AutoArchive)
nging, 148, 151
ching fi les to (see attachments)
-reply (see auto-reply messages)
save settings, 329
ground color, 104
ked content, viewing, 322
ness cards (see business cards)
ndar items, creating from, 131, 134

courtesy copies, xlii, 82
creating, xli
default appearance of, 100
deleting, xliv, 125, 130
delivery options, 99
diagrams in (see SmartArt)
displaying in Reading Pane, 115
drafts, saving, 82
encrypting, lxiii, 320
etiquette, 122
expanding, 61
fi les, attaching (see attachments)
fi ltering (see rules)
fl agging, 98, 131–32
folders (see folders)
font color, 103
font size, 103
formatting text of, xliii
forwarding (see forwarding e-mail messages)
graphics in (see SmartArt)
grouping (see grouping messages)
headers, 161
importance of (see importance)
marking as read, xliv, 116, 130
marking as unread, 152
meeting attendees, sending to, 192
moving into folders, 167
new, getting notifi cations for, 126–27
old, storing, xlviii, 169, 172 (see also 

AutoArchive)
opening in own window, 115, 120
organizing, xlvi (see also folders)
paging through, with Spacebar, 115
plain text, 321
predefi ned text blocks in (see signatures)
preventing from being forwarded or copied, 

99, 322
previewing, 26, 116–18, 153
printing, xlv
recalling, xlii, 88
receipts, requesting, 99
replacing, after sending, 88
replying to (see replying to e-mail messages)
restricting permissions for, 99
saving, changing automatic settings for, 329
schedule information in, li
sending (see sending messages)

messages, e-mail   351
elling, xlii, 88
ing after replying, xlv, 123
psing, 61
r categories for (see color categories)
mas as address separators in, 329

sensitivity of, 98
setup, confi guring, lxv
signatures in (see signatures)
size, grouping by, 150
SmartArt diagrams in (see SmartArt)
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s, e-mail (continued)
g, 75
 101
 in, 85–86
creating from, xlv, 131
rmatting, xliii

s, applying, xliii
g, 99
 (see unread messages)

g in Reading Pane, consecutively, 115
 buttons, 99, 122
ft Exchange dialog box, 279
ft Exchange Proxy Settings dialog 
, 279
ft Exchange Server, 189
ss list, 37, 334
cting to, troubleshooting, 7
d, 335
 accounts, ability to confi gure only one, 11
l accounts, multiple profi les for, 12
P account, 7
k support for, 2
s, xxxvii

g folders over, lvi, 262, 268
ft Knowledge Base, xxxv
ft Offi ce 2007, xxvi
ft Offi ce Button, 30, 335
ft Offi ce OneNote
ars, linking to, lii, 216
ts, linking to, xli, 71
g pages in, 168
in, linking to Outlook, 243
in, moving, 216
g e-mail messages to, xlviii, 168
ft Offi ce SharePoint Server 2007 
ument libraries, lvii, 272-73
ft Offi ce Outlook
atic setup, 3
izing, lxi, 301

l accounts supported by, 2
(see Inbox)
ne, 21, 199
ation Pane, 21, 199
s (see profi les)
 up, 3, 7
g, 3
r, xi

practice fi les, managing, xv
Start menu, xvi
starting Outlook on, xvi
virtual private network (VPN) connection, 

setting up under, lviii, 282
Mini toolbar, 102, 302, 335
Minimize button, 31
minimizing

Daily Task List, 230
Navigation Pane, 21
To-Do Bar, 21, 230

Mobile Address Book, 38, 335
modules, defi ned, 335
monitor requirements for Offi ce 2007, xxvii
Monthly Style for printed calendars, 207
Move Items dialog box, 167
Move Or Copy Pages dialog box, 216
Move Up button, 300
moving

appointments, 183
desktop alert location, 129
menu bar, 23
messages, into folders, 167
Quick Access Toolbar, 76
Reading Pane, 22
Ribbon, 77

N
name bar, 31
names, contact. See contacts
naming profi les, 15
navigating

calendars, 199, 202
contacts, 58
folders, 25

Navigation Pane
expanding, 21
minimizing, 21
widening, 199

networking. See sharing
New Appointment button, 177, 190
New Contact button, 33, 40, 47
New Mail Message button, 75, 83, 89, 129, 329
New Mail Message icon, 126

Microsoft Exchange dialog box
ft Press Knowledge Base, xxxi
ft Product Support Services, xxxv
ft Windows SharePoint site, 193
ft Windows XP
 boxes in, navigating, xvii

new mail notifi cations, 126–27
new messages. See unread messages
New Note button, 253
New Outlook Data File dialog box, 314
New Profi le dialog box, 15
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ignature dialog box, 108
ask button, 226, 236
command on toolbar, 250
eeds
ting, 248
rs for, 246–47

ers for, 246
oving, liv
cribing to, liv, 248
ting, 246
ing available, 247
roups
ssing, 250
ng, 251
ed, 335
ing, 250
eaders, defi ned, 250
 251. See also OneNote
ng, 253
r, 252
acts, adding to, lv, 254
ting, lv, 253
ult settings, 252
ed, 335

laying, 252
 saving as, 257
atting, lv
arding, lvi, 257
rlinks in, 253
ing, lvi
ing Pane and, 252
g, 253
g, as fi les, lvi

ching in, 252
ing, 257
 adding, 253
s for, 251
 About This Item button, 216
 button, 252
ation of new e-mail messages, 126–27
ation windows. See desktop alerts

ered steps, formatting conventions of, xxiv

offl ine content
defi ned, 283
download options, 284
fi les in document libraries, 273

Offl ine Server Documents, 273
OneNote. See also notes

calendars, linking to, lii, 216
contacts, linking to, xli, 71
moving pages in, 168
notes in, linking to Outlook, 243
notes in, moving, 216
sending e-mail messages to, xlviii, 168

opening
appointment window, 177, 184
attachments, xliv, 117, 120
contact records, 42
Control Panel, 14
data fi les, lxiii, 316
e-mail messages, in own window, 115, 120
events, 187
folders, from other user, 266
message window, 75
notes, lvi
Outlook, 3
Personal Folders fi les, 316
Print Preview, 137
task window, 235

Open Other User’s Folder dialog box, 266
OPEN paragraphs, xxiv
operating system version required for Offi ce 

2007, xxvii
Optional Attendee status, 191
Options dialog box, 107, 127, 169, 327
Options tab, 79
Organizational Forms Library, 305
organizations, addressing messages within, 81
Other Actions button, 88
Other Settings dialog box, 158
Out Of Offi ce Assistant. See also auto-reply 

messages
defi ned, 336
Exchange Server 2003 features, 288
Exchange Server 2007 features, 292
using to set time as, 158

Out Of Offi ce Assistant dialog box, 288, 292

Outlook  353
 2007 system requirements, xxvi
 Button, 30, 335
 menu, 30, 178
 Online Web site, 217
 address books, 286, 336

Outlook
automatic setup, 3
with Business Contact Manager, 13
customizing, lxi, 301
e-mail accounts supported by, 2
Inbox (see Inbox)
Navigation Pane, 21, 199
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 (continued)
s (see profi les)

g up, 3, 7
g, 3

or, xi
 2007 Standard Forms Library, 305
 2007 Startup wizard, xxxvii, 3
 2007 with Business Contact Manager, 13
 Address Books, defi ned, page 336
 Anywhere, lvii, 279, 336
 Data Files view, 199
 forms

ng, 305
izing, 305

ed with Outlook, 305
ed, accessing, 305
es, accessing, 305
izational Forms Library, publishing to, 305
rties, 305
hing, 305
, 305
 Today page, 25
 Web Access (OWA), 283
 with Business Contact Manager, 13
 Rich Text Format (RTF), defi ned, 336

 mode, viewing multiple calendars in, 219
e mode, 304

w page, 25
utlook Web Access), 283

lor, 104
lor button, 104
lor gallery, 104
tup button, 138
tup dialog box, 138, 209
ptions button, 304
 See contacts
ions. See also Information Rights 
nagement (IRM)
lendars, delegating, liii, 20
d, 336
ting, 99
aring folders, 262

defi ned, 336
expanding, 316
exporting to older version of Outlook, 315
folders, moving to, 316
folders in, default, 316
moving messages to, lxii
opening, 316

personalizing. See customizing
phishing messages, 323, 336. See also junk e-mail
Phone List view, 57
phone lists, xl. See also contacts
phone numbers, 40
pictures

blocked, downloading, 322
in business cards, 51 (see also business cards)
in e-mail messages (see SmartArt)
placeholders, turning on/off, 304
sending, 90

plain text messages, lxiii, 80, 321, 336
Plan A Meeting dialog box, 26
pop-up toolbars, 102, 302
pop-up windows for alerts. See desktop alerts
POP3, 336
populating distribution lists, 46, 48. See also 

contacts
Post-It Notes. See notes
Post Offi ce Protocol 3 (POP3), 336
practice fi les, xxv

installing, xxviii
in Windows XP, location of, xv

Preview button, 208
previewing

attachments, xliv, 117, 119
e-mail messages, 26, 116–17, 153
as printed (see Print Preview)

Print button, 66, 208
Print dialog box, 66, 137, 208
Print Preview

opening, 25, 67, 137, 208
scrolling, 210

Print Preview button, 67
print styles, 137, 210, 336
printer installation, 140, 208
printing

address cards, xli
calendars, li
contacts, selected, 70

Outlook 2007 Standard Forms Library
bfolder creation, granting, 263
w folders, requesting, 266
l, setting messages as, 98
l Folders fi les
g up, 314

ng, lxii, 56, 314

e-mail messages, xlv
phone lists, xl

printing calendars, 207
date range, selecting, 210
default styles for, 207
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iewing (see Print Preview)
t styles, 210
ter, selecting, 209
ng e-mail messages
 default options, 137

ders for, 140
er options, 139
t styles, 137
ng range, selecting, 67
ty. See importance
y, 322
e, marking items as, 98, 184
e button, 184
e stores, 314, 336
ss diagrams. See SmartArt
ssor requirement for Offi ce 2007, xxvii
es
ing, 15
ing e-mail accounts to, 9–10
osing, when prompted, 16
ting, xxxviii
laying current, 14
tiple, 12
ing, 15

mpting for on startup, xxxviii, 16
ming, 15

ing as default, 12, 17
age location of, 12
ching between, 14
am interface elements in exercises, 
rmatting of, xxiv

cts, organizing with Business Contact 
anager, 13

oting bulleted list items, 85
se New Time dialog box, 195
se Time button, 195
sing new meeting time, 192, 194

cting e-mail, 317. See also digital 
gnatures; encryption; plain text messages; 
formation Rights Management (IRM)
cting privacy, 322
les
king up, 314
ting, lxii, 56, 314
anding, 316
orting to older version of Outlook, 315
ers, moving to, 316

publishing
calendars, 212
forms, 305

Q
Quick Access Toolbar, 30, 298

adding items to, in contact window, 31
buttons, adding, lx, 299
buttons, moving, 300
buttons, removing, 301
commands on, 31
commands on, adding, 77
customizing, 76, 299
defi ned, 336
moving, 76–77

Quick Click categories, 161
Quick Launch bar. See Quick Access Toolbar
Quick Print, 137
Quick Reference, how to use, xxiii
Quick Styles, 100, 336
Quick Styles gallery, 101

R
RAM requirement for Offi ce 2007, xxvii
reading newsgroups, 250
Reading Pane

closing, 23
displaying, 230
displaying messages in, 115
moving, 22
notes and, 252
position of, 115
previewing attachments in, 117, 119
previewing e-mail messages in, 118
task details in, 234
turning on/off, 25
viewing consecutive messages in, 115

Really Simple Syndication (RSS) feeds
defi ned, 336
deleting, 248
folders for, 246–47
readers for, 246

Rearrange Commands dialog box  355
ers in, default, 316
ing messages to, lxii
ning, 316

removing, liv
subscribing to, liv, 248
updating, 246
viewing available, 247

Rearrange Commands dialog box, 306
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ing. See sorting
is Message dialog box, 88
 messages, xlii, 88, 336

 for delivery, 99
earches, viewing, 64
ts, grouping messages by, 150
ng declined tasks, 239
g activities. See Journal
 contact. See also contacts
sing messages from, 44
ing tasks from, 44
ss Card area (see electronic business cards)
y As box, 40
 fi eld, 40
f contact addresses, displaying, 44
g requests, creating from, 44
 Internet calls from, 44

ites, displaying from, 44
ce button, 185, 187

g, defi ned, 336
g appointments, 182, 185, 188
g Appointments view, 198
g events
g, xlix, 187
t settings, 187
dicating, 188
 searches, 146. See also searching
g the Ribbon, 77
r button, 184
rs
ointments, 182, 184

d, 336
g, 240

sing, 233
, 98, 232, 236
 snooze for, 233
ks, 239
 off, liv

connections, 278
procedure calls (RPC), defi ned, 336
 Category dialog box, 45
g
ategories, xlvii, 162
s, 15
 Folders, xlvii
ng
ns, 157

replacing messages after sending, 88
reply address, alternative, 99
Reply button, 123
replying to e-mail messages, xliv

all recipients included, 121
attachments and, 124 (see also attachments)
automatically (see auto-reply messages; Out Of 

Offi ce Assistant)
closing message after, xlv, 123
preventing, lxiii
Reply To All function, disabling for recipients, 122
specifying signature for, 122

Request A Delivery Receipt command, 300
requesting meetings. See meeting requests
Required Attendee status, 191
resending messages, 88, 337
Reset Current View button, 157
resetting

calendars, to default display, 201
toolbars, to default, 307
views, to original settings, 159

resolving, defi ned, 337
resolving e-mail addresses, xli, 9, 82
resources, requesting for meetings, 188
responding to e-mail messages, xliv

all recipients included, 121
attachments and, 124 (see also attachments)
automatically (see auto-reply messages; Out Of 

Offi ce Assistant)
closing message after, xlv, 123
preventing, lxiii
Reply To All function, disabling for recipients, 122
specifying signature for, 122

Restore Down/Maximize button, 31
restoring Inbox to default settings, xlvi
restricting message permissions, 99
retention policies, 169
Return To Task List button, 239
Reviewer role for delegating, 263
Ribbon, xii, 32, 78. See also tabs

in calendar item windows, 179–181
in contact window, 35–37
defi ned, 337
hiding, 79
in message window, 76–80
moving, 77
in task window, 228

rearranging
ts, xl
ts, by column, 59
 messages, 151
ts, 230
g appointments, 182, 185, 188

Rich Text Format (RTF) fi les, 80
defi ned, 337
saving notes as, 257

RPC (remote procedure calls), defi ned, 336
RPC over HTTP. See Outlook Anywhere
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eeds
eting, 248
ers for, 246–47

ders for, 246
oving, liv
scribing to, liv, 248
ating, 246

wing available, 247
eeds folder, 247
ubscriptions folder, 247
 les, 80
 ned, 337
ing notes as, 257
, 307
ions, specifying, 310
nt, 307
ating, lxii, 308
eria, specifying, 309
 ned, 337
TP e-mail accounts and, 307
naging, 26
ning, 312
ing, 312
ver, 307
plates for, 309
 And Alerts dialog box, 26, 310, 312
 And Alerts window, 308
 wizard, 308

uarding e-mail, 317. See also digital 
ignatures; encryption; plain text messages; 
nformation Rights Management (IRM)
Recipients List, 322, 325
Senders List, 322, 325
 metrics, reviewing with Business Contact 

anager, 13
serif, 337

scams. See junk e-mail; phishing messages
schedules, group

creating, lvi, 271
defi ned, 334
viewing, 271

scheduling
appointments, xlviii
auto-reply messages, lx
events, xlix

Scheduling button, 191
scheduling events and appointments. See 

appointments; events
screen resolution minimum for Offi ce 2007, 

xxvii
ScreenTips

defi ned, 337
keyboard shortcuts displayed in, turning 

on/off, 304
style, setting, 302

Search Folders
creating, 160
custom, xlvii
customizing, xlvii, 160
displaying, 160
modifying messages in, 160
renaming, xlvii
updating, 160

Search Options dialog box, 64
Search Text dialog box, 310
searches

clearing, 148
criteria, adding, 146
folders for (see Search Folders)
messages no longer appearing in, 148
refi ning, 146
results, displaying in folder (see Search Folders)

searching. See also Instant Search
address books, xlii
attachments, 144
clearing results of, 64

Secure Multipurpose Internet Mail extensions (S/MIME)  357
& Close button, 41, 46, 184, 188, 236
As dialog box, 257
As Web Page dialog box, 212
 addresses. See contacts
g
chments, to hard disk, 117
ndars, as Web pages, lii, 212

ms, 305
ssage drafts, lxv, 82, 329
es, lvi, 253, 257
s, 312
t messages, 83

contacts, xl, 63
folders, all, 148
Inbox, 145
narrowing results of, 145
notes, 252
recent searches, 64
setting options for, 64
for tasks, 231

Secure Multipurpose Internet Mail extensions 
(S/MIME), 317, 337
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securing e-mail, 317. See also digital signatures; 
encryption; plain text messages; 
Information Rights Management (IRM)

Security Alert message box, 7
security certifi cates, 7
See Also paragraphs, xxiv
Select Contacts dialog box, 254
Select Members button, 47
Select Members dialog box, 47
Send A Calendar Via E-mail dialog box, 214
Send button, 53, 87, 90, 192, 239, 258, 267
Send Status Report button, 240
Send To OneNote button, 168
senders, grouping messages by, 150, 154
sending address books, xl, 56
sending calendars as e-mail, li

customizing level of detail for, 213
date range, selecting, 214
on the Web, 212

sending messages, xli, 87. See also e-mail 
messages

confi guring, lxv
courtesy copies, xlii, 82
to meeting attendees, 192
from multiple accounts, 10
to OneNote, xlviii, 168
from Sent Items folder, 88

sensitivity, 98, 337
Sent Items folder, 88
sent messages, saving, 83
server certifi cates, 7
server confi guration, 5, 8
server rules, 307, 337
Service Sign-Up dialog box, 321
Set Quick Click dialog box, 131
setting up

Outlook, 3, 7
server settings, 5, 8

shared attachments, 87
creating document workspaces with, 269
defi ned, 337
sending, lvii, 270

shared meeting sites, 193
shared resources, 190
SharePoint calendars, 274
SharePoint Contacts List, xli, 31
SharePoint document libraries

connecting to Outlook, lvii, 273
editing offl ine, 273
as folders, 272
offl ine fi les, editing, 273
previewing items in, 273
read-only items in, 273

SharePoint Lists folder, 273
SharePoint meeting workspaces, 193
SharePoint sites, connecting to, lvii, 272
sharing

address books, xl, 53
contacts folders, 53
documents, lvii, 269–70, 272–73
folders, lvi, 262
notes, 257
permissions for, changing, 264

sharing calendars, li
customizing level of detail for, 213
date range, selecting, 214
on the Web, 212

Show As button, 184
Show Bcc button, 82
Show Fields dialog box, 151, 157
showing. See displaying
signatures

associating with accounts, 109
business cards as, 109
creating, xliii, 106–107
default, setting, 109
defi ned, 337
deleting from messages, 110
formatting, 108
including by default, 109
inserting, xliii
multiple, for different accounts, 109
specifying different for replies and forwards, 122

Signatures And Stationery dialog box, 107
Signatures button, 107
signing e-mail digitally. See digital IDs; digital 

signatures
Single Key Reading Using Space Bar option, 115
size, grouping messages by, 150
smart cut and paste, 304
Smart Tags, 304
SmartArt

defi ned, 337
inserting in messages, xlii–xliii, 92 
shapes, adding, 94
text, adding, 94
Text Pane, displaying, 93

SmartArt Styles gallery, 96
S/MIME (Secure Multipurpose Internet Mail 

extensions), 317, 337
sorting

columns, 157
contacts, xl, 59
e-mail messages, 151
task lists, 230

sounds for new mail notifi cations, 127
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spam, 323
defi ned, 337
deleting automatically, 325
level of protection, selecting, 324
notifi cations of receipt, 322
Web beacons, 322

standard color categories, 44
Standard Forms Library, 305
start dates, grouping messages by, 150
starting

e-mail messages, 75
Outlook, on Windows Vista, 3
Outlook, on Windows XP, xvi

Startup wizard, xxxvii, 3
status, task, 237. See also tasks
Step by Step series conventions, xxiii
sticky notes. See notes
storing old messages. See archiving messages
street addresses

checking validity of, 41
displaying maps of, 44
entering, for contacts, 40

structuring folders, 165
Style Sets, 101
styles, changing all, 101
subfolders, creating, 263
subjects, grouping messages by, 150
subscribing

to Internet calendars, 217
to newsgroups, 250–51
to RSS feeds (see RSS feeds)

suppressing. See hiding
Swap Time Zones button, 207
switching

between e-mail accounts, 10
between profi les, 14

synchronizing, 337
system requirements for Offi ce 2007, xxvi

T
Table button, 85
table of contents, how to use, xxiii
tables

entering information in, 86
inserting, 85

tabs, 32, 298. See also Ribbon
Appointment, 179
Business Tools, 35
Contact, 35
contextual, 86

defi ned, 337
double-clicking, 78
Event, 181
Format Text, 36, 80, 179, 228
hiding, 79
hiding commands on, 78
Insert, 35, 79, 179, 228
Meeting, 181
Message, 78
Options, 79
Task, 228

task creation, liii, 226, 232, 234–36
from e-mail messages, xlv, 131
by fl agging messages, 132

task list, 337. See also To-Do List
Task Options dialog box, 232
task originator, defi ned, 337
task owner, defnined, 337
task reminders

deleting, 240
setting, 232, 236
setting snooze for, 233

task requests, 238–39. See also assigning tasks
task status

changing, 237
reports, sending, liv, 240
updating, liv

Task tab, 228
task window, 224, 235, 337
tasks

assigning to others (see assigning tasks; task 
requests)

availability of, 231
categories, changing, 235
color, changing default settings for, 232
completed, displaying, 241
declined, reclaiming, 239
delegating, liii
deleting, liv, 240, 242
details, displaying, 236
due dates, changing, 231, 234
due dates, setting, xlv, 131, 236
due each day, displaying, 230
fi ltering as you type, 231
fl agging for completion This Week, 235
folders, creating for, liii, 231
incomplete, displaying, 241
information for inclusion in, 232
marking as complete, liv, 240–41
modifying, 232
percentage complete, changing, 237
Reading Pane details, 234
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tasks (continued)
reordering, 230
searching for, 231
status of, 237
To-Do List, removing from, 240
updating, liii, 237
viewing, 229
views, 229–30

Tasks button, 133, 225
team calendars, 274
templates

for message formatting (see themes)
for rules, 309

text
converting to bulleted list, 84
copied, choosing source or destination 

formatting for, 304
copying formatting of, 103
fonts for, 100, 103

text animation, 304
text fi les, notes as, 257
text messages, lxiii, 80, 321
Text Pane button, 93
text wrapping, 304
themes

applying, xliii, 104
modifying, 105

Themes button, 104
Themes gallery, 105
third-party add-ins, defi ned, 337
threaded conversations, 149, ee7
thumb tabs in book, how to use, xxiii
time periods in Calendar, switching between, 198
time slots, appointment, 183. See also 

appointments
Time Zone dialog box, 206
time zones

appointments, scheduling across, 180
changing, li, 206
displaying multiple, li, 206
setting, 181
switching between, 207

Time Zones button, 180
timelines, creating. See Journal
Tip paragraphs, xxiv
title bar, 31, 337
To-Do Bar, 224

closing, 22
customizing, 22
minimizing, 21, 230
tasks on, 225
To-Do List, displaying on, 230

To-Do Bar Options dialog box, 22
To-Do List

defi ned, 338
increasing space allotted to, 230
link with Calendar, 223
tasks, removing from, 240
To-Do Bar, displaying on, 230

Toolbar Options button, 250, 306
toolbars

buttons on, lxi, 306
commands, rearranging, lxi
displaying, 24
fl oating, 24
Mini, 102, 302
new organization of, xii
primary (see Ribbon)
Quick Access (see Quick Access Toolbar)
resetting to default, lxi, 307

tracking
activities (see Journal)
changes, 304
messages, 99

Tri-fold Style for printed calendars, 207
troubleshooting setup, 7
Trust Center, 317–21, 323
turning off

AutoPreview, 26
desktop alerts, xliv, 128
reminders, liv

turning on AutoPreview, 117, 153
type, grouping messages by, 150

U
Undo button, 26
undoing, 26
Unicode character sets, defi ned, 338
Unifi ed Messaging, 284
Uniform Resource Locators (URLs), 338
units of measurement, 304
Unread Mail folder, 160
unread messages

appearance of, 115, 153
cursor changing to indicate, 329
displaying only, 155
marking messages as, 152

updating
meetings, 190
RSS feeds, 246
Search Folders, 160
tasks, liii, liv, 237
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URLs (Uniform Resource Locators), 338
USE paragraphs, xxiv
Usenet. See newsgroups
user environment, 30
user folder access, lvi, 262
user input in exercises, formatting of, xxiv
user name

replacing with display name, xli, 9, 82
setting, 302

V
validating e-mail addresses, xli, 9, 82
verifying digital certifi cates, 7
View Certifi cate button, 7
View In Overlay Mode button, 219
View In Side-By-Side Mode button, 220
views, 148. See also specifi c views

calendar, 198–99
Current View list, 26
customizing, 156
for Daily Task List, toggling, 230
default settings, returning to, 199
defi ned, 338
for notes, 251
resetting to original settings, 159
switching, 148–49, 230
for tasks, 229
for To-Do Bar, switching between, 230

virtual folders, 160, 338
virtual private network (VPN)

connecting to, 281
disconnecting from, 281
setting up connection to, lviii, 281–82

voting buttons, 99, 122, 338
VPN (virtual private network)

connecting to, 281
disconnecting from, 281
setting up connection to, lviii, 281–82

W
warnings for appointments, 182, 184
Ways To Organize pane, 230
Web beacons, 322, 338
Web logs, 246, 333. See also RSS feeds
Web pages

publishing calendars as, lii, 212
viewing, from contact records, 26

Web sites
blogs, 246, 333 (see also RSS feeds)
displaying from contact records, 44

Web toolbar, 25
week numbers, displaying in calendar, 199
Weekly Style for printed calendars, 207
weeks. See work week
Windows XP

dialog boxes in, navigating, xvii
practice fi les, managing, xv
Start menu, xvi
starting Outlook on, xvi
virtual private network (VPN) connection, 

setting up under, lviii, 282
wizards

Rules, 308
Startup, 3

work day, setting, 205
work week

default, 204
defi ned, 338
displaying, 201, 204
setting, li, 205

Work Week view, 198
working offl ine, 283–84
workspaces, document, lvii, 269–70, 272–73
wrapping text, 304

X
XP. See Windows XP
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www.microsoft.com/learning/booksurvey/

What do you think 
of this book? 

We want to hear 
from you!

No purchase necessary. Void where prohibited. Open only to residents of the 50 United States (includes District of  
Columbia) and Canada (void in Quebec). For official rules and entry dates see:

Do you have a few minutes to participate in a brief online survey?

Microsoft is interested in hearing your feedback so we can continually improve our books 
and learning resources for you.

To participate in our survey, please visit:

www.microsoft.com/learning/booksurvey/

...and enter this book’s ISBN-10 or ISBN-13 number (located above barcode on back cover*).  
As a thank-you to survey participants in the United States and Canada, each month we’ll  
randomly select five respondents to win one of five $100 gift certificates from a leading  
online merchant. At the conclusion of the survey, you can enter the drawing by providing 
your e-mail address, which will be used for prize notification only.

Thanks in advance for your input. Your opinion counts!

*	Where to find the ISBN on back cover

Example only. Each book has unique ISBN.
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